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Safety Instructions
Be sure to read these instructions in order to operate the product safely. Follow these instructions to prevent 
injury or harm to the operator of the product or others.

WARNING
Denotes the risk of serious injury or death.
• Stop using the product in any case of unusual circumstances such as the presence of smoke or a strange 

smell.
• Do not touch any exposed internal parts.
• Do not get the product wet. Do not insert foreign objects or liquids into the product.
• Do not touch the product connected to a power outlet during lightning storms. This may cause electric shock.
• Do not disassemble or modify the product.
• Do not expose the product to strong shocks or vibration.
• Use only power sources specified in this instruction manual for use with the product.
• Observe the following instructions when using a battery charger or AC adapter.

- Do not touch the battery charger or AC adapter connected to a power outlet during lightning storms.
- Do not use the product if the power plug is not fully inserted into the power outlet.
- Do not unplug the product by pulling the power cord.
- Do not plug in or unplug the product with wet hands.
- Do not place heavy objects on the power cord. Do not damage, break or modify the power cord.
- Do not leave the product connected to a power source for long periods of time.
- Do not expose the power plug and terminals to dirt or let them come into contact with metallic pins or other 

metal objects.
- Do not charge batteries/battery packs at temperatures outside the range of 0 - 40 °C (32 - 104 °F).

• Observe the following instructions when using commercially available batteries or provided battery packs.
- Do not use leaking batteries/battery packs. 

If a battery/battery pack leaks and the material contacts your skin or clothing, flush the exposed area 
thoroughly with running water. In case of eye contact, flush thoroughly with copious amounts of clean 
running water and seek immediate medical assistance.

- Use batteries/battery packs only with their specified product.
- Do not heat batteries/battery packs or expose them to fire. 
- Do not charge batteries/battery packs using non-authorized battery chargers.
- Do not expose the terminals to dirt or let them come into contact with metallic pins or other metal objects.
- Keep batteries out of the reach of children.
- When disposing of batteries/battery packs, insulate the terminals with tape or other means.

• Do not shoot the sun directly or point a lens or a camera with a lens attached at the sun. Even when the sun 
does not appear on the screen or is behind the subject, the lens may concentrate the sunlight and cause a 
malfunction or fire.

• Do not leave a lens or a camera with a lens attached, exposed without the lens cap attached. The lens may 
concentrate the light and cause fire.

• Do not leave the lens exposed without the lens cap attached.
• Do not wrap the product in cloth or other materials when in use or shortly after use when the product is still 

warm in temperature.
• Do not allow the product to maintain contact with the same area of skin for extended periods of time during 

use. This may result in low-temperature contact burns, including skin redness and blistering, even if the 
product does not feel hot. The use of a tripod or similar equipment is recommended when using the product in 
hot places and for people with circulation problems or less sensitive skin.

• Keep the product out of the reach of young children.
• A strap wrapped around a person’s neck may result in strangulation.
• Periodically remove any dust buildup from the power plug and power outlet using a dry cloth.
• Follow any indications to turn off the product in places where its use is forbidden. Not doing so may cause 

other equipment to malfunction due to the effect of electromagnetic waves and even result in accidents.
• Before installing, be sure the surface is capable of supporting the total weight of the camera and connected 

devices, and sufficiently reinforce the surface if necessary.
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CAUTIONS
Follow the cautions below. Otherwise physical injury or property damage may result.
• Strap is intended for use on the body only. Hanging the strap with any product attached on a hook or other 

object may damage the product. Also, do not shake the product or expose the product to strong impacts.  
This may cause injury or damage to the product.

• Do not leave the product in places exposed to extremely high or low temperatures. The product may become 
extremely hot/cold and cause burns or injury when touched.

• Only mount the product on a tripod that is sufficiently sturdy.
• Do not look at the screen for prolonged periods of time. This may induce symptoms similar to motion 

sickness. In such a case, stop using the product immediately and rest for a while before resuming use.

 



4



5

Safety Instructions 2

1. Introduction 9
About this Manual 9

Conventions Used in this Manual 9
Supplied Accessories 10
Names of Parts 11

Camera 11
Handle Unit 16
Microphone Holder 16

2. Preparations 17
Preparing the Power Supply 17

Using a Battery 17
Using a Power Outlet 19

Using the LCD Screen 21
Date, Time and Language Settings 22

Setting the Date and Time 22
Changing the Language 22

Using the Menus 23
Selecting an Option from the Menu 23
Using the Customized Menus (My Menu) 24

Preparing the Camera 26
Examples of Camera Configurations 26
Preparing the Lens 26
In-Camera Lens Correction 28
Attaching the Handle Unit 29
Attaching the Microphone Holder 30

Preparing Recording Media 31
Compatible Recording Media 31
Inserting and Removing an SD Card 32
Initializing Cards 32
Setting a Card’s Volume Label 33
Switching Between Card Slots 33
Checking the Remaining Recording Time on a 

Card 33
Recovering Recordings 34

Selecting the Video Recording Method 35
Setting the File Name for Recordings 37

XF-AVC Clips File Names 37
MP4 Clip and Photo Numbering 38

Using the Fan 39
Adjusting the Black Balance 40

3. Recording 41
Recording Video and Photos 41

Recording 41
Onscreen Displays 43
Reviewing a Recording 47

Adjusting Camera and Recording Settings 49
Performing Basic Settings with Direct Touch 

Control 49
Direct Setting Mode (FUNC Button) 50

Video Recording Configuration: Video Format, 
Sensor Mode, System Frequency, 
Resolution and Frame Rate 52

Selecting the System Frequency 53
Selecting the Sensor Mode 53
Selecting the Main Recording Format 53
Selecting the Resolution and Bit Rate of Primary 

Clips 53
Selecting the Frame Rate 53

Sub Recording Clips 54
Proxy Clips 56
Shutter Speed 57
ISO Speed/Gain 59

Manual ISO Speed/Gain Value 59
Automatic ISO Speed/Gain 60

ND Filter 61
Aperture 62

Aperture Mode of the Lens 62
Manual Aperture: Changing the Aperture 

Value 62
Momentary Automatic Aperture - Push Auto 

Iris 64
Automatic Aperture 64
Exposure Compensation - AE Shift 65
Light Metering Mode 65

White Balance 66
White Balance Mode 66
Custom White Balance 67
Color Temperature/Preset White Balance 67
Auto White Balance (AWB) 68

Table of Contents



6

Focus 69
Focus Mode on the Lens 69
Manual Focus 70
One-Shot AF 72
AF-Boosted MF 73
Continuous AF 73
Changing the AF Frame Type and Position 75
Face Detection 75

Image Stabilization 78
Powerful Image Stabilization 78

Zoom 79
Zoom Modes of the Lens 79
Adjusting the Zoom 79

Onscreen Markers, Zebra Patterns and False 
Color 80

Displaying Onscreen Markers 80
Displaying Zebra Patterns 82
Displaying False Color 82

Setting the Time Code 83
Selecting the Time Code Mode 83
Selecting Drop or Non-Drop Frame 84
Setting the User Bit 84

Synchronizing with an External Device 85
Connecting an External Device 85
Time Code Signal Input 85
Time Code Signal Output 86

Recording Audio 87
Audio Format for MP4 Clips 88
Connecting an External Microphone or External 

Audio Input Source to the Camera 88
Selecting the Built-in Microphone Mode 89
Selecting the Audio Input Source for Audio 

Channels 90
Adjusting the Audio Recording Level 90
Advanced Audio Input Settings 92
Monitoring the Audio with Headphones 93

Colors Bars/Audio Reference Signal 94
Color Bars 94
Audio Reference Signal 94

Video Scopes 95
Displaying a Video Scope 95
Changing the Waveform Monitor Settings 95
Changing the Vectorscope Settings 96

Adding Marks to Clips in CAMERA Mode 97
Adding a Shot Mark while Recording 97
Adding an $ Mark or % Mark to the Last Clip 

Recorded 97
Using Metadata 98

Setting a User Memo Created with Canon XF 
Utility 98

Entering Slate Information About the 
Recording 99

Special Recording Modes 100
Slow & Fast Motion Recording 100
Pre-recording 101
Continuous Recording 102

Using Anamorphic Lenses 103
Using the RC-V100 Remote Controller 104

4. Customization 105
Assignable Buttons 105

Changing the Assigned Function 105
Custom Picture Settings 109

Selecting Custom Picture Files 109
Preset Picture Settings 109
Editing a Custom Picture File’s Settings 110
Look Files 111
Saving a Custom Picture File 112
Available Custom Picture Settings 113

Saving and Loading Menu Settings 117
Saving Menu Settings 117
Loading Menu Settings 117

5. Playback 119
Playback 119

Displaying the Index Screen 119
Playing Back Recordings 120
Onscreen Displays During Clip Playback 121
Clip Playback Controls 122
Adjusting the Volume 122



7

File Operations 123
File Menu Operations 123
Displaying Clip Information 124
Adding $ Marks or % Marks 125
Deleting $ Marks or % Marks 125
Adding/Deleting Shot Marks 125
Deleting All the Shot Marks from a Clip 126
Deleting Recordings 126
Deleting the User Memo and GPS Information from 

a Clip 126

6. External Connections 127
Video Output Configuration 127

HDMI OUT Terminal Video Output Configuration 
(Recording/Playback) 127

Connecting to an External Monitor or 
Recorder 128

Using the HDMI OUT Terminal 128
Superimposing Onscreen Displays on Video 

Outputs 129
Changing the Opacity Level of Onscreen 

Displays 129
Selecting the Output Range 130

Applying a LUT to the LCD Screen 131
Adjusting the Gain Difference When Converting 

HDR to SDR 132
Audio Output Channels 133
Working with Files on a Computer 134

Saving Files 134
Saving MP4 Clips 134
Saving Audio Files (WAV) 135

7. Network Functions 137
Network functions and connection types 137

Using a Wi-Fi Network 138
Using a Wired (Ethernet) Network 139

Configuring Connection Settings 140
Activating a Network Connection 140
Adding a New Connection Setting Using the 

Wizard 141
Function Settings 141
Other Connection Methods 144
Other Network Settings 147
Checking and Changing Connection Settings 

(SET) 148
Checking and Changing Communication Settings 

(NW)/Function Settings (MODE) 149
Checking the Network’s Status 152
FTP File Transfer 153

Transferring a Single Clip 153
Transferring All Clips 153

IP Streaming 154
Browser Remote: Controlling the Camera from a 

Network Device 156
Starting Browser Remote 156
Using Browser Remote 158

8. Additional Information 163
Menu Options 163
Displaying the Status Screens 173
Troubleshooting 182

List of Messages 188
Handling Precautions 194
Maintenance/Others 196
Optional Accessories 197
Specifications 198
Compatible Lenses and Functions 203
Reference Tables 205

Approximate Recording Time on a Card 205
Charging Times 205

Appendix: Camera Dimensions 206
Index 208



8



1
9

Introduction

About this Manual
Thank you for purchasing the Canon EOS C70. Please read this manual carefully before you use the camera and 
retain it for future reference. Should the camera fail to operate correctly, refer to Troubleshooting (A 182).

Conventions Used in this Manual
• IMPORTANT: Precautions related to the camera’s operation.
• NOTES: Additional topics that complement the basic operating procedures.
• A: Reference page number.
• The following terms are used in this manual.

- “Screen” refers to the LCD monitor's screen.
- “Battery” refers to a supplied or optional battery pack.
- “AC adapter” refers to the CA-CP200 L Compact Power Adapter.
- “SD card” refers to an SD, SDHC or SDXC memory card.
- “Card” alone, not specified: refers to SD cards.
- “CAMERA mode”: operating mode for making recordings (shooting mode). 

“MEDIA mode”: operating mode for playing back and managing recordings (playback mode).
- “Access indicator”: when not specified, refers collectively to the SD CARD access indicators.
- Unless indicated otherwise, shooting functions are utilized in CAMERA mode.

• Unless indicated otherwise, illustrations in the manual show the Canon EOS C70 camera with a Canon 
RF24-105mm F4 L IS USM lens attached.

• Photographs in the manual are simulated pictures taken with a still camera.
• Some screenshots have been altered to make them easier to read. Furthermore, screenshots used are from a 

product in development and may differ slightly from the actual screens due to product enhancement.

Before Using the Camera

• Before making important recordings for the first time, make test recordings using the video configuration(s) 
you plan to use to check that the camera operates correctly. Should it fail to operate correctly, refer to 
Troubleshooting (A 182).

• Copyright notice: Unauthorized recording of copyrighted materials may infringe on the rights of copyright 
owners and be contrary to copyright laws.

• About the LCD screen: The screen is produced using extremely high-precision manufacturing techniques, with 
more than 99.99% of the pixels operating to specification. Very rarely, pixels may misfire or light up 
permanently. This has no effect on the recorded image and does not constitute a malfunction.

• About the access indicator: Observe the following precautions while an access indicator (A 32) is illuminated 
or flashing in red. Failing to do so may result in permanent data loss.
- Do not turn off the camera and do not remove the battery or other power source.
- Do not open the card compartment cover.
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Supplied Accessories
The following accessories are supplied with the camera. For accessories sold separately, please refer to Optional 
Accessories (A 197). Unless indicated otherwise, accessories mentioned in this manual are the ones supplied 
with the camera.

CA-CP200 L Compact Power Adapter CG-A20 Battery Charger BP-A30 Battery Pack
(incl. terminal cover)

Handle Unit

Microphone Holder
(incl. M4 fixation bolts, x2)

Body Cap* SS-1200 Shoulder Strap Tape Measure Hook*

Quick Guide Shoe Mount Bracket

* Comes pre-attached to the camera.
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Names of Parts

Names of Parts
Camera

* Can be assigned exclusively as a REC button (A 105)

Removing and attaching the terminal covers
You can remove the covers of the camera’s terminals to access them more easily. To remove a terminal’s 
cover, open the cover and gently pull it straight out. To attach back the terminal cover, insert the connecting 
strip into the opening. If the connecting strip is difficult to grasp, use a pair of tweezers or similar tool.

1

2

3

4 5
6

7

8
9

10

13 14

15

11

12

1 ND FILTER +/– buttons (A 61)
2 WB (white balance) button (A 66)/

Assignable button Camera 1 (A 105)
3 Å (white balance adjustment) button (A 66)/ 

Assignable button Camera 2 (A 105)
4 Strap mounts

Pass one end of the SS-1200 Shoulder Strap 
through the strap mount and adjust the length of 
the strap.

5 Air intake vent (A 39)
6 INPUT 1/INPUT 2 terminals (A 88)
7 MIC (microphone) terminal (A 88)
8 USB terminal

For connecting a commercially available Wi-Fi/
Ethernet adapter or the GP-E2 GPS Receiver.

9 × (headphone) terminal (A 93)
10 REMOTE terminal (A 104)

For connecting the RC-V100 Remote Controller or 
commercially available remote controllers.

11 DISP (display) button (A 43)/
Assignable button Camera 5 (A 105)

12 ZEBRA button (A 82)/
Assignable button Camera 6 (A 105)

13 WFM (video scope) button (A 95)/
Assignable button Camera 4* (A 105)

14 PEAKING button (A 71)/
Assignable button Camera 3 (A 105)

15 HDMI OUT terminal (A 128)
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1 2 3

4

6

5

7
8

1 Strap mounts
Insert the end of the SS-1200 Shoulder Strap from 
the top of the strap mount and pull it from the 
exhaust ventilation outlet to attach it to the 
camera.

2 Exhaust ventilation outlet (A 39)
3 ONE-SHOT AF (focus automatically once) button 

(A 72)/
Assignable button Camera 10 (A 105)

4 Card slots  and  (A 32)
5 Card compartment cover (A 32)
6 TIME CODE terminal (A 85)
7 Tripod screw holes (1/4"-20, 8.9 mm (0.35 in.) 

deep)
8 Speaker (A 122)
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Names of Parts

1

2

3 4
5

6

7

8

9 10 11
Lens mount

1 REC (start/stop recording) button (A 41)
2 Grip belt

Adjust the grip belt so that you can reach the REC 
button with your index finger but still have a 
comfortable but secure grip.

3 Front control dial (A 59, 62)
4 RF lens mount index (A 26)
5 Built-in microphone (A 89)
6 Power indicator (green)/Tally lamp (red) (A 41)
7 Lens lock pin
8 Lens release button (A 26)
9 Assignable button Camera 11 (A 105)
10 Lens contacts (A 26)
11 AF LOCK button (A 74)/

Assignable button Camera 12 (A 105)
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1 2 3 4 5 6 7

8 9 10

11 12 13 14 15 16

1 LCD monitor (A 21)
2 INPUT 1 (top) / INPUT 2 (bottom) switches 

(audio source selection, A 89)
3 PUSH AUTO IRIS (momentary automatic aperture) 

button (A 64)/
Assignable button Camera 7 (A 105)

4 INDEX button (A 120)/
MAGN. (magnification) button (A 71)/
Assignable button Camera 8 (A 105)

5 Joystick (A 23)
You can push the joystick in 8 directions (up/
down, left/right, or diagonally) and press the 
joystick itself to confirm.

6 Rear control dial (A 59, 63)
7 FUNC (main functions) button (A 50)/

Assignable button Camera 9 (A 105)

8 Audio level dials for CH1 (top) and CH2 (bottom) 
(A 91)

9 Audio level switches for CH1 (top) and CH2 
(bottom) (A 90)

10 AUDIO STATUS (display the [¡ Audio Setup] 
status screens) button (A 177) /
Assignable button Camera 13 (A 105)

11 DC IN terminal (A 19)
12 Battery compartment (A 18)
13 BATTERY RELEASE button (A 18)
14 CANCEL button (A 23)
15 SELECT dial/SET button (A 23)
16 MENU button (A 23)
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Names of Parts

IMPORTANT

• Do not use tripods and other accessories with mounting screws exceeding the depth of the screw holes on 
the camera as this may damage the camera.

• Mounting the camera on a tripod using only one of the 1/4"-20 screw holes for tripod reinforcement may 
damage the camera.

Locking the camera’s controls (key lock)
You can set the Q switch to C (key lock) to lock all the camera’s buttons* and switches. This is useful 
in preventing settings from being changed due to inadvertently pressing one of the buttons. Set the Q 
switch back to CAMERA to reactivate the controls.
When the camera’s controls are locked, you can still operate the camera using an RC-V100 Remote 
Controller or the Browser Remote application.
* REC buttons are not locked by default but you can choose to lock them too (A 171).

1

2 3

87

9

10

11

4

5

6

1 Tape measure hook and focal plane mark
Use the hook to accurately measure the distance 
from the focal plane.

2 Accessory shoe with socket for 1/4"-20 mounting 
screws (9.2 mm (0.36 in.) deep)

3 Q switch
Set to CAMERA to turn on the camera (the power 
indicator/tally lamp illuminates in green) or to OFF 
to turn it off (the power indicator/tally lamp goes 
out).

4 MEDIA button (A 119)
When the camera is on, press to toggle the 
camera between CAMERA mode (shooting) and 
MEDIA mode (playback).

5 SLOT SELECT (card selection) button (A 33, 
120)

6 SD CARD access indicator: /  (A 32)
7 Power cord clamp (unplugging prevention) 

(A 20)
8 Exhaust ventilation outlet (A 39)
9 Socket for tripod’s anti-rotation pin 

(5.6 mm (0.22 in.) deep)
10 Screw holes for tripod reinforcements and 

accessories with 1/4"-20 mounting screws 
(8.9 mm (0.35 in.) deep, x2)

11 Screw hole for 3/8"-16 mounting screws 
(10 mm (0.39 in.) deep)
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Handle Unit

Microphone Holder

(A 29)

21 3

4

1 Cable clamp
2 Locking knob
3 Accessory shoe

4 Sockets for the microphone holder (A 30)

(A 30)

1

4

3

2

1 Microphone lock screw
2 Microphone holder

3 Screw hole for the shoe mount bracket
4 Microphone cable clamp
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Preparations

Preparing the Power Supply
You can power the camera using a battery or a power outlet. Even when a battery is attached, if the camera is 
connected to a power outlet, it will not draw power from the battery.

Using a Battery
You can power the camera using the BP-A30 Battery Pack or the BP-A60 Battery Pack. Both battery packs are 
compatible with Intelligent System so you can check the approximate remaining battery usage time (in minutes) 
on the screen. For more accurate readings, when using a battery for the first time, charge it fully and then use the 
camera until the battery is completely depleted.

Charging the Battery

Charge battery packs using the CG-A20 Battery Charger and 
CA-CP200 L Compact Power Adapter. Before charging, remove 
the terminal cover of the battery pack.

1 Connect the AC adapter to the battery charger and plug the 
power cord into a power outlet.

2 Attach the battery to the battery charger.
• Press lightly and slide the battery in the direction of the arrow 

until it clicks.
• The CHARGE indicator starts flashing and also indicates the 

battery pack’s approximate charge. The indicator will stay on 
when charging has completed.

approx. 0% to 49%: Flashes once every 2 seconds
approx. 50% to 74%: Flashes twice every 2 seconds
approx. 75% to 99%: Flashes 3 times every 2 seconds

3 Disconnect the AC adapter from the battery charger and unplug the power cord.

4 Remove the battery from the battery charger.

IMPORTANT

• Do not connect to the battery charger any product that is not expressly recommended for use with this 
camera.

• When using the battery charger or AC adapter, do not fix it permanently to one place as this may cause a 
malfunction.

• To prevent equipment breakdowns and excessive heating, do not connect the battery charger or AC adapter 
to voltage converters for overseas travels or special power sources such as those on aircraft and ships, 
DC-AC inverters, etc.

CHARGE 
indicator

AC adapter

Battery Charger
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NOTES

• We recommend charging the battery in temperatures between 10 ºC and 30 ºC (50 ºF and 86 ºF). Outside the 
temperature range of 0 ºC to 40 ºC (32 ºF to 104 ºF), charging will not start.

• If there is a malfunction with the battery charger, AC adapter or battery, the charge indicator will go out and 
charging will stop.

• For handling precautions regarding the battery, refer to Handling Precautions (A 194).
• For approximate charging times / usage times, refer to the Reference Tables (A 205) and Approximate 

Continuous Recording Times (A 201).
• Charged batteries continue to discharge naturally. Therefore, charge them on the day of use, or the day 

before, to ensure a full charge.
• We recommend that you prepare batteries to last 2 to 3 times longer than you think you might need.
• Repeatedly charging and completely depleting a battery will eventually shorten its battery life. You can check 

the battery life on the [B System Setup] status screen (A 178). Fully charging the battery and then depleting 
it completely will give you a more accurate reading.

Attaching the Battery

1 Turn off the camera.

2 Insert the battery all the way into the compartment as 
shown in the illustration and press it gently toward the left 
until it clicks.

Removing the Battery

1 Turn off the camera.

2 Holding down the BATTERY RELEASE button (�), slide 
the battery toward the right and then pull it out (�).

�

�

�

�

�
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Preparing the Power Supply

Checking the Remaining Battery Charge

When the camera is turned on, you can check the approximate remaining battery usage time (in minutes) by 
looking at any recording/playback screen or the [B System Setup] status screen (A 178). You can also check 
the approximate charge level on the battery itself. 

Press the CHECK button on the battery. An indicator will 
light for approximately 3 seconds and show the 
approximate remaining battery charge.

0-25%

26-50%

51-75%

76-100%

NOTES

• The remaining battery charge level displayed in minutes on the screen may not match the [B System Setup] 
status screen or the indicators on the battery pack.

Using a Power Outlet
You can also power the camera directly from a power outlet using the CA-CP200 L Compact Power Adapter 
(AC adapter). While the camera is powered using a power outlet, you can replace the battery pack even when 
the camera is turned on.

1 Connect the power cord to the AC adapter and plug 
it into a power outlet.

2 Connect the AC adapter’s DC plug to the DC IN 
terminal on the camera.

IMPORTANT

• Make sure to turn off the camera before connecting or 
disconnecting the AC adapter.

• When using the AC adapter, do not fix it permanently to 
one place as this may cause a malfunction.

CHECK buttonBattery charge 
indicator

�

�DC IN 
terminal

AC adapter
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Checking the Voltage Level of the Power Source

The voltage level appears on the screen (A 43). Select  > [B System Setup] > [DC IN Warning (V)] to set 
a power warning level. When the voltage from the DC IN terminal reaches the set value, the onscreen voltage 
indicator will turn red and a warning will be displayed.

NOTES

• The camera will not start recording if the voltage falls below the selected low-power warning level (A 172). 
While shooting, the recording will be interrupted and the camera will turn off if the power voltage falls below the 
level required for the camera's operation.

Preventing the accidental unplugging of the power cord

Pass the power cord through the clamp at the bottom of the camera as 
shown in the illustration to prevent the accidental unplugging of the DC plug.
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Using the LCD Screen

Using the LCD Screen
This section explains how to adjust the LCD monitor. You can adjust the direction of the screen as shown below, 
as well as image settings such as brightness or contrast. Additionally, you can use the touch screen to select the 
subject or perform a variety of settings using direct touch control (A 49).

1 Open the LCD monitor 180 degrees (�) and adjust to the desired angle (�).

2 When the screen is facing the subject (�), you can also place it back in its original position with the 
screen facing out (�).

NOTES

• You can adjust the brightness, contrast, color saturation, sharpness and luminance of the LCD screen with the 
respective settings in the  > [¢ Monitoring Setup] menu (A 167).

• In CAMERA mode, you can use the  > [¢ Monitoring Setup] > [B&W Image: LCD] setting to change 
the image on the screen to black and white display. Even when the captured image is displayed in black and 
white, onscreen displays and icons will be shown in color.

• You can use the  > [B System Setup] > [Touch Screen Response] setting to adjust the LCD monitor’s 
response to touch input.

• Adjusting the brightness does not affect the brightness of recordings.
• When the LCD panel is rotated 180 degrees toward the subject, you can set  > [¢ Monitoring Setup] 

> [LCD Mirror Image] to [On] to flip the image horizontally so it shows a mirror image of the subject.
• For details about how to take care of the LCD monitor, refer to Handling Precautions (A 194), Cleaning 

(A 196).

�

�

�

�
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Date, Time and Language Settings
Setting the Date and Time
You will need to set the date and time on the camera the first time you power it on, or after the camera's settings 
have been reset. The [Date/Time] screen will appear automatically when the camera’s clock is not set. Refer to 
Using the Menus (A 23) for instructions on how to operate the menus.

1 Select the desired time zone* using the joystick or the SELECT dial, and confirm by pressing the SET 
button or the joystick itself.
• The cursor will move to the next field.
• You can also push the joystick left/right to move between the fields.
* The default time zone is [UTC-05:00] (New York) or [UTC+01:00] (Central Europe), depending on the country/region of 

purchase. Time zones are based on Coordinated Universal Time (UTC).

2 Change the rest of the fields in the same way.

3 Select [Set] and then press SET.

NOTES

• You can display the date/time with the  > [¢ Monitoring Setup] > [Custom Display 2] or [Custom 
Display] > [Date/Time] setting.

• With the following settings, you can make changes after the initial setup. You can also change the date format 
and clock format (12 or 24 hours).
-  > [B System Setup] > [Time Zone], [Date/Time] and [Date Format]

• When you do not use the camera for about 3 months, the built-in backup battery may be depleted completely 
and the date and time setting may be lost. In such case, recharge the built-in backup battery (A 195) and set 
the time zone, date and time again.

• Using the GP-E2 GPS Receiver, you can have the camera adjust settings automatically according to the UTC 
date/time information received from the GPS signal (A 172).

Changing the Language
The camera’s default language is English. You can change it to German, Spanish, French, Italian, Polish, 
Portuguese, Russian, Ukrainian, Simplified Chinese, Korean or Japanese. Please note that some settings and 
screens will be displayed in English, regardless of the language setting.
Refer to Selecting an Option from the Menu (A 23) for details on how to navigate the menu to complete this 
procedure.

1 Select  > [B System Setup] > [Language H].

2 Select the desired language and press the MENU button to close the menu.
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Using the Menus

Using the Menus
Many of the camera’s functions can be adjusted using the menus. In CAMERA mode, you can also register 
frequently used menu settings in a customized menu (My Menu) for easy access. For details about the available 
menu options and settings, refer to Menu Options (A 163).

Selecting an Option from the Menu
The following is a step-by-step explanation of how to select a typical option from the setup menus. Some menu 
items may require additional steps. Such operations will be explained in the respective section of the manual.
For brevity's sake, references to menu settings throughout the manual will be abbreviated as follows:
  > [B System Setup] > [Language H] > Desired option

1 Press the MENU button.
• The menu opens. The icon displayed in orange is the menu item that was selected the last time the menu 

was closed (unless the camera was turned off).
• When a menu icon is not selected, first push the joystick up or press the CANCEL button to move the 

orange selection frame to one of the icons.

2 Push the joystick left/right to select the icon of the desired setup menu.
• You can also use the rear control dial. 

MENU button
Press the button to open the setup menus and then 
press again to close the menu after adjusting desired 
settings.

SET button
Press the SET button to confirm a selection.

SELECT dial
Turn the dial to move the orange selection frame in the 
menu.

CANCEL button
Press to return to the previous menu/submenu level or 
to stop some operations that are in progress.

Joystick/SET button
When making a menu selection, push the joystick 
to move the orange selection frame in the menu. 
Then, press the joystick itself to select the menu 
item indicated by the orange selection frame.

Rear control dial
When the menu is open, turn the dial to move to 
the next/previous setup menu.

Front control dial
When the menu is open, turn the 
dial to move to the next/previous 
menu page.
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3 Press the joystick or the SET button to confirm your selected setup menu.
• The cursor moves to the first item on the first page of the selected setup menu.
• You can also push the joystick down to move the cursor to the list of menu items.
• Going forward, this operation will be referred to as “press SET” in this manual.

4 Select the desired menu item ([Language H], in the example) and then press SET.
• Joystick operation: 

- Push the joystick left/right to scroll through the menu pages. Moving left/right from the first/last page will 
move to the previous/next setup. You can use the front control dial.

- Push the joystick up/down to move the cursor over the menu items on the page.
• Dial operation: 

- Turning the SELECT dial will scroll through the menu items on the page. Scrolling beyond the first/last 
menu item in the list will move to the previous/next menu page.

- Scrolling beyond the first/last page will move to the previous/next setup menu.

5 Push the joystick up/down or turn the SELECT dial to select the desired setting option and then 
press SET.
• During the selection, the currently selected option is indicated with a  mark. Press SET to confirm your 

selection and go back to the previous screen.
• When many options are available, a scroll bar will appear on the right. Scroll up or down to see other 

options.
• Press the CANCEL button or select [L] and press SET to return to the previous menu level.

6 Press the MENU button to close the menu.
• Pressing the MENU button at any time closes the menu.

NOTES

• Unavailable items may appear grayed out.
• On some screens, the following icons may be displayed as a guide: , , . They refer, respectively, 

to pressing the joystick or SET button, the MENU button and the CANCEL button.
• When an RC-V100 Remote Controller is connected to the camera, you can use the remote controller’s up/

down/left/right/SET buttons in the same way as the camera’s joystick. Pressing the SET button is equivalent to 
pressing the joystick on the camera.

• You can check most of the current settings on the status screens (A 173).
• You can set  > [B System Setup] > [Ctrl Dial in Menus] to [Disable] to disable the use of the front and 

rear control dials while browsing the menus. In such case, use the SELECT dial to move between menus.

Using the Customized Menus (My Menu)
In CAMERA mode, you can register up to 6 frequently used menu settings under a My Menu page for easy 
access. You can save up to 5 separate sets of My Menu settings each with 6 options for different shooting 
situations. Furthermore, if you set an assignable button to [My Menu] (A 105), you can press the button to 
access your registered menu settings even faster and more easily.

Adding Menu Settings

1 Select  > [¥ My Menu] > Desired menu page > [Edit] > [Register].
• A screen will appear where you can select the menu setting you want to add.
• Press the CANCEL button to cancel the operation and return to the regular menu.

2 Select the menu setting you want to add.
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3 Select [OK].
• The menu setting you registered will now appear under the currently selected My Menu set.

Rearranging Menu Settings

1 Select  > [¥ My Menu] > Desired menu page > [Edit] > [Move].

2 Select the menu setting you want to move.
• The ] icon will appear next to the setting you selected to move.

3 Move the menu setting to the desired position and press SET.

Removing Menu Settings

1 Select  > [¥ My Menu] > Desired menu page > [Edit] > [Delete].

2 Select the menu setting you want to remove and then select [OK].

Resetting All the My Menu Sets

Reset all the menu settings registered to the currently selected My Menu set.

Select  > [¥ My Menu] > Desired menu page > [Edit] > [Reset All] and then select [OK].

Renaming My Menu Sets

You can give each of the 5 My Menu sets a more descriptive name to make them easier to identify.

1 Select  > [¥ My Menu] > Desired menu page > [Edit] > [Rename].

2 Enter the desired name (8 characters long) using the keyboard screen (see the following sidebar).

Entering text and numbers
There are two types of screens used to enter text and numbers – the keyboard screen, and the data entry 
screen. Which screen is used, as well as the available characters will depend on the menu setting.

Keyboard screen

1 Touch the character you wish to enter.
• The characters you entered will appear in the input area at the top of the screen.

• You can also move the cursor with the SELECT dial or the joystick, and select the desired character by 
pressing SET.

2 After entering the desired text, touch [OK] to confirm.

Data entry screen
Use the SELECT dial or the joystick to select characters.

1 Select a character and then press SET to confirm.
• The cursor will move to the next field.
• You can also push the joystick left/right to move between the fields.
• Change the rest of the characters in the same way.

2 Select [Set] to confirm the text or value.
• Press CANCEL to stop entering text.

Key Function

� / � Moves the cursor in the input area.

Shift key

 / Switches between letters, numbers and special characters.

Space key

Backspace key
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Preparing the Camera
This section details how to prepare the camera for the first time, including how to mount and remove lenses and 
the handle unit. 

Examples of Camera Configurations
Your camera allows you to build the shooting configuration that best fits your needs and shooting conditions. For 
details on the optional accessories compatible with this camera, refer to Optional Accessories (A 197) and the 
Cinema EOS System Expansion User Guide (PDF file).

IMPORTANT

• Be careful not to drop the camera or accessories when attaching, removing or adjusting the various 
accessories. Use a table or other stable surface to change the camera’s configuration.

Preparing the Lens
As much as possible, attach and remove the lens quickly and in a clean environment free of dust. You can also 
use an EF lens by attaching a mount adapter to the RF lens mount. Refer also to the instruction manual of the 
lens/mount adapter used.

IMPORTANT

• When attaching/removing a lens, avoid direct sunlight or strong light sources. Also, be careful not to drop the 
camera or lens.

NOTES

• After removing a lens/When a lens is not attached to the camera:
- Do not touch the lens’s surfaces, the lens mount or any components inside the lens mount area.
- Place the body cap back on the lens mount and the dust caps on the lens. Clean any dust or dirt from the 

body cap and dust caps before using them.

Configuration with
 microphone holder

Configuration with microphone
 holder and handle

Minimal configuration 
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Attaching a Lens

1 Turn off the camera.

2 Remove the body cap from the camera and the dust caps 
from the lens.

3 Attach the lens to the camera and turn the lens in the 
direction of the arrow until it clicks in place.
• Align the red mark on the lens with the red lens mount 

index mark on the camera.

Removing a Lens

1 Turn off the camera.

2 Hold down the lens release button and turn the lens all the 
way in the direction of the arrow until it stops.

3 Remove the lens.

4 Place the body cap back on the lens mount and the dust 
caps on the lens.

NOTES

• Turning on the image stabilization function of a lens may reduce the effective usage time of the battery pack. 
When image stabilization is not necessary, for example if the camera is fixed to a tripod, it is recommended to 
turn it off.

• Depending on the lens used, you may experience one or more of the following limitations.
- The lens model name may be shortened when displayed on the screen.
- You may not be able to focus manually when the focus mode switch of an EF lens is set to AF.
- You may not be able to use the focus preset function on an EF lens (super telephoto lenses).
- You may not be able to use the power zoom function on EF lenses with that function.

• This camera’s sensor is larger than the sensor size for which EF-S lenses are designed (APS-C). When using 
EF-S lenses with this camera, you may notice peripheral illumination fall-off or vignetting (A 164).

• When using a compatible lens, you can use the  > [B System Setup] > [Retract Lens] setting to retract 
the lens automatically when the camera’s power is turned off with the lens's focus mode switch set to AF.

Using the EF-EOS R 0.71x Mount Adapter
• You can use the EF-EOS R 0.71x Mount Adapter to attach a compatible EF lens to the camera and shoot 

video with an angle of view equivalent to full frame. Additionally, you can use autofocus, peripheral illumination 
correction and chromatic aberration correction. For details on compatible lenses, visit your local Canon 
website.

�

��

�

�
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Updating the Firmware of a Lens/Mount Adapter

You can update the firmware of the lens/mount adapter attached to the camera (only in CAMERA mode). For 
details about firmware updates, visit your local Canon website. The following example explains how to perform a 
firmware update for lenses.

1 Download the lens/mount adapter firmware update file from the Canon website and save it on the root 
directory of an SD card. Insert the SD card containing the firmware update into the camera's SD card slot B 
(A 32).

2 Attach the lens/mount adapter you want to update and turn on the camera in CAMERA mode.
• Attach a lens also when updating the firmware of the mount adapter.

3 Select  > [B System Setup] > [Firmware] > [Lens] or [Mount Adapter].
• The current lens/mount adapter firmware version will appear on the screen.
• If the menu option is grayed out, the attached lens/mount adapter may not support firmware updates or the 

SD card used may not contain a valid lens firmware file. Check the lens/mount adapter and SD card and 
repeat the procedure from the beginning.

4 Select [OK].

5 Select the lens firmware file (.LFU or .AFU file).

6 Select [OK].
• The firmware will be updated. Once in progress, the lens firmware update cannot be canceled.

7 When the confirmation message appears, press SET.

IMPORTANT

• Be sure to observe the following precautions while the lens firmware is being updated.
- Do not turn off the camera and do not remove the battery pack or other power source.
- Do not remove the lens/mount adapter.
- Do not operate any buttons or controls on the camera.
- Do not open the card compartment cover and do not remove the SD card.

NOTES

• The lens firmware cannot be updated while pre-recording is activated.
• Power the camera using an AC adapter or a sufficiently charged battery pack.
• When using an EF extender, remove the extender before performing the procedure.

In-Camera Lens Correction
Depending on the characteristics of the lens used, the corners of an image frame may be darker than the center 
due to light fall-off (peripheral illumination drop), color shift/color fringing may be visible along high-contrast 
edges in the image (chromatic aberration), the image produced may not be as sharp at certain apertures (lens 
diffraction), or the image might appear distorted (distortion aberration). In CAMERA mode, you can apply a 
correction to compensate as necessary. To apply peripheral illumination or chromatic aberration correction, 
correction data for the lens used is necessary. Distortion aberration correction is only possible for compatible RF 
lenses. 

1 Attach the lens you want to use and turn on the camera in CAMERA mode.
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2 Select  > [v Camera Setup] > [Periph. Illum. Corr.], [Chromatic Aberr. Corr.], [Diffraction 
Correction], or [Distortion Aberr. Corr.].
• If correction data is not available, [Periph. Illum. Corr.] or [Chromatic Aberr. Corr.] will appear grayed out. Visit 

your local Canon website and check if there is correction data available for the lens you are using. If so, 
download the necessary update package, update the camera’s firmware version and repeat the procedure 
from the beginning.

• If the appropriate correction data for distortion aberration is not available for the lens attached, [Distortion 
Aberr. Corr.] will appear grayed out.

3  Select [On].
• The camera will apply the correction for the attached lens to all future recordings.

NOTES

• About in-camera lens correction data: The camera contains a register of correction data for compatible lenses 
that were available at the time the camera went on sale. Correction data for future lenses will be made 
available as part of the regular updates released for the camera’s firmware. For more details, visit your local 
Canon website.

• Peripheral illumination/chromatic aberration correction cannot be applied in the following cases:
- When the appropriate correction data is not available for the lens attached.
- When using non-Canon lenses. Even if the corresponding menu setting is available (not grayed out), setting 

it to [Off] is recommended.
• Diffraction correction cannot be applied when the camera cannot obtain the current aperture value of the lens.
• When peripheral illumination/diffraction correction is activated:

- Depending on the recording conditions, noise may appear in parts of the image.
- The level of correction will be lower for lenses that cannot provide distance information.
- The level of correction will be lower the higher the ISO speed/gain setting used.
- When using EF-S lenses, peripheral illumination fall-off may be more pronounced.

Attaching the Handle Unit
1 Insert the handle unit’s mounting screw into the screw hole of 

the camera’s top accessory shoe.

2 Tighten the locking knob to firmly secure the handle in place.
• If necessary, use a hex wrench for 0.64 cm, 1/4" screws to tighten 

the locking knob. �

�
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Attaching the Microphone Holder

To the Right Side of the Handle Unit

1 Attach the microphone holder to the handle unit.

2 Use a commercially available Phillips head (“crosshead”) screwdriver 
to secure it firmly with the 2 M4 bolts.

To an Accessory Shoe (Handle Unit or Camera)

1 Insert the part of the shoe mount bracket with the screw through the 
mounting hole on the microphone holder, from below (�). Align the 
part of the shoe mount bracket with the female threading and tighten 
from above (�).
• It is recommended to leave about 4 mm of clearance.

2 Slide the shoe mount bracket into the accessory shoe and tighten the 
lock screw (�).
• Make sure to slide the microphone holder in the direction of the 

arrow at the bottom of the attachment bracket.

�

�

�
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Preparing Recording Media
The camera records clips, photos and other files on SD cards*. The camera has two card slots, and recording on 
two cards is possible (A 35).
Initialize cards (A 32) when you use them with this camera for the first time.
* The SD card is used also to save/read other files such as custom picture files.

Compatible Recording Media
The following types of memory card can be used with this camera. For the latest information about recording 
media tested for use with this camera, visit your local Canon website.

SD cards

* UHS and Video Speed Class are standards that indicate the minimum guaranteed data transfer rate of SD cards.

Recommended speed class by video configuration

IMPORTANT

• After repeatedly recording, deleting and editing clips (if the memory is fragmented), you may notice slower 
writing speeds to the card and recording may even stop. In such case, save your recordings and initialize the 
card with the camera. Be sure to initialize cards especially before shooting important scenes.

• About SDXC cards: You can use SDXC cards with this camera but these cards are initialized by the camera 
using the exFAT file system.
- When using exFAT-formatted cards with other devices (digital recorders, card readers, etc.), make sure that 

the external device is compatible with exFAT. For more information on compatibility, contact the computer, 
operating system or card manufacturer.

- If you use exFAT-formatted cards with a computer OS that is not exFAT-compatible, you may be prompted 
to format the card. In such case, cancel the operation to prevent data loss.

NOTES

• Proper operation cannot be guaranteed for all cards.

SD card type: . SD cards, /SDHC cards, 0 SDXC cards

UHS Speed Class*: U3

Video Speed Class*: V30, V60, V90

Video configuration
Recommended speed class

Recording mode Recording format Resolution

Slow & fast motion recording – – V90

Other recording modes
XF-AVC YCC422 10 bit – V60, V90

MP4 (HEVC) YCC422 10 bit 4096x2160, 3840x2160 V60, V90
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Inserting and Removing an SD Card
1 Wait until the SD CARD access indicator is off or is 

illuminated in green.

2 Open the card compartment cover.

3 Insert the card straight, with the label facing the side 
opposite to the lens, into the SD card slot until it clicks.
• You can use two cards, one in each card slot.
• To remove the card, make sure the SD CARD indicator is off 

and then push the card once to release it. When the card 
springs out, pull it all the way out.

4 Close the card compartment cover.
• Do not force the cover closed if the card is not correctly 

inserted.

SD card access indicator

If you set  > [B System Setup] > [SD Card Access LED] to [Off], the SD card access indicator will not 
illuminate.

IMPORTANT

• SD cards have front and back sides that are not interchangeable. Inserting a card facing the wrong direction 
can cause a malfunction of the camera. Be sure to insert the card as shown in the illustration.

Initializing Cards
Initialize cards when you use them with this camera for the first time. You can also initialize a card to permanently 
delete all the recordings it contains.

1 Select  > [Æ Recording/Media Setup] > [Initialize Media].

2 Select the desired card.

3 Select [OK].
• The card is initialized and all the data it contains is erased.

IMPORTANT

• SD cards are initialized using the FAT file system, SDHC cards using the FAT32 file system, and SDXC cards 
using the exFAT file system.

• Initializing a card will permanently erase all data, including photos and protected custom picture files. Lost data 
cannot be recovered. Make sure you save important recordings in advance.

Indicator Card status

Red Accessing the card.

Green Recording/playback is possible and the card is selected for recording/playback.

Off A card is not inserted or the card slot is not currently selected.

�

�

�

�

SD CARD 
indicator
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• Depending on the card, initialization may take up to a few minutes.

NOTES

• If you set an assignable button to [Initialize Media] (A 105), you can press the button to open the [Initialize 
Media] submenu.

Setting a Card’s Volume Label
You can set the volume label for SDXC cards used for recording (only in CAMERA mode, when recording 
XF-AVC clips), in order to make it easier to identify and organize them later.

1 Select  > [Æ Recording/Media Setup] > [Volume Label] > Desired option.

2 Initialize the card (A 32).

3 If necessary, set the XF-AVC clip file name’s metadata elements (A 37).

4 Record clips on the card.
• The card’s volume label changes when the first XF-AVC clip is recorded on a just initialized card. 

Options
[Canon]: The card’s volume label will be “CANON” regardless of the clip file name settings.
[Canon + Metadata]:

The card’s volume label will be “CANON”, plus the camera index number and the reel number 
(A 37).

Switching Between Card Slots
If both slots contain a card, you can switch the card used for recording/playback as necessary.

Press the SLOT SELECT button.
• The access indicator of the selected SD card slot will illuminate in 

green.

NOTES

• You cannot use the SLOT SELECT button to switch between card 
slots while recording or playing back.

• You can also perform this function remotely using Browser Remote 
(A 160).

Checking the Remaining Recording Time on a Card
The display on the upper left of the screen shows the card icons and the remaining recording time* (in minutes) 
on each card (A 44).
On the [Æ Recording/Media Setup] status screen (A 179), you can check the total space, used space and 
approximate remaining recording time* of each card. The approximate remaining number of photos (SD card B 
only) and speed class will be displayed as well.
* Remaining recording times are approximate and calculated based on the current video configuration used.
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Recovering Recordings
Some actions, such as suddenly turning off the camera or removing the card while data is being recorded, can 
cause data errors in the recorded file. You may be able to recover recordings with corrupted data using the 
following procedure.

1 Switch to MEDIA mode and open the index screen with the recordings you wish to recover (A 119).

2 Select the desired recording (with the  icon).

3 Press SET to open the file menu and select [Recover] > [OK].
• The camera will attempt to recover the corrupted data.

NOTES

• The file may not be recorded if the power is cut or if the SD card is removed immediately after starting 
recording. Even if a partial recording was made, such files may be deleted if file recovery is attempted.

• In some cases, it may not be possible to recover the data. This is more likely when the file system is corrupted 
or the card is physically damaged.

• Only clips and audio (WAV) files recorded with this camera can be recovered. Photos cannot be recovered.
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Selecting the Video Recording Method 
This camera features various recording modes, as well as video recording methods using two cards. You can 
also stream the audio/video while recording it on a card (A 154). Below is an overview. For details, refer to each 
function’s section.

Recording modes 
You can select the video recording method for the card selected for recording.

Second card recording Functions
These are the recording methods for the other SD card.

1 Select the recording mode
• Use direct touch control (A 49) or in the menu, select  > [Æ Recording / Media Setup] > 

[Recording Mode] > Desired option.

2 Select the second card's recording function
• Use direct touch control (A 49) or in the menu, select  > [Æ Recording / Media Setup] > [2nd 

Card Rec Functions] > Desired option.

Available simultaneous recording configurations

• Simultaneous recording is available only with normal recording while connected to a network with IP streaming 
activated.

[Recording Mode] Description A

[Normal Recording]
Normal recording. Records a clip in the selected recording format. The most basic video recording 
method.

41

[Slow & Fast Motion], 
[S&F Clip / Audio (WAV)]

Slow & fast motion recording. Records using a frame rate that is different from the playback frame 
rate (overcrank/undercrank shooting). Audio can also be recorded.

100

[Pre-Recording]
Pre-recording. Records onto a temporary memory (3 seconds) so the clip will contain a few seconds 
of video and audio recorded before you perform the recording operation.

101

[  Main / Continuous Rec]
Continuous recording. SD card A is used for normal recording, and SD card B is used for continuous 
recording.

102

[2nd Card Rec Functions] Description A

[ Main / Proxy Rec]
Proxy recording. Simultaneously records a proxy clip (to SD card B, while the main clip is recorded to 
SD card A) with a smaller file size for offline editing. The proxy clip is recorded with a file name 
associated with the main clip.

56

[ Main / Sub Rec]
Sub recording. Simultaneously records a clip to SD card B with a different video configuration from 
that of the main clip on SD card A.

54

[Relay Recording]
Relay recording. Continues recording on the other card without interruption when the card you are 
using becomes full. It is available from SD card A to SD card B and vice versa.

–

[Double Slot Recording]
Double slot recording. Records the same clip simultaneously to both cards, which is a convenient way 
to make a backup copy of your recordings.

–

Second card recording function

Off Proxy Recording Sub Recording Relay Recording
Double Slot 
Recording

Recording 
mode

Normal Recording Ü Ü Ü Ü Ü

Slow & Fast Motion Recording Ü – – – –

Pre-recording Ü Ü Ü Ü Ü

Continuous Recording Ü – – – –
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NOTES

• It is not possible to switch between card slots when proxy recording, sub recording or continuous recording is 
activated.

• If a card becomes full during double slot recording, recording on both cards will stop. On the other hand, if an 
error occurs with one of the cards, recording will continue on the other card.
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Setting the File Name for Recordings
This section explains how to set the file names for XF-AVC clips, MP4 clips and photos. 

XF-AVC Clips File Names
The camera allows you to change several settings that determine the clip file name of recorded XF-AVC clips (only in 
CAMERA mode). For more details on how to enter characters, see Entering text and numbers (A 25).
The basic file name structure is as follows.

• Apart from the suffix "_P" in component number 7, the file name of the primary clip and the proxy clip will be 
identical.

• Apart from component number 2, the file name of the primary clip and the sub recording clip will be identical.
• The file name of double slot recording clips will be the same on both SD cards.
• Apart from the .WAV extension, the file name of the audio recorded with slow & fast motion clips will be the 

same as that of the clip, and will be saved on the "/PRIVATE/AUDIO" folder.

To set the camera index

Select  > [Æ Recording/Media Setup] > [Metadata] > [Camera Index] > Desired camera index (A 25).

To set the clip numbering method

Select  > [Æ Recording/Media Setup] > [Metadata] > [Clip Numbering] > [Reset] or 
[Continuous].

Options
[Reset]: The clip number will restart from 001 every time you insert a new card.
[Continuous]: Clip numbers will start from the initial number set with [Clip Number] (following procedure) and 

continue across multiple cards.

A 0 0 1 C 0 0 1 _ y y m m d d X X _ C A N O N _ 0 1 P
1 2 3 4 6 75

1 Camera index: One character (A to Z) that 
identifies the camera used.

2 Reel number: 3 characters (001 to 999) that 
identify the card used. The number is assigned 
automatically but you can set the initial number.
After you insert a new card (just purchased or 
initialized), the number advances by one when the 
first recording is made.

3 Clip number: 4 characters (C001 to D999). The 
clip number advances automatically with each 
clip recorded (switching to D001 after C999), but 
you can set the initial clip number and select the 
clip numbering method.

4 Recording date (set automatically by the camera).

5 Random component: 2 characters (numbers 0 to 
9 and capital letters A to Z) that change randomly 
with each clip.

6 User defined field: 5 characters (numbers 0 to 9 
and capital letters A to Z) for any other 
identification purposes.

7 Proxy clips only: The camera will automatically 
add the suffix “_P” to the file name of proxy clips. 
Additionally, when an SD or SDHC card is used to 
record proxy clips, a stream number (01 to 99) will 
be added before the “P”. The stream number will 
advance every time the video (stream) file within 
the clip is split and recording continues on a 
separate stream file.
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To set the reel number or initial clip number

1 Select  > [Æ Recording/Media Setup] > [Metadata] > [Reel Number] or [Clip Number] > [Change].
• To return to initial settings, select [Reset] instead.

2 Enter the reel/clip number using the data entry screen (A 25).

To set the user-defined field

1 Select  > [Æ Recording/Media Setup] > [Metadata] > [User Defined] > [Change].
• To return to initial settings, select [Reset] instead.

2 Enter the desired text string using the data entry screen (A 25).

MP4 Clip and Photo Numbering
MP4 clips and photos are automatically assigned consecutive numbers and stored on the SD card in folders. 
You can select the numbering method to be used.

MP4 clip/photo folder names and file names

MP4 clip/photo number 

• For sub recording clips, the folder name and consecutive number (“nnnn”) will be the same in both SD cards.
• For double slot recording clips, the folder name and file name will be the same in both SD cards.
• The audio recorded during slow & fast motion recording will have the same file name as that of the primary clip 

with the addition of "_yyyymmddHHMMSS" (year, month, day, hour, minute, second), and will be stored in the 
“/PRIVATE/AUDIO/” folder of the card.

Select  > [Æ Recording/Media Setup] > [MP4 Clip/Photo Numbering] > Desired option.

Options
[Reset]: Recording numbers will restart from 100-0001 every time you insert a new card. If a card already 

contains previous recordings, numbers will continue from the number following that of the last 
MP4 clip/photo on the card.

[Continuous]: Recording numbers will continue from the number following that of the last MP4 clip/photo 
recorded with the camera. This setting is the most convenient for managing files on a computer. 
We recommend using the [Continuous] setting.

NOTES

• Each folder can contain up to 500 files. When that number is exceeded, a new folder is created automatically.

xxx   nnnn

x x x __ m m d d

M V I __ n n n n . M P 4

I M G __ n n n n . J P G

M V I S n n n n . M P 4
M V I C n n n n . M P 4

DCIM

: “xxx” indicates the folder number (from 100 to 999), and “nnnn” indicates the consecutive 
number assigned to the MP4 clip/photo (from 0001 to 9999).

: Folder name. “mmdd” indicates the month and day of recording.

: Primary clip (MP4) file name.

: Sub recording clip (MP4) file name.

: Continuous recording clip (SD card B) file name.

: Photo file name.
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Using the Fan
The camera uses a cooling fan to lower the camera’s internal temperature. In CAMERA mode, you can change 
the fan’s operation mode and speed. In MEDIA mode, the fan runs at all times but you can select its speed.

Setting the Fan’s Operation in CAMERA Mode

1 Select  > [B System Setup] > [Fan Mode] > Desired option.

If you selected [Always On]

2 Select  > [B System Setup] > [Fan Speed (Always)] > Desired fan speed.

If you selected [Automatic]

2 Select  > [B System Setup] > [Fan Speed (STBY)] > Desired fan speed in record standby mode.

3 Select  > [B System Setup] > [Fan Speed (REC)] > Desired fan speed while recording.
• The [Maximum] option offers the maximum cooling effect but is available only for [Fan Speed (STBY)], as it is 

noisier.

Options for [Fan Mode]
[Automatic]: The fan runs while the camera is not recording and is automatically turned off while the camera 

is recording. However, if the internal temperature of the camera is too high (b appears in red), 
the fan will be activated automatically (in that case, ` will appear next to the b icon). When 
the camera’s temperature has decreased sufficiently, the fan will be turned off. Use this setting 
when you do not want the camera to pick up the fan’s operating sound.

[Always On]: The fan runs at all times.

Setting the Fan Speed in MEDIA Mode

1 Select  > [B System Setup] > [Fan Speed].

2 Select the desired option.

IMPORTANT

• While the fan is running, the exhaust vent will emit warm air.
• Be careful not to obstruct in any way the fan’s air vents (A 11, 12, 15).

NOTES

• Depending on the ambient temperature and other shooting conditions, the fan may not turn off even if you set 
its operating mode to [Automatic].
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Adjusting the Black Balance
In CAMERA mode, you can have the camera adjust the black balance automatically when ambient temperature 
changes considerably or if there is a noticeable change in a true black video signal.

1 Attach the body cap to the lens mount and set the camera to CAMERA mode.
• If a lens was attached, turn off the camera and remove the lens. Place the body cap back on the lens mount 

and turn on the camera.

2 Select  > [v Camera Setup] > [ABB] > [OK].
• The automatic black balance procedure will start. It may take about 1 minute depending on the frame rate.
• If the sensor is not completely shielded from light, [Error] will appear on the screen. Repeat the procedure 

from the beginning.

NOTES

Adjusting the black balance is necessary in the following cases:
- When using the camera for the very first time or after a long period of not using it.
- After sudden or extreme changes in ambient temperature.
- After changing the sensor mode.
- After activating or deactivating slow & fast motion recording (including switching to another special recording 

mode).
- After changing the shooting frame rate, when slow & fast motion recording is activated.
- After resetting the camera’s settings.

• During the adjustment of the black balance, you may notice some irregular displays appear on the screen. This 
is not a malfunction.
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Recording Video and Photos
This section explains the basics of recording clips* and photos. For details on recording audio, refer to Recording 
Audio (A 87). 
* “Clip” refers to a single movie unit recorded with a single recording operation. You can also include metadata with the clip.

Recording

* Can be assigned to function as a REC button (A 105).

1 Set the Q switch to CAMERA.
• The camera turns on in CAMERA mode and enters record standby mode ([STBY]). The power indicator (tally 

lamp) illuminates in green.
• The access indicators of card slots with a card inserted will illuminate momentarily in red. Then, the access 

indicators of cards selected for recording will change to green.

2 Press the REC button to begin recording.
• Recording starts. The tally lamp changes from green (power indicator) to red and the recording indicator at 

the top of the screen changes from [STBY] to [ÜREC].
• The access indicator of cards used for recording will illuminate in red.
• You can also perform this function remotely using Browser Remote on a connected network device (A 160).

3 Press the REC button to stop recording.
• The clip is recorded and the camera enters record standby mode. The tally lamp changes from red to green 

(power indicator).
• The access indicator of cards selected for recording will change back to green.

*SD card access 
indicator

Power indicator/
Tally lamp
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IMPORTANT
• Be sure to save your recordings regularly, especially after making important recordings. Canon shall not be 

liable for any loss or corruption of data.

NOTESNOTES
• If you record using metadata settings, those settings will be recorded with the (XF-AVC) clip. For more details, 

refer to Using Metadata (A 98).
• If the camera switches to the other card while recording video due to the relay recording function (A 35), the 

two parts (before/after the switch) will be recorded as separate clips.
• A single clip can be recorded continuously for up to 6 hours. At that point, a new clip will be created 

automatically and recording will continue on a separate clip.
• You can use the review function (A 47) to play back part or all of the last clip recorded without having to 

switch to MEDIA mode.
• When recording clips on SDHC cards, the video (stream) file in the clip will be split approximately every 4 GB. 

Playback with the camera will be seamless.
• You can assign the [REC] function to assignable button Camera 4 and use it to start/stop recording.
• You can set  > [B System Setup] > [Onscreen REC/STBY Button] to [On] to use the onscreen 

[ÜREC]/[STBY] touch buttons to stop and start recording respectively.

To take photos

While the camera is in record standby mode, you can record photos on SD card B.

1 Set an assignable button to [Photo] (A 105).

2 When the camera is in record standby mode, press the assignable button.
•  appears on the screen and the photo is recorded on SD card B.
• The SD CARD access indicator will illuminate in red.
• The size of the recorded photos depends on the video configuration currently in use. For details, refer to 

Specifications (A 200).

NOTESNOTES

• Photos cannot be recorded in the following cases
- While recording a clip, or when slow & fast motion recording is activated.
- When pre-recording is activated.
- While Browser Remote is activated.
- While color bars are displayed.
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Onscreen Displays
Refer to this section for an explanation of the various screen displays that appear in CAMERA mode. You can 
use the custom display function (A 167) to turn off individual onscreen displays if they are not required. The 
menu item that controls each display is given in the following tables (1: indicates a menu item under [Custom 
Display 1] and 2: indicates a menu item under [Custom Display 2]).
The position of some icons and onscreen displays may change depending on the display level settings, which 
can be set to level 1, level 2 or level 3. The following screenshot and tables describe the onscreen displays at 
display level 1 with the [All Displays] setting (A 46).

AF frames
You can turn AF frames on/off with the  > [¢ Monitoring Setup] > [Custom Display 1] > [Focus Mode] 
setting.

Continuous AF frame – always in white (A 73)
AF-Boosted MF frame – in yellow: manual adjustment range; in white: automatic adjustment range (A 73)

One-shot AF frame (A 72)

Face AF: Main subject (A 75)

Face AF: 
Only one face detected or faces 
other than the main subject

Tracking: Subject selection (A 76)

Tracking: During tracking Focus guide (A 70) 
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Left side of the screen

Top of the screen

Icon/Display Description Custom Display

0000 mm Approximate focal length of the lens. 1: [Focal Length]

000.0 m Object distance (numeric).

• Only when an RF lens or certain EF Cinema lenses are attached.

1: [Object Distance 
(Numeric)]

A, @ Focus mode (A 69). 1: [Focus Mode]

, Face AF (A 75).

, Image stabilization enabled/disabled (A 78). 1: [Digital IS]

Super16 Digital IS (A 78).

j (Lens information) Lens information. 

• Depending on the lens, the information displayed may differ.

1: [Lens]

i (in red) Lens error warning (A 184).

/00 Custom picture file selected (A 109). 1: [Custom Picture]

, , , , 
, , , 
, 

[Gamma/Color Space] setting in the custom picture file (A 113).

Look Files (A 111).

, Light metering mode (A 65). 1: [Light Metering]

A viewing LUT has been applied (A 131). 1: [LUT]

GPS signal: continuously on - satellite signal acquired; flashing - satellite signal not 
acquired.

• Displayed only when a GP-E2 GPS Receiver is connected to the camera.

2: [GPS]

` Fan operation: in white – normal (A 39); in red – fan warning (A 184). 2: [Temperature/Fan]

b (in green) Temperature warning (A 39).

• When the camera internal temperature rises above a certain level, b will 
appear in yellow. If the temperature rises further, b will appear in red.

Q User memo (A 98). 2: [User Memo]

Icon/Display Description Custom Display

Recording media status, estimated remaining recording time and recording format 2: [Remaining Rec Time]

,  (in green)
000 min

 / : SD card (primary clips). 
The card’s status is indicated by the icon’s color: in green – can record; in yellow – 
card almost full (5 minutes or less); in red – card almost full (less than 1 minute); in 
white – reading the card.

• The card selected for recording is indicated with a  mark.

,  (in red) END Card is full.

,  (in red) No card or cannot record on the card.

, ¸ Video format (A 53).

Audio files for slow & fast motion recording (A 100).

, , 
, , 

Network connection status (A 152). 2: [Network Functions]
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Right side of the screen

4 Double slot recording (A 35). 2: [Recording Mode]

Recording operation

STBY, ÜREC Clip recording: record standby, recording.

S&F STBY, 
S&F ÜREC

Slow & fast motion recording (A 100): record standby, recording.

PRE STBY, 
PRE ÜREC

Pre-recording (A 101): record standby, recording.

CONT, ÜCONT Continuous recording (A 102)

` Recording command (A 129). 2: [Rec Command]

00.00P, 00.00i Frame rate (A 53).
When slow & fast motion recording is activated, the shooting frame rate is also 
displayed (000/00.00P).

2: [Frame Rate]

C Key lock (A 15). 1: [Key Lock]

00:00:00.00 / 00:00:00:00 
R, P, F, E

Time code (A 83).
Time code status (A 84).

2: [Time Code]

Power supply level indicator 2: [Remaining Battery]

è � é � 
ê � ë � 

 (in red)
000 min

Remaining battery charge of a BP-A30 or BP-A60 Battery Pack and estimated 
remaining usage time (in minutes).

• When  is displayed, replace the battery pack with a fully charged one.
• Depending on the conditions of use, the actual battery charge level may not be 

indicated accurately or may not match the levels shown on the [B System 
Setup] status screen or the indicators on the battery pack.

DC IN 00.0V Power supply voltage when using an AC adapter. 

• When the voltage falls below the selected low-power warning level (A 172), 
the voltage will be displayed in red.

Icon/Display Description Custom Display

, Sensor mode (A 53). 2: [Sensor Mode]

0000x0000 Resolution (A 53). 2: [Resolution/
Color Sampling]YCC000 00 bit Color depth, color sampling (A 53).

7 (in green) Photo recorded on the SD card (A 42). 2: [Photo]

 (in red) No SD card or cannot record photos on the SD card.

60(24)fps,
60(30)fps

Video output (A 105). 2: [Output Terminals 
Status]

T (in red) Output onscreen displays (A 129). 2: [OSD Output]

^ (in yellow) Magnification (A 71). 1: [Magnification]

J, K (in yellow) Peaking (A 71). 1: [Peaking]

Audio limiter (A 91). 2: [Audio Level Indicator]

Audio level meter (A 90).

×00, Headphone volume (A 122). –

Date/time 2: [Date/Time]

CH0/CH0, 
CH0+CH0/CH0+CH0

Audio output channels (A 133). 2: [Monitor Channels]

1/0000.00, 000.00°, 000.00Hz Shutter speed (A 57). 1: [Shutter]

Icon/Display Description Custom Display
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Bottom and center of the screen

Selecting the Onscreen Display Level

You can press the DISP button to control de amount of information shown 
over the image. Repeatedly pressing the DISP button will change the 
display level: Display level 1 � Display level 2 � Display level 3 � Display 
level 1. In CAMERA mode, you can change the information displayed at 
each display level in the menu (A 167). 

CAMERA mode

MEDIA mode

1  > [¢ Monitoring Setup] > [DISP Level 1], [DISP Level 2] or [DISP Level 3].
2 Smaller onscreen displays (same size as when set to [All Displays (Periph. Border)]).

Icon/Display Description Custom Display

Object distance (bar).

• Only when an RF lens is attached to the camera.

1: [Object Distance (Bar)]

 Direct touch control (A 49) –

A001C001 to Z999D999 Clip identification. Includes the camera index, reel number and clip number 
components of the clip file name (A 37).

2: [Reel/Clip Number]

00 00 00 00 User bit (A 84). 2: [User Bit]

Exposure bar (A 65). 1: [Exposure Bar]

AE ±0.00 AE shift (A 65). 1: [AE Shift]

ÅA / ÅB, ¼, É, È, 
 

00000K ±0

White balance (A 66). 1: [White Balance]

ND 00 stops ND filter (A 61). 1: [ND Filter]

E, F00.0 / T00.0, closed Aperture value (A 62). 1: [Iris]

EISO 000000, 00.0dB ISO speed/Gain value (A 59). 1: [ISO/Gain]

Display level1 Options Description

[DISP Level 1] [All Displays] All onscreen displays at a larger size.

[All Displays (Periph. Border)] All onscreen displays at a smaller size, more appropriate for use with the peripheral border.

[DISP Level 2]2 [Main Recording Displays] Only the onscreen displays most relevant for shooting.

[Only FUNC/MENU] Only markers, focus frames/tracking frame, and video scopes are displayed. When the FUNC 
button, MENU button or an assignable button is pressed, the necessary information will be 
displayed.

[DISP Level 3]2 [Only REC/STBY] No onscreen displays except for the recording operation (REC/STBY).

[No Displays] No onscreen displays at all.

Display level1 During clip playback During photo playback Index screen/During audio playback

[DISP Level 1] All onscreen displays. All onscreen displays.

All onscreen displays.[DISP Level 2] All onscreen displays except for the joystick guide. No onscreen displays.

[DISP Level 3] No onscreen displays. –

Example of the 
[Main Recording Displays] option
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NOTESNOTES

• The zebra pattern and false color display will appear on the screen regardless of the selected display level.
• You can change the transparency level of onscreen displays (A 129).

Peripheral Border Display

You can apply the peripheral border display to all display levels. With the peripheral border display, the camera’s 
image is reduced slightly so the onscreen displays are shown mostly around it and not on top of it, partially 
hiding it. The peripheral border is linked with the display level. You can select the levels that use the peripheral 
border with the  > [¢ Monitoring Setup] > [Apply Peripheral Border] setting.

Onscreen Displays in Portrait Mode

When shooting in portrait mode, you can change the orientation of the onscreen 
displays.

Select  > [¢ Monitoring Setup] > [OSD Orientation: LCD] > [90 degrees] 
or [270 degrees].

NOTESNOTES

• For video output from the HDMI OUT terminal, select  > [¢ Monitoring 
Setup] > [OSD Orientation: HDMI] > Desired option (only when rotating the LCD 
monitor's onscreen displays).

• The menu and status screens cannot be rotated.
• Direct touch control and the peripheral border display cannot be used when the 

CAMERA mode screen is rotated. 

Reviewing a Recording
If you set an assignable button to [Review Recording] in advance, you can review all or part of the last clip 
recorded even with the camera set to CAMERA mode.

1 Set an assignable button to [Review Recording] (A 105).

2 Select  > [B System Setup] > [Review Recording] > Desired option.

Full-screen display Peripheral border display



Recording Video and Photos

48

3 After you finish recording a clip, press the assignable button.
• The last clip that was recorded is played back for the selected duration. [Ð REVIEW] appears on the 

screen.
• There will be no sound from the built-in speaker but the audio will be output from the × (headphone) 

terminal and HDMI OUT terminal.
• You can use the joystick to jump back/forward within the clip. You can also touch or slide the onscreen 

progress bar to move to a different position in the video (A 122).
• Press CANCEL or flick down on the screen to stop reviewing the clip.
• After the clip finishes playing back, or if you stop reviewing the clip, the camera returns to record standby 

mode.

Options
[Entire Clip]: Allows you to review the entire clip.
[Last 4 sec]: Allows you to review just the last 4 seconds of the clip.

NOTESNOTES

• If the camera switched cards during a recording, the camera will play back the clip on the card most recently 
recorded on.

• You cannot review clips when continuous recording is activated.
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Adjusting Camera and Recording Settings
Using direct touch control, you can perform a variety of settings (camera, recording, assistance functions, etc.) in 
CAMERA mode. White balance and exposure related settings can also be modified with the direct setting mode, 
using the FUNC button.

Performing Basic Settings with Direct Touch Control
With direct touch control you can change commonly used settings such as camera and recording settings and 
assistance functions. For details about each function, refer to the respective section on the manual.

Available Direct Touch Control Settings

Turn on/off the Direct Touch Control Interface

Even when the direct touch control interface is displayed, you can still use other functions such as recording, 
menu settings, direct setting mode or status screens.

1 Touch  to open the direct touch control interface.

2 Touch X to close the direct touch control interface.

Touch button Available settings

White balance White balance mode (custom, preset, color temperature, automatic (AWB)), color correction value.

ND filter Off ([0 stops]), 5 different density settings.

Aperture Adjustment of the F value/T value.

ISO/Gain Adjustment of ISO or gain value/adjustment value preset.

Shutter speed Adjustment of the value in the current shutter speed mode.

A (assistance functions) Focus guide (on/off), peaking (type), WFM, zebra (type), false color (on/off), markers (on/off), LUT (on/off).

Æ(recording settings) Sensor mode, recording mode, second card recording functions, slow & fast shooting frame rate, main recording 
format, / file selection, main resolution/bit rate, frame rate, sub recording format, proxy recording color 
conversion, sub recording resolution/bit rate and sub recording frame rate.

Recording settings

Assistance functionsOpening ( )/ Closing (X) the
direct touch control interface

Camera settings
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Changing Camera Settings

1 Touch the setting you want to adjust, then select the desired value/
setting.
• Once the settings menu is displayed, touch to select the desired 

value/setting as needed.
• When the slider appears, drag the slider left/right or touch the �/
� buttons to adjust the desired value.

• You can also use the SELECT dial or the control dial.

2 Touch K. 

Using Assistance Functions

1 Touch A (assistance functions) and then turn assistance functions 
on/off, or select the desired assistance function.

2 Touch K. 

Changing Recording Settings

1 Touch Æ (Recording Settings) 
• The recording settings menu will be displayed. There are three 

pages that can be switched by swiping left and right.

2 Select the desired menu setting and then select the desired option.

3 Touch X. 

Direct Setting Mode (FUNC Button)
You can adjust main camera functions—white balance, aperture, ISO 
speed/gain and shutter speed—using the FUNC button (direct setting 
mode). This section will explain the basic operation of the direct setting 
mode. For details about each function, refer to the respective section on 
the manual.

1 Press the FUNC button.
• The onscreen display of the selected function will be highlighted in 

orange.
• Press the FUNC button repeatedly or push the joystick left/right to 

select a different function (the rear control dial can also be used).

2 Push the joystick up/down or turn the SELECT dial to select the 
desired value or white balance mode.
• You can also use the front control dial.

3 Press SET.
• The selected value/mode will be set and direct setting mode will end.
• The onscreen display of the selected function will return to normal.

Drag the slider to select the desired value
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NOTESNOTES

• The camera will automatically end the direct setting mode in the following cases.
- If no operation was performed for more than 6 seconds.
- If the FUNC button is pressed while selecting the shutter speed.
- If the menu or a status screen was opened.

• If you set an assignable button to [White Balance], [Iris], [ISO/Gain] or [Shutter], you can press the button to 
enter direct setting mode with the respective function highlighted.
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Video Recording Configuration: Video Format, Sensor Mode, 
System Frequency, Resolution and Frame Rate
When recording media, you can set the video configuration used for primary clips with the following procedures. 
Select the sensor mode, main recording format (video format, color sampling, bit depth), primary resolution/bit 
rate and frame rate settings that best match your creative needs. Available options for some settings may 
change depending on previous selections for other settings. See the following tables for a summary.
For details about sub recording clips and audio, refer to Sub Recording Clips (A 54) and Recording Audio 
(A 87) respectively.

XF-AVC

The camera uses a variable bit rate (VBR). Intra-frame options compress the image after analyzing each frame separately and are 
more appropriate for editing. Long GOP options compress the image after analyzing also changes across a group of pictures 
and offer better compression (smaller data size).

MP4

NOTESNOTES

• For details on the signal output from each terminal, refer to Video Output Configuration (A 127).

Main 
recording 

format

Sensor 
mode*

Main 
resolution 

Bit rate

System frequency/Frame rate

59.94 Hz 50.00 Hz 24.00 Hz

59.94P 59.94i 29.97P 23.98P 50.00P 50.00i 25.00P 24.00P

XF-AVC
YCC422 
10 bit

Super 
35mm

4096x2160
3840x2160 

410 Mbps Intra-frame – – Ü Ü – – Ü Ü

260 Mbps Long GOP Ü – – – Ü – – –

160 Mbps Long GOP – – Ü Ü – – Ü Ü

Super 
35mm

Super 
16mm 
(Crop)

2048x1080 

310 Mbps Intra-frame Ü – – – Ü – – –

160 Mbps Intra-frame – – Ü Ü – – Ü Ü

50 Mbps Long GOP Ü – Ü Ü Ü – Ü Ü

1920x1080 

310 Mbps Intra-frame Ü – – – Ü – – –

160 Mbps Intra-frame – Ü Ü Ü – Ü Ü Ü

50 Mbps Long GOP Ü Ü Ü Ü Ü Ü Ü Ü

1280x720 24 Mbps Long GOP Ü – – – Ü – – –

Main recording 
format

Sensor mode* Main resolution

System frequency/Frame rate

59.94 Hz 50.00 Hz 24.00 Hz

59.94P 29.97P 23.98P 50.00P 25.00P 24.00P

MP4(HEVC)
YCC422 10 bit

MP4(HEVC)
YCC420 10 bit

MP4(H.264)
YCC420 8 bit

Super 35mm
4096x2160 Ü Ü Ü Ü Ü Ü

3840x2160 Ü Ü Ü Ü Ü Ü

Super 35mm
Super 16mm (Crop)

2048x1080 Ü Ü Ü Ü Ü Ü

1920x1080 Ü Ü Ü Ü Ü Ü

1280x720 Ü – – Ü – –
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Selecting the System Frequency
You can change the system frequency also in MEDIA mode if you want to play back clips from a card recorded 
with a different system frequency setting.

1 Select  > [Æ Recording/Media Setup] > [System Frequency].

2 Select the desired option.
• The camera will reset and restart in the selected mode.

Selecting the Sensor Mode
You can change the area of the imaging circle covered by the CMOS sensor to produce the recorded image. 

1 Select  > [Æ Recording/Media Setup] > [Sensor Mode].
• You can also adjust this setting using direct touch control (A 49).

2 Select the desired option.

NOTESNOTES

• You cannot change the sensor mode when [Super16 Digital IS] (A 78) is set to [On].

Selecting the Main Recording Format
Select the combination of video format, color sampling and bit depth for primary clips.

1 Select  > [Æ Recording/Media Setup] > [Main Rec Format].
• You can also adjust this setting using direct touch control (A 49).

2 Select the desired option.

Selecting the Resolution and Bit Rate of Primary Clips
1 Select  > [Æ Recording/Media Setup] > [Main Resolution/Bit Rate].

• You can also adjust this setting using direct touch control (A 49).

2 Select the desired option.

Selecting the Frame Rate
Select the frame rate for the primary clips. This procedure is not necessary when the system frequency is set to 
24.00 Hz.

1 Select  > [Æ Recording/Media Setup] > [Frame Rate].
• You can also adjust this setting using direct touch control (A 49).

2 Select the desired option.
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Sub Recording Clips
While recording a primary clip on an SD card A, you can simultaneously record the same scene on SD card B. 
See the following table for more details on the video configuration for sub recording clips. For more details on 
audio, see Recording Audio (A 87).
You can also use direct touch control to perform this function (A 49).

Video configuration for sub recording clips (primary clip: XF-AVC)

1 Sub recording frame rate is the same as that of the primary clip. 
2 59.94i/50.00i can also be selected.

Primary clip
Video configuration of sub recording clips1

Sub recording format, resolution and bit rate

Main 
recording 

format
Main resolution/bit rate Frame rate XF-AVC  YCC422 10 bit MP4 (H.264)  YCC420 8 bit

XF-AVC
YCC422 10 bit

4096x2160

410 Mbps Intra-frame 29.97P, 25.00P,
24.00P, 23.98P

4096x2160 / 160 Mbps Long GOP,
2048x1080 / 160 Mbps Intra-frame 4096x2160 / 150 Mbps,

2048x1080 / 35 Mbps

2048x1080 / 50 Mbps Long GOP
260 Mbps Long GOP 59.94P, 50.00P 2048x1080 / 35 Mbps

160 Mbps Long GOP 29.97P, 25.00P,
24.00P, 23.98P

4096x2160 / 150 Mbps,
2048x1080 / 35 Mbps

3840x2160

410 Mbps Intra-frame 29.97P, 25.00P,
24.00P, 23.98P

3840x2160 / 160 Mbps Long GOP,
1920x1080 / 160 Mbps Intra-frame,

1920x1080 / 50 Mbps Long GOP

3840x2160 / 150 Mbps

1920x1080 / 35 Mbps

260 Mbps Long GOP 59.94P, 50.00P
1920x1080 / 50 Mbps Long GOP2

1280x720 / 24 Mbps Long GOP 1280x720 / 8 Mbps

160 Mbps Long GOP 29.97P, 25.00P,
24.00P, 23.98P 1920x1080 / 50 Mbps Long GOP 3840x2160 / 150 Mbps,

1920x1080 / 35 Mbps

2048x1080

310 Mbps Intra-frame 59.94P, 50.00P
2048x1080 / 50 Mbps Long GOP

2048x1080 / 35 Mbps
160 Mbps Intra-frame 29.97P, 25.00P,

24.00P, 23.98P

50 Mbps Long GOP
59.94P, 50.00P,
29.97P, 25.00P,
24.00P, 23.98P

–

1920x1080

310 Mbps Intra-frame 59.94P, 50.00P 1920x1080 / 50 Mbps Long GOP,
1280x720 / 24 Mbps Long GOP

1920x1080 / 35 Mbps,
1280x720 / 8 Mbps

160 Mbps Intra-frame
29.97P, 25.00P,
24.00P, 23.98P 1920x1080 / 50 Mbps Long GOP

1920x1080 / 35 Mbps

59.94i, 50.00i –

50 Mbps Long GOP
59.94P, 50.00P 1280x720 / 24 Mbps Long GOP 1920x1080 / 35 Mbps,

1280x720 / 8 Mbps

29.97P, 25.00P,
24.00P, 23.98P – 1920x1080 / 35 Mbps

1280x720 24 Mbps Long GOP 59.94P, 50.00P – 1280x720 / 8 Mbps
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Video configuration for sub recording clips (primary clip: MP4)

* Only when frame rate is 59.94P/50.00P

1 Insert an SD card into each card slot (slot A for the main clip, slot B for the sub recording clip).

2 Select  > [Æ Recording/Media Setup] > [2nd Card Rec Functions] > [ Main / Sub Rec].

3 Select  > [Æ Recording/Media Setup] > [Sub Rec Format] > Desired option.

4 Select  > [Æ Recording/Media Setup] > [Sub Resolution/Bit Rate] > Desired option.

5 Select  > [Æ Recording/Media Setup] > [Sub Rec Frame Rate] > Desired option.
• Frame rate can only be selected with some main recording formats.

6 Press the REC button to start recording.
• Proxy clips will be recorded simultaneously with the primary clips.

NOTESNOTES

• If there is no card inserted in the slot used for the primary clip, only the sub recording clip will be recorded.

Primary clip
Video configuration of sub recording clips

Sub recording format, resolution and bit rate

Main 
recording 

format
Main resolution/bit rate Frame rate MP4 (HEVC)

YCC422 10 bit
MP4 (HEVC)

YCC420 10 bit
MP4 (H.264)
YCC420 8 bit

MP4 (HEVC)
 YCC422 

10 bit

4096x2160
225 Mbps 59.94P, 50.00P

2048x1080 / 50 Mbps
2048x1080 / 35 Mbps

–

135 Mbps 29.97P, 25.00P,
24.00P, 23.98P

4096x2160 / 100 Mbps,
2048x1080 / 35 Mbps

3840x2160
225 Mbps 59.94P, 50.00P 1920x1080 / 50 Mbps,

1280x720 / 12 Mbps
1920x1080 / 35 Mbps,

1280x720 / 9 Mbps

135 Mbps 29.97P, 25.00P,
24.00P, 23.98P 1920x1080 / 50 Mbps 3840x2160 / 100 Mbps,

1920x1080 / 35 Mbps

2048x1080 50 Mbps
59.94P, 50.00P,
29.97P, 25.00P,
24.00P, 23.98P

– 2048x1080 / 35 Mbps

1920x1080 50 Mbps
59.94P, 50.00P 1280x720 / 12 Mbps

1280x720 / 9 Mbps

1920x1080 / 35 Mbps29.97P, 25.00P,
24.00P, 23.98P –

1280x720 12 Mbps 59.94P, 50.00P – 1280x720 / 9 Mbps

MP4 (HEVC)
 YCC420 

10 bit

4096x2160
170 Mbps 59.94P, 50.00P

–

2048x1080 / 35 Mbps

–

100 Mbps 29.97P, 25.00P,
24.00P, 23.98P 2048x1080 / 35 Mbps

3840x2160
170 Mbps 59.94P, 50.00P 1920x1080 / 35 Mbps,

1280x720 / 9 Mbps

100 Mbps 29.97P, 25.00P,
24.00P, 23.98P 1920x1080 / 35 Mbps

1920x1080 35 Mbps 59.94P, 50.00P 1280x720 / 9 Mbps

MP4 (H.264)
 YCC420 8 bit

4096x2160 150 Mbps 59.94P, 50.00P,
29.97P, 25.00P,
24.00P, 23.98P – –

2048x1080 / 35 Mbps

3840x2160 150 Mbps 1920x1080 / 35 Mbps,
1280x720 / 8 Mbps*

1920x1080 35 Mbps 59.94P, 50.00P 1280x720 / 8 Mbps
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Proxy Clips
While recording a primary clip on an SD card A, you can simultaneously record the same scene as a proxy clip 
(XF-AVC format) on another SD card B. Because proxy clips have smaller files, they are suitable for offline editing.
You can also use direct touch control to perform this function (A 49).

Video configuration of proxy clips

1 Insert an SD card into each card slot (slot A for the main clip, slot B for the proxy clip).

2 Set the main recording format to [XF-AVC] (A 53).

3 Select  > [Æ Recording/Media Setup] > [2nd Card Rec Functions] > [ Main / Proxy Rec].

4 Select  > [Æ Recording/Media Setup] > [Proxy Rec Color Conversion] > Desired option.

5 Press the REC button to start recording.
• Proxy clips will be recorded simultaneously with the primary clips.

Options
[Conform to Custom Picture]: 

No change is applied.
[BT.709]: When the gamma curve component of the [Gamma/Color Space] setting in the custom picture 

file is set to [BT.709 Wide DR] or [BT.709 Normal], no change is applied. When it is set to a 
different option, it is changed to [BT.709 Wide DR] and the color space component changes to 
[BT.709]. If the original gamma was set to HDR, you can adjust the brightness settings with the 

 > [¢ Monitoring Setup] > [Gain for HDR�SDR Conv.] setting (A 132).

NOTESNOTES

• If the recording of the primary clip stops during simultaneous recording, recording of the proxy clip will stop as 
well. 

• If there is no card inserted in the slot used for the primary clip, only the proxy clip will be recorded.

Primary clip Video configuration of proxy clips

Main recording format Main resolution Frame rate Recording format Resolution/ bit rate Frame rate

XF-AVC
YCC422 10 bit

4096x2160,
2048x1080

59.94P, 50.00P

XF-AVC
YCC420 8 bit

2048x1080 / 35 Mbps Long GOP

Same as main clip

29.97P, 25.00P,
24.00P, 23.98P 2048x1080 / 24 Mbps Long GOP

3840x2160,
1920x1080

59.94P, 50.00P 1920x1080 / 35 Mbps Long GOP

29.97P, 25.00P,
24.00P, 23.98P 1920x1080 / 24 Mbps Long GOP

1920x1080 59.94i, 50.00i

1280x720 59.94P, 50.00P 1280x720 / 17 Mbps Long GOP
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Shutter Speed
You can set the shutter speed according to the shooting conditions. For example, you may want to set slower 
shutter speeds in darker environments. The camera offers the following modes.
You can also perform this function remotely using Browser Remote on a connected network device (A 159).

[Speed]: Allows you to set the shutter speed (in fractions of a second). You can select the increment to use when 
adjusting the shutter speed between 1/3-stop and 1/4-stop increments.

[Angle]: You can set the shutter angle to determine the shutter speed.

[Clear Scan]: Set the frequency in order to record CRT computer monitors without displaying black bands or 
flicker on the screen.

[Slow]: You can set slower shutter speeds to obtain brighter recordings in places with insufficient lighting. This 
mode is not available when slow & fast motion recording is activated.

[Off]: The camera uses a standard shutter speed based on the frame rate.

Available shutter speeds
The individual setting options that can be selected will change depending on the frame rate used.

1 59.94i and 50.00i are available only for XF-AVC (YCC422 10 bit) primary clips.
2 When slow & fast motion recording is activated, available setting options will vary depending on the selected shooting frame rate.
3 Not available when slow & fast motion recording is activated.

1 Select  > [v Camera Setup] > [Shutter Mode] > Desired shutter speed mode.

2 For [Speed] only: Select  > [v Camera Setup] > [Shutter Increment] > [1/3 stop] or [1/4 stop].

3 Adjust the shutter speed, angle value or clear scan frequency using the direct setting mode (A 50).
• You can also use direct touch control (A 49).

NOTESNOTES

• When recording under artificial light sources such as fluorescent, mercury or halogen lamps, the screen may 
flicker depending on the shutter speed. You may be able to avoid flicker by setting the shutter speed mode to 
[Speed] and the shutter speed to a value matching the frequency of the local electrical system: 1/50* or 1/100 
for 50 Hz systems, 1/60 or 1/120 for 60 Hz systems.
* May not be available depending on the frame rate.

Shutter speed mode
System frequency/Frame rate

59.94 Hz 24.00 Hz 50.00 Hz
59.94P / 59.94i1 29.97P 23.98P 24.00P 50.00P / 50.00i1 25.00P

[Speed]2

1/3-stop 
increments

1/12 to 1/2000 (24 setting options in total)

1/4-stop 
increments

1/12 to 1/2000 (31 setting options in total)

[Angle]2
360.00°, 240.00°, 180.00°, 120.00°, 90.00°, 60.00°, 45.00°, 30.00°, 22.50°, 15.00°, 11.25°

Also angle values equivalent to the following shutter speeds: 1/120, 1/100, 1/60, 1/50, 1/40, 3/100, 1/30, 1/25.
[Clear Scan]2 23.98 Hz to 250.38 Hz 24.00 Hz to 250.40 Hz
[Slow]3 1/15, 1/30 1/15 1/12 1/12, 1/25 1/12
[Off]2 1/60 1/30 1/24 1/50 1/25

Using slow shutter mode
When recording in dark surroundings, you can obtain a brighter picture by using slow shutter mode. You can 
also use this mode when you wish to add certain effects to your recordings, such as blurring the background 
during panning shots or recording a moving subject with an afterimage trail.
• Image quality may not be as good as when using faster shutter speeds in brighter surroundings.
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• Closing down the aperture when recording under bright conditions may cause the picture to appear soft or out 
of focus. The following measures may be effective in avoiding the loss of sharpness due to diffraction.
- Using a denser ND filter (A 61).
- Using a faster shutter speed.
- Applying diffraction correction (A 28). Results may vary depending on the lens used.

• When the shutter speed mode is set to [Slow], bright red, green or blue dots may appear on the screen. In 
such case, use a faster shutter speed or select a lower ISO speed or gain value (A 59).

• When an RC-V100 Remote Controller is connected to the camera, you can change the shutter speed mode 
with the remote controller’s SHUTTER SELECT button and the shutter speed value with the remote controller’s 
SHUTTER Í/Î buttons.
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ISO Speed/Gain
You may want to adjust the brightness of the image according to the shooting conditions. You can choose 
between manual and automatic settings. By choosing manual settings you can change the ISO speed or gain 
value to adjust the sensitivity of the sensor.
You can also perform this function remotely using Browser Remote on a connected network device (A 156, 
159).

Available ISO speed and gain settings1

1 The minimum sensitivity needed to obtain the recommended dynamic range depends on the gamma curve component of the 
[Gamma/Color Space] setting in the custom picture file (A 113).
[Canon Log 2], [Canon Log 3], or [PQ]: ISO 800 / 12 dB gain
[HLG] or [BT.709 Wide DR]: ISO 400 / 6 dB gain
[BT.709 Normal]: ISO 160 / –2 dB gain

2  > [Æ Recording/Media Setup] > [Main Rec Format] setting.
3  > [v Camera Setup] > [ISO/Gain] setting.
4  > [v Camera Setup] > [ISO Increment] or [Gain Increment] setting.
5 Available only when  > [v Camera Setup] > [ISO/Gain Extended Range] is set to [On].
6 Available only when [ISO/Gain Extended Range] is set to [Off].

Manual ISO Speed/Gain Value
1 Select  > [v Camera Setup] > [ISO/Gain] > [ISO] or [Gain].

2 Select  > [v Camera Setup] > [ISO/Gain Mode] > [Manual].

3 Depending on your previous selection, select  > [v Camera Setup] > [ISO Increment] (ISO 
speed) or [Gain Increment] (gain) > Desired option.

4 Adjust the ISO speed or gain value using the direct setting mode (A 50).
• You can also use direct touch control (A 49).

Using the Control Dial/Control Ring

You can adjust the ISO speed or gain value using the control dial or the 
control ring of an RF lens.

1 Perform steps 1 to 3 in the Manual ISO Speed/Gain Value procedure. 
(A 59)

2 Select  > [B System Setup] > [Front Control Dial], [Rear Control 
Dial] or [Control Ring] > [ISO/Gain].

3 Turn the control dial or control ring to set the desired ISO speed or gain 
value.

Main recording 
format2

ISO/Gain3 Increment4 Normal range Extended range5

XF-AVC
MP4

[ISO]

[1 stop] 1606, 200, 400, 800, 1600, 3200, 6400, 12800, 25600 100, 51200, 102400

[1/3 stop]
160, 200, 250, 320, 400, 500, 640, 800, 1000, 1250, 
1600, 2000, 2500, 3200, 4000, 5000, 6400, 8000, 
10000, 12800, 16000, 20000, 25600

100, 125, 32000, 40000, 
51200, 64000, 80000, 102400

[Gain]

[Normal]
(3 dB)

–2 dB6, 0 dB to 42 dB –6 dB, –3 dB, 45 dB to 54 dB

[Fine]
(0.5 dB)

–2 dB to 42 dB 42.5 dB to 54 dB

Control dial
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ISO Speed/Gain Preset

Using direct touch control (A 49), you can adjust and use up to 3 preset ISO speed/gain values.

Saving a preset value

1 Touch  > Current ISO speed/gain value.

2 Adjust the value selected and touch [Register].

3 Touch the desired position to save the preset value. 
• The current value is saved. 

Using a saved preset value

1 Touch  > Current ISO speed/gain value.

2 Touch the desired preset value (above the slider).
• The selected preset value is applied.

NOTESNOTES

• When high ISO speeds or gain levels are set, the picture may flicker slightly.
• When high ISO speeds or gain levels are set, bright red, green or blue dots may appear on the screen. In such 

case, use a faster shutter speed (A 57) or select a lower ISO speed or gain value.
• When the ISO speed or gain level is changed, some noise may appear momentarily on the screen. Do not 

adjust the ISO speed/gain level while recording.
• You can use the  > [B System Setup] > [Front Ctrl Dial Dir.], [Rear Ctrl Dial Dir.] or [Control Ring Dir.] 

setting to change the direction of the adjustment when you turn the control dial or control ring.
• When an RC-V100 Remote Controller is connected to the camera, you can adjust the ISO speed or gain value 

with the remote controller’s ISO/GAIN Í/Î buttons.
• If you set an assignable button to [ISO/Gain Mode] (A 105), you can press the button to switch between 

automatic and manual adjustment.

Automatic ISO Speed/Gain
The sensitivity is automatically adjusted according to the subject. You can also set a sensitivity limit. Automatic 
adjustment is not available when the [Gamma/Color Space] setting in the custom picture file is set to one of the 
[Canon Log 2] or [Canon Log 3] options, or during slow & fast motion recording.

Select  > [v Camera Setup] > [ISO/Gain Mode] > [Automatic].
• When the [Gamma/Color Space] setting in the custom picture file is set to [BT.709 Normal], the sensitivity limit 

is ISO 320 (4 dB). Otherwise, it is set automatically to ISO 800 (12 dB).

Setting an automatic ISO limit

By setting an ISO limit in automatic mode, you can curb the amount of noise and keep a dark ambient.

Select  > [v Camera Setup] > [Limit for Auto Mode] > Desired option.

Stored preset values

Drag the slider to select the desired value

Touch to register a preset value
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ND Filter

Using the ND filter allows you to open up the aperture to obtain a shallower depth of field even when recording in 
bright surroundings. You can also use the ND filter to avoid the soft focus caused by diffraction when using small 
apertures. By default, you can select one of 3 density levels (up to 6 stops in 2-stop intervals). If you enable the 
extended ND range, you can select one of 5 density levels (up to 10 stops in 2-stop intervals).
You can also perform this function remotely using Browser Remote on a connected network device (A 159).

Press the ND FILTER + or – button to select the desired ND 
filter setting. 
• Repeatedly pressing ND FILTER + button will change the ND filter 

setting in the following order: [ND 2 stops] � [ND 4 stops] � [ND 
6 stops] � [ND 8 stops]* � [ND 10 stops]* � ND filter off. (The ND 
FILTER – button cycles through the settings in reverse order.)

• You can also adjust this setting using direct touch control (A 49).
* Only when  > [v Camera Setup] > [Extended ND Range] is set to [On].

NOTESNOTES

• Depending on the scene, the color may change slightly when turning the ND filter on/off. Setting a custom 
white balance (A 67) may be effective in such case.

About the extended ND range
- When you switch to or from a density level in the extended range (8 or 10 stops), the focus may shift, 

affecting also the indication on the lens’s focus distance scale.
- When you switch to 8 or 10 stops, depending on the lens, the camera may not be able to focus at infinity 

focus.
Changing the ND filter setting using the RC-V100 Remote Controller

- When the remote controller is connected to the camera, you can use the remote controller’s ND button in 
the same way as the camera’s ND FILTER + button.

- For settings between 2 and 8 stops, the corresponding ND filter indicator (1 to 4, respectively) will illuminate 
in orange. When the ND filter is set to 10 stops, indicators 1 and 4 will both illuminate.
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Aperture
You can affect the brightness of your recordings or change the depth of field by adjusting the aperture. 
Depending on the lens used, the aperture value displayed may differ (F value or T value) and available aperture 
values will vary as well (A 203). You can select the adjustment increment and even use the smallest iris 
increment allowed by the lens.
You can also perform this function remotely using Browser Remote on a connected network device (A 159).

Manual aperture: Adjust the aperture value manually.

Push Auto Iris: Momentary automatic aperture. During manual aperture, press the PUSH AUTO IRIS button or 
other control to temporarily adjust the aperture automatically.

Automatic aperture: The camera adjusts the aperture automatically.

Aperture Mode of the Lens
To adjust the aperture from the camera, you will need to enable automatic adjustment using the controls on the 
lens. Required settings vary depending on the lens. Refer to the instruction manual of the lens used.

Set the lens to automatic aperture mode.

Manual Aperture: Changing the Aperture Value
1 Select  > [v Camera Setup] > [Iris Mode] > [Manual].

• This setting is available only when a lens compatible with automatic aperture is attached to the camera. For 
non-compatible lenses, the aperture mode is automatically set to [Manual] and cannot be changed.

2 When using a lens compatible with automatic aperture, set the lens to automatic aperture mode.

3 Select  > [v Camera Setup] > [Iris Increment] > [1/2 Stop] or [1/3 Stop].
• You can also set  > [v Camera Setup] > [Fine Increment] to [On] to use the smallest iris increment 

allowed by the lens attached. Nevertheless, the aperture value displayed on the screen will be the closest 
value in the selected increment scale.

4 Adjust the aperture value using direct setting mode (A 50).
• You can also use direct touch control (A 49).
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Using the Control Dial/Control Ring

You can also adjust the aperture settings using the control dial (after assigning the [Iris] function) or the control 
ring of an RF lens.

1 Select  > [B System Setup] > [Front Control Dial], [Rear 
Control Dial] or [Control Ring] > [Iris].

2 Turn the control dial or the control ring of an RF lens to adjust the 
aperture.
• The selected aperture value will appear at the bottom of the screen.

NOTESNOTES

• You can use the  > [B System Setup] > [Front Ctrl Dial Dir.], [Rear Ctrl Dial Dir.] or [Control Ring Dir.] 
setting to change the direction of the adjustment when you turn the control dial or control ring.

• If you set an assignable button to [Iris +] or [Iris –] (A 105), you can press the button to respectively open up 
or close down the aperture.

• When using a lens with no lens contacts or an incompatible lens (A 203), you cannot adjust the aperture 
using the camera. Adjust it using the lens.

• When using a lens that can correct the aperture value according to the position of the zoom, you can use the 
 > [v Camera Setup] > [Zoom-Iris Correction] setting to activate this correction.

• When an RC-V100 Remote Controller is connected to the camera, you can adjust the aperture with the 
remote controller’s IRIS dial. At default settings, turn the dial right to open up the aperture and left to close the 
aperture.

• Using an EF Cinema lens
- The aperture value displayed on the screen will be a T value. The aperture value (T value) displayed on the 

screen may differ from the indication on the lens’s aperture scale. 
- When the iris is almost fully closed, the aperture value (T value) will appear in gray on the screen.
- When you change the aperture value from a position of fully open or fully closed iris, multiple adjustment 

operations may be required until the aperture changes.
• If you use the EF-EOS R 0.71x Mount Adapter to attach an EF lens, the aperture will be approximately one 

level brighter than the value indicated by the lens. 

Control dial
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Momentary Automatic Aperture - Push Auto Iris
During manual aperture, you can press the PUSH AUTO IRIS button to have the camera temporarily take control 
and adjust the aperture automatically for an optimal exposure.
This function is not available when slow & fast motion recording is activated.

1 Select  > [v Camera Setup] > [Iris Mode] > [Manual].

2 When using a lens compatible with automatic aperture, set the lens 
to automatic aperture mode (A 62).

3 Press and hold the PUSH AUTO IRIS button.
• The camera will automatically adjust the aperture to obtain optimal 

exposure as long as you hold the button pressed down, and E will 
appear on the screen next to the aperture value.

• When you release the button the aperture value will be set, automatic 
aperture mode will end and the E icon will disappear.

NOTESNOTES

• You can use the  > [v Camera Setup] > [AE Response] setting to change how quickly the aperture 
changes during automatic aperture mode. This setting has no effect when using an incompatible lens 
(A 203).

Automatic Aperture
When a compatible lens is attached to the camera, you can have the camera automatically adjust the aperture. 
This function is not available when slow & fast motion recording is activated.

1 Select  > [v Camera Setup] > [Iris Mode] > [Automatic].
• The camera will automatically adjust the aperture to obtain optimal exposure. The selected aperture value 

will appear at the bottom of the screen with an E icon next to it.

2 When using a lens compatible with automatic aperture, set the lens to automatic aperture mode 
(A 62).

NOTESNOTES

• If you set an assignable button to [Iris Mode] (A 105), you can press the button to toggle between the 
[Automatic] and [Manual] settings.

• The aperture value may change in the following cases.
- While using the built-in extender or iris compensation function of an EF Cinema lens, when you switch from 

automatic aperture to manual aperture.
- When the aperture controls on the lens are switched between automatic/manual mode.

• When using EF Cinema lenses that let you adjust the aperture gain, if the aperture gain is set too high, the 
aperture adjustment may not be stable (“aperture hunting”), depending on the shooting conditions. In such 
case, reset the lens’s aperture gain to its initial value.
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Exposure Compensation - AE Shift
Use AE shift to compensate the exposure that was set using automatic aperture, in order to darken or lighten the 
image.
You can also perform this function remotely using Browser Remote on a connected network device (A 159).

1 Select  > [v Camera Setup] > [AE Shift].

2 Select the desired option.
• The camera will attempt to adjust the exposure accordingly.
• You can select one of 17 AE shift levels from –2.0 to +2.0.

NOTESNOTES

• If you set an assignable button to [AE Shift +] or [AE Shift –] (A 105), you can press the button to adjust the 
AE shift level.

Light Metering Mode

Select the light metering mode to match the recording conditions. Using the appropriate setting will help achieve 
a more appropriate exposure level.

1 Select  > [v Camera Setup] > [Light Metering].

2 Select the desired option.
• The icon of the selected mode (  or ) appears on the screen.

Options
[Backlight]: Suitable when recording backlit scenes.
[Standard]: Averages the light metered from the entire screen, giving more weight to the subject in the center.
[Spotlight]: Use this option when recording a scene in which only a certain part of the picture is lit, for 

example, when the subject is lit by a spotlight.

NOTESNOTES

• If you set an assignable button to [Backlight] or [Spotlight] (A 105), you can press the button to toggle 
between the respective light metering mode and [Standard].

• Adjust the exposure again if you change the metering mode after adjusting the aperture manually.

The exposure bar
The Î on top of the exposure bar indicates optimal exposure without any shift 
(AE±0); the scale markings indicate the deviation from optimal exposure in 
1/2 EV increments. The indicator inside the exposure bar represents the current 
exposure. When the difference between current and optimal exposure is larger 
than ±2 EV, the indicator will flash at the edge of the exposure bar. Optimal 
exposure will change depending on the light metering mode used.

Optimal exposure AE±0

Current exposure
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White Balance
The camera uses an electronic white balance process to calibrate the picture and produce accurate colors under 
different lighting conditions. The camera offers the following ways to set the white balance.
You can also perform this function remotely using Browser Remote on a connected network device (A 159).

Custom white balance: You can use a gray card or white object with no pattern to establish the white balance 
and set it to one of two custom white balance positions, ÅA or ÅB. When recording under fluorescent lights, 
we recommend setting the custom white balance.

Preset white balance: Set the white balance to ¼ (daylight) or É (tungsten lamp). You can further adjust the 
color temperature (K) value and the color compensation (CC) value, which adjusts the color along the green/
magenta gradation.

Color temperature: Allows you to set the color temperature between 2,000 K and 15,000 K, and further adjust 
the color compensation (CC) value.

Auto white balance (AWB): The camera automatically adjusts the white balance to the optimal level.

NOTESNOTES

• The [White Balance] and [Color Matrix Tuning] settings in the custom picture file (A 115) take precedence 
over the white balance set with these procedures.

• You can use the  > [v Camera Setup] > [Shockless WB] setting to make the transition look smoother 
when you change the white balance settings.

• When an RC-V100 Remote Controller is connected to the camera, you can adjust the white balance with the 
remote controller’s AWB button, A button, B button, PRESET button and Å button.

• The color temperatures displayed on the screen are approximate. Use them only as a reference.

White Balance Mode
Select a white balance mode using the direct setting mode 
(A 50).
• You can also use direct touch control (A 49).
• If you set  > [B System Setup] > [Front Control Dial], 

[Rear Control Dial] or [Control Ring] to [White Balance Mode], 
you can change the white balance mode using the control dials 
or control ring of an RF lens.

NOTESNOTES

• If you set an assignable button to [  AWB]. [Å Set A], 
[Å Set B], [¼ Daylight], [É Tungsten] or [È Kelvin] (A 105), you can press the button to change the white 
balance mode temporarily. Press the button again to return to the previous white balance mode.



67

White Balance

Custom White Balance

1 Select the ÅA or ÅB icon (A 66).
• To apply the stored custom white balance setting as is, the rest 

of the procedure is not necessary. To set a new custom white 
balance, continue the procedure.

2 Point the camera at a gray card or white object so that it fills 
the center of screen.
• Use the same lighting conditions you plan to use when 

recording.

3 Press the Å button.
• The Å A or Å B icon will flash quickly.
• Make sure the gray card or white object fills the center of the screen until the procedure is completed.
• Once the icon stops flashing, the procedure is completed. The setting is retained even if you turn off the 

camera.

NOTESNOTES

• Readjust the custom white balance if the light source or ND filter setting changes.
• Very rarely and depending on the light source, Å may keep flashing (it will change to a slow flashing). In that 

case, change the subject brightness and adjust the custom white balance again.
• After the camera registers a custom white balance, the color temperature or CC value may appear in gray. This 

indicates that the value registered exceeds the range of values that can be displayed but the white balance is 
correctly calibrated and you can continue shooting.

Color Temperature/Preset White Balance
1 Select the ¼ or É icon (preset white balance), or the 

È icon (color temperature setting) (A 66).
• To apply the stored preset setting or color temperature as is, the 

rest of the procedure is not necessary. To adjust the color 
temperature or CC value, continue the procedure.

2 Press the Å button.
• The camera will enter the direct setting mode with the color 

temperature highlighted in orange. To adjust the CC value, push 
the joystick right.

• You can also adjust the color temperature or CC value using direct touch control (A 49).

3 Select the desired value.
• The selected color temperature and CC value will be set and will appear on the screen next to the white 

balance icon.

White balance mode/setting
Adjustment range

Color temperature (K) Color compensation (CC) value

¼ (daylight) 4,300 K to 8,000 K
–5 to +5

É (tungsten lamp) 2,700 K to 3,700 K

È (color temperature) 2,000 K to 15,000 K –20 to +20
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NOTESNOTES

• You can use the  > [v Camera Setup] > [C. Temp. Increment] setting to change the units for the color 
temperature increment to [Mired] (5-mired increments) or [Kelvin] (100-kelvin increments). Even when [Mired] is 
selected, the color temperature is converted to and displayed in kelvins. Changing this setting may change the 
white balance setting.

• If you set  > [B System Setup] > [Front Control Dial], [Rear Control Dial] or [Control Ring] to [White 
Balance (K)] or [White Balance (CC)], you can adjust the color temperature (K) value and the color 
compensation (CC) value using the control dials or control ring of an RF lens.

Auto White Balance (AWB)
The camera constantly adjusts the white balance automatically to achieve an appropriate level. The camera will 
adjust the white balance if the light source changes.

Select the  icon (A 66).
• The color temperature and CC value set automatically by the camera will appear at the bottom of the screen 

next to the  icon.

NOTESNOTES

• Custom white balance may provide better results in the following cases:
- Changing lighting conditions
- Close-ups
- Subjects in a single color (sky, sea or forest)
- Under mercury lamps and certain types of fluorescent and LED lights

• You can use the  > [v Camera Setup] > [AWB Response] setting to change how quickly the white 
balance changes in auto white balance (AWB) mode.

• If you set an assignable button to [AWB Lock] (A 105), you can press the button to lock the current white 
balance settings set automatically by the camera. To cancel the lock, press the button again (resume auto 
white balance mode) or select a different white balance setting.
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Focus
The camera offers the following ways to focus, depending on the lens used. The camera incorporates Dual Pixel 
CMOS AF technology for advanced autofocus performance with compatible lenses. Refer to the list of 
compatible lenses and functions that can be used (A 203). 
You can also adjust the focus remotely using Browser Remote on a connected network device (A 158).
Note that some methods allow you to operate aspects of the focus by touching the LCD screen.

Manual focus: Turn the focus ring on the lens to adjust the focus. The camera offers several focus assistance 
functions (A 70) to help you focus more accurately when using the manual focus. 

One-shot AF*: You will be able to focus manually but still have the option to press the ONE-SHOT AF button to 
let the camera focus automatically once on the subject inside the AF frame.

AF-Boosted MF*: Focus manually most of the way and let the camera finish focusing automatically.

Continuous AF*: The camera automatically keeps the subject inside the AF frame in focus at all times. You can 
use the AF lock function (A 74) to change the composition of the picture while keeping the focus on the 
selected spot.

Face AF*: The camera automatically detects a person’s face, focuses on it and can track it if that person moves.

Tracking*: After you select a subject, the camera keeps focusing it and tracks the subject if it moves.
* Not available when a manual focus lens is attached to the camera.

Focusing methods and required settings
Available focusing methods will vary depending on the lens (A 203).

1  > [v Camera Setup] > [AF Mode].
2 Depending on the lens, the focus ring may be disabled when the focus mode switch is set to AF.
3 Set  > [v Camera Setup] > [Face Det. & Tracking] to [On].
4 To activate tracking, set an assignable button to [Tracking] and press the button.

Focus Mode on the Lens
Use the switch on the lens to select the lens’s focus mode (automatic, manual). The name of the controls may 
differ depending on the lens. Refer to the instruction manual of the lens used.
 

Set the lens’s focus mode to either automatic or manual.
• Either @ (automatic) or A (manual) will appear on the screen.
• When using a lens without a focus mode switch, select  > [v Camera Setup] > [Focus Mode] > [AF] 

(automatic) or [MF] (manual).

Focusing method Focus mode on the lens AF mode1

Manual focus
Focus ring

Manual –

Automatic2

[One Shot]
Browser Remote Automatic

One-shot AF
ONE-SHOT AF button

Automatic [One Shot]
Browser Remote

AF-Boosted MF

Focus ring � 
Camera (automatic)

Automatic [AF-Boosted MF]
Browser Remote � 
Camera (automatic)

Continuous AF
Automatic 
(camera or Browser Remote)

Automatic [Continuous]

Face AF3/Tracking4 Camera or Browser Remote Automatic –
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Manual Focus
Focus manually using the focus ring on the lens.

1 Select  > [v Camera Setup] > [AF Mode] > [One Shot].
• You can set the lens’s focus mode switch to manual (A 69).

2 Turn the focus ring to adjust the focus.

NOTESNOTES

• With some lenses, you may be able to operate the focus ring even when the focus mode is set to automatic.
• If you operate the zoom after focusing, the focus on the subject may be lost.
• If you focus manually and then leave the camera with the power turned on, the focus on the subject may be 

lost after a while. This possible slight shift in focus is a result of the internal temperature rising in the camera 
and lens. Check the focus before resuming shooting.

• When adjusting the focus, be careful not to touch the front of the lens or moving parts on the lens except for 
the focus ring.

• When an RC-V100 Remote Controller is connected to the camera, you can adjust the focus with the remote 
controller’s FOCUS dial. At default settings, turn the dial right to focus farther and left to focus nearer.

Using the RF lens's focus ring
- You can change the direction of the adjustment when operating the focus ring with the  > [B System 

Setup] > [Focus Ring Dir.] setting.
- You can link the amount of focus adjustment when using the focus ring to either the rotation angle or the 

rotation speed  with the  > [B System Setup] > [Focus Ring Response] setting. 
- When the lens is set to autofocus, you can enable/disable manual adjustments with the  > 

[B System Setup] > [Focus Ring Operation] setting.

Using the Focus Assistance Functions

In order to focus more accurately, you can use the following focus assistance functions: Dual Pixel Focus Guide, 
an onscreen guide that shows you if the selected subject is in focus; peaking, which creates a clearer contrast 
by emphasizing the outlines of the subject; and magnification, which enlarges the image on the screen. You can 
use peaking and the focus guide or peaking and magnification simultaneously for greater effect.

Focus guide
The focus guide gives you an intuitive visual indication of the current focus distance and the direction and 
amount of adjustment necessary to bring the selected subject into full focus. When used in combination with 
face detection (A 75), the guide will focus on the vicinity of the eyes of the person detected as the main 
subject.

1 Using direct touch control (A 49), you can touch the [Focus Guide] switch to turn on/off the focus guide.
• Alternatively, you can use the  > [A Assistance Functions] > [Focus Guide] setting or an assignable 

button set to [Focus Guide], to display/hide the focus guide. 
• You can use the  > [A Assistance Functions] > [Focus Guide 2nd Frame] setting to display a 

second focus frame.
• The second focus guide frame will be displayed only when [AF Mode] is set to [One shot], or when the lens’s 

focus mode is set to manual.

2 Touch the point where you want to focus on the LCD screen to move the focus guide.
• You can also use the joystick or SELECT dial to move the focus guide’s frame. Press the CANCEL button to 

return the focus guide’s frame to the center of the screen.
• When both focus guide frames are displayed, press SET to move the focus guide between the two focus 

frames.
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3 Adjust the focus manually as necessary.
• When the focus guide turns green, the subject is correctly focused.

NOTESNOTES

• With subjects or in situations where autofocus may not work well (A 74), the focus guide may not work 
correctly.

• The focus guide cannot be used in the following cases:
- While the focus is being adjusted automatically using one-shot AF, AF-Boosted MF or continuous AF. 
- When the aperture value used is F13 or larger.
- When a manual focus lens is attached to the camera, except for compatible EF Cinema lenses (A 203).

• When the focus guide and face detection/tracking functions are used together, the focus guide may not focus 
the main subject’s eyes correctly, depending on the direction in which the face is turned.

Peaking
The camera offers two peaking levels.

1 Press the PEAKING button.
• The peaking icon (J or K) appears on the left of the 

screen and outlines (contour lines) in the image that are in 
focus will be shown highlighted.

• Press the button again to turn off peaking.
• You can use direct touch control (A 49) to turn the 

[Peaking 1]/[Peaking 2] setting on/off.
• Alternatively, you can use one of the  > [A Assistance 

Functions] > [Peaking:] settings to turn the peaking function on/
off separately on the respective terminal/output destination.

2 Select  > [A Assistance Functions] > [Peaking] > [Peaking 1] or [Peaking 2].

Magnification

1 Press the MAGN. button.
• ^ appears on the left of the screen and the center of the 

screen* is magnified 5 times.
• The orange frame displayed on the top right of the screen 

(magnification frame) shows the approximate part of the image 
shown magnified.

• Press SET to switch back and forth between 5x and 10x 
magnification.

In focus 
(in green)

Focus farther 
(large adjustment)

Focus farther 
(small adjustment)

Focus closer 
(small adjustment)

Focus closer 
(large adjustment)

Cannot determine 
adjustment
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2 If necessary, use the joystick to move around the magnification frame and check other parts of the image.
• You can also drag your finger across the LCD screen to move the frame.
• Press the CANCEL button to return the magnification frame to the center position.
• Press the MAGN. button again to cancel the magnification.

* If one of the AF frames or a face detection frame is displayed on the screen, the area around the active frame will be magnified 
instead.

NOTESNOTES

• About Peaking/Magnification:
- You can use the  > [A Assistance Functions] > [Peaking 1] and [Peaking 2] settings to set the color, 

gain and frequency of the two peaking levels independently of each other.
- You can use the  > [A Assistance Functions] > [Magn. Output] setting to select where to show the 

magnified image.
- The assistance functions will not affect your recordings.
- Magnification will be turned off if you change the video configuration (A 52), turn  > [v Camera 

Setup] > [Digital IS] on/off, or if you turn slow & fast motion recording on/off while the magnified image is 
displayed.

• Peaking/magnification are not available while the color bars are displayed.

One-Shot AF
In this focus mode, you will focus manually in most situations but still have the option to have the camera focus 
automatically only once on the subject inside the AF frame. You can change the type and position of the AF 
frame.

1 Set the focus mode on the lens to automatic (A 69).

2 Select  > [v Camera Setup] > [AF Mode] > [One Shot].

3 If necessary, change the type and position of the AF frame 
(A 75).

4 Press and hold the ONE-SHOT AF button.
• A white AF frame will appear on the screen and the camera will 

focus automatically. When you are using Face AF, the face detection 
frame around the face of the person who has been determined to be the main subject will turn white.

• When correct focus has been achieved, the AF frame turns green. If the camera cannot focus automatically, 
the AF frame will turn red.

• The AF frame will disappear when you release the ONE-SHOT AF button.

NOTESNOTES

• One-shot AF will not work when Face AF is set to [Face Only] and a face has not been detected.
• When the aperture value used is F13 or higher, Dual Pixel CMOS AF will not work and the camera will focus 

using contrast-detection autofocus.
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AF-Boosted MF
In this focus mode, you can focus manually most of the way and let the camera finish focusing automatically. 
This is very convenient when you want to make certain that high-resolution clips (4K and higher) are in sharp 
focus.
Additionally, with this mode, if the camera cannot evaluate how to adjust the focus, it will not perform unreliable 
focus adjustments. This results in a more stable focusing operation overall than with continuous AF.

1 Set the focus mode on the lens to automatic (A 69).

2 Select  > [v Camera Setup] > [AF Mode] > [AF-Boosted MF].
• When the focus is in the manual adjustment range, a yellow AF frame will appear on the screen.

3 If necessary, change the type and position of the AF frame (A 75).

4 Turn the focus ring to adjust the focus.
• Focus manually to bring the subject closer into focus. When the focus enters the automatic adjustment 

range, the focus frame will turn white and the camera will then finish focusing automatically.
• While the focus stays within the automatic adjustment range, the camera will keep the subject in focus 

automatically.

Continuous AF

The camera will focus automatically on a subject inside the main area of the image (approximately 80% of the 
screen’s length and height).

1 Set the focus mode on the lens to automatic (A 69).

2 Select  > [v Camera Setup] > [AF Mode] > [Continuous].
• A white AF frame will appear on the screen.
• When you are using Face AF, a white detection frame will appear around the face of the person who has 

been determined to be the main subject.

3 If necessary, change the type and position of the AF frame (A 75).

NOTESNOTES

About the autofocus (AF) functions: 
• The point where the camera focuses may change slightly depending on shooting conditions, such as subject, 

brightness and zoom position. Check the focus before resuming shooting.
• Autofocus may take longer in the following cases.

- When the frame rate set in the video configuration is 29.97P, 25.00P, 24.00P or 23.98P.
- With some lenses, the camera may take longer to focus automatically or may not be able to focus correctly. 

Visit your local Canon website for the latest information.
• Depending on the lens, you can change various aspects of the autofocus function with the following settings. 

Visit your local Canon website for the latest information.
-  > [v Camera Setup] > [AF Speed] to set the AF speed (the speed at which the focus is adjusted) 

to one of 10 levels.
-  > [v Camera Setup] > [AF Response] to set the responsiveness of the autofocus function to one 

of 7 levels.
- While using continuous AF, you can hold the ONE-SHOT AF button pressed down to temporarily adjust the 

focus using the maximum AF speed and AF response. This is helpful when you want to focus quickly after 
focus was lost or to keep a subject in focus while you follow it.
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• Autofocus will not work in the following cases. 
- When slow & fast motion recording is activated, if using lenses not compatible with autofocus.
- When the shooting frame rate in slow & fast motion recording is not set to 24, 25, 30, 48, 50, 60,100 or 120 

(fps). 
• Continuous AF will not work in the following cases.

- When using an EF lens that does not have a focus mode switch.
- While adjusting the focus using a remote controller connected to the REMOTE terminal.

• Autofocus may not work well on the following subjects or in the following cases. In such case, focus manually.

- When using small apertures.
- When subjects at different distances appear in the picture.
- When an ISO speed or gain value in the extended range is selected (A 59).
- When the gamma curve component of the [Gamma/Color Space] setting in the custom picture file (A 113) 

is set to an option other than [BT.709 Normal].

AF Lock

While using continuous AF or AF-Boosted MF, you can lock the 
focus on a certain subject and then move the camera to change 
the composition. 

1 While the autofocus is active, press the AF LOCK button.
• The focus will be locked and @ and the AF frame will turn 

gray. When you are using Face AF, the face detection frame 
around the main subject will turn gray.

• The frame displayed on the screen will be the focus guide 
frame if [Focus Guide] is set to [On].

• When you use a button assigned to [AF Lock (While Pressed)], 
the focus will only be locked while the button is held pressed down.

2 Press the AF LOCK button again to cancel the AF lock.

NOTESNOTES

AF lock will be canceled automatically in the following cases:
- If the camera is turned off or the camera’s system frequency is changed.
- If the lens is removed or replaced.
- If  > [v Camera Setup] > [AF Mode] is changed to [One Shot].
- When slow & fast motion recording is activated.

- Reflective surfaces
- Subjects with low contrast or without vertical lines
- Fast moving subjects

- Through dirty or wet windows
- Night scenes
- Subjects with a repetitive pattern
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Changing the AF Frame Type and Position
You can change the type and position of the AF frame that appears on the screen (except for the face detection/
tracking frame) while using one of the autofocus functions.

1 Select  > [v Camera Setup] > [AF Frame Position] > Desired option.

2 Select  > [v Camera Setup] > [AF Frame] > Desired option.

Options for [AF Frame Position]
[Selectable]: You can move the AF frame by touching the desired point on the LCD screen. You can also use 

the joystick (8 directions) or SELECT dial. Press the CANCEL button to return the AF frame to 
the center of the screen.

[Center Frame]: A fixed AF frame appears at the center of the screen.

Options for [AF Frame]
[Large]: Standard AF frame size.
[Small]: Smaller AF frame size (about 1/3 the standard size).

Face Detection
When the face detection function is activated, the camera will detect people’s faces. When there are a number of 
people in the picture, one person will be determined to be the main subject. The camera will keep tracking the 
main subject even when it moves.
You can use face detection with one of the autofocus functions to let the camera focus on the main subject 
automatically (Face AF). You can use the focus guide to adjust the focus on the main subject manually. You can 
also change the main subject.

1 Select  > [v Camera Setup] > [Face Det. & Tracking] > [On].

2 Select  > [v Camera Setup] > [Face AF] > Desired option when a face is not detected.
•  (face priority) or  (face-only AF) will appear on the screen.

3 Point the camera at a person.
• All detected faces will have a face detection frame. The main subject will be indicated with a face detection 

frame with small arrows (white when autofocus is active, gray or yellow* during manual focus). 
• Push the joystick (left/right) or turn the SELECT dial to select a different person as the main subject.
• During continuous AF, the camera will keep focusing on the main subject’s face. 
• During one-shot AF, the camera will focus on the main subject’s face while you hold the ONE-SHOT AF 

button pressed down.
• If you use face detection together with the tracking function, the camera will be able to track the selected 

main subject more reliably. When you touch a subject on the LCD screen, tracking will be activated and the 
face detection frame will change to a double frame £ (tracking frame). This is better if you want to track a 
subject when it is difficult to keep seeing their face.

* [AF-Boosted MF] within manual adjustment range.

Options
[Face Priority]: The camera focuses according to the AF mode currently selected.
[Face Only]: The camera locks the focus.
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Face AF operation by AF mode

NOTESNOTES

• Typical examples of faces not correctly detected
- Faces extremely small, large, dark or bright in relation to the overall picture.
- Faces that are turned to the side, at a diagonal, partially hidden or upside-down.

• Face detection cannot be used in the following cases.
- When the shutter speed used is slower than 1/30 (59.94 Hz recordings), 1/25 (50.00 Hz recordings) or 1/24 

(24.00 Hz recordings or 59.94 Hz recordings with a 23.98P frame rate).
- When both focus guide frames are activated, and also the AF mode is set to [One Shot] or the lens's focus 

mode is set to manual.
- When slow & fast motion recording is activated.
- When a manual focus lens is attached to the camera.

• The camera may mistakenly detect the faces of non-human subjects. In such case, turn face detection & 
tracking off.

• If you set an assignable button to [Face Det. & Tracking] or [Face AF] (A 105), you can press the button to 
adjust those settings.

Tracking a Specific Subject

You can have the camera track other moving subjects that are not faces and also combine the tracking function 
with one of the autofocus functions to let the camera focus on the desired subject automatically.

1 Set an assignable button to [Tracking] (A 105).

2 Press the assignable button.
• The subject selection mark I will appear on the screen.
• Press the assignable button again or the CANCEL button to end the subject selection mode.

3 Touch the desired subject on the LCD screen.
• The I mark changes to a double frame £ (tracking frame) and the camera will start tracking the selected 

subject.
• You can also use the joystick (8 directions) or SELECT dial to place the center of the I mark on the desired 

subject and then press SET. 
• If the tracking failed, the I mark will turn red momentarily. Select the subject again.
• The subject selected for tracking becomes the target for autofocus functions.

4 Press SET or the button assigned to [Tracking].
• The camera stops tracking and returns to subject selection mode. 
• Press the CANCEL button to end the tracking function and return the camera to the focus mode that was 

used previously. 

 > [v Camera Setup] > 
[AF Mode] and focus operation

 > [v Camera Setup] > [Face AF]

[Face Priority] [Face Only]

Face detected No face detected Face detected No face detected

[One Shot] while the ONE-SHOT AF button is not pressed Manual focus

[One Shot] while the ONE-SHOT AF button is held pressed down
Focus on the 
detected face

Focus on the 
subject inside 
the AF frame

Focus on the 
detected face

Manual focus[Continuous] (autofocus), 
[AF-Boosted MF] within the automatic adjustment range

[AF-Boosted MF] within the manual adjustment range 
(yellow AF frame)

Manual focus
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NOTESNOTES

• The camera may start tracking the incorrect subject if there is another subject in the picture with similar color/
pattern characteristics. In that case, select the desired subject again.

• Tracking cannot be used in the same cases in which face detection cannot be used.
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Image Stabilization
You can use the image stabilizer to compensate for camera shake and achieve steadier shots. The image 
stabilizer is more effective at wider angles and the effect is reduced the more you approach the telephoto end.

1 Select  > [v Camera Setup] > [Digital IS] > [On].
• Press the button assigned to [Digital IS] to turn this function on and off.
• The  icon appears on the screen.

2 If the camera cannot obtain the focal length from the lens, select  > [v Camera Setup] > 
[Lens Focal Length] and enter the lens’s focal length using the data entry screen (A 25).
• The image stabilization is adjusted according to the focal length entered.

3 When using an anamorphic lens, select  > [v Camera Setup] > [Anamorphic Corr.] > 
Squeeze factor to use to correct the image stabilization.
• If you selected [Lens Squeeze Factor], the anamorphic correction will be applied according to the squeeze 

factor specified with the  > [Æ Recording/Media Setup] > [Metadata] > [Lens Squeeze] setting.

NOTESNOTES

• If the IS function is turned off on the lens, the camera’s image stabilization function is deactivated too and the 
 icon will flash.

• If you set an assignable button to [Pause Digital IS] (A 105), you can press and hold the button to temporarily 
stop the camera's image stabilization (  will appear grayed out). This will not affect the lens’s image 
stabilization.

• Depending on the subject and shooting conditions, subject blur may be more prominent (the subject may be 
momentarily blurred) due to the use of image stabilization.

• Turning off the camera’s image stabilization is recommended in the following cases:
- When using TS-E lenses and fisheye lenses
- When the camera is expected to be stable, for example when it is mounted on a tripod

• If the degree of camera shake is too high, the image stabilizer may not be able to compensate fully.
• The camera’s image stabilization will not function when using super telephoto lenses with a focal length 

exceeding 1000 mm.

Powerful Image Stabilization
Using the peripheral area of the screen outside a 2K image size for digital IS correction, it is possible to achieve a 
higher level of image stabilization while shooting. This feature is available for clips with a resolution of 2048x1080 
or lower, and when the sensor mode is set to [Super 16mm (Crop)].

Select  > [v Camera Setup] > [Super16 Digital IS] > [On].
•  is displayed on the screen.

NOTESNOTES

• Depending on the lens, the stabilization results may not be optimal or limiting the lens's image stabilization 
may be necessary to produce better results.

• Subject blur may be more prominent depending on the shutter speed (the subject may be momentarily 
blurred). In such cases, setting a faster shutter speed (approximately 1/180 seconds or faster) is 
recommended.
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Zoom
You can use the camera to zoom when an EF Cinema lens compatible with zoom operation (A 203) or an EF 
lens integrated with a PZ-E1 Power Zoom Adapter is attached to the camera.
You can also zoom remotely using Browser Remote on a connected network device (A 158).

Zoom Modes of the Lens
Use the switch on the lens to select the lens’s zoom mode (automatic, manual). The name of the controls may 
differ depending on the lens. Refer to the instruction manual of the lens/accessory used.

Set the lens’s zoom mode to automatic.
• Operating the zoom from the camera is enabled.

Adjusting the Zoom
1 Enable automatic zoom mode on the lens.

2 Select  > [v Camera Setup] > [Camera Grip Zoom] > [On].

3 Select  > [v Camera Setup] > [Camera Grip Zoom Speed] > Desired zoom speed.
• Zoom speeds are constant; [1] being the slowest and [16] the fastest.

4 Use the joystick on the camera grip to zoom.
• Push the joystick up to zoom in (telephoto) and push it down to zoom out (wide-angle).

NOTESNOTES

• When an RC-V100 Remote Controller is connected to the camera and the lens is correctly set, you can zoom 
with the remote controller’s ZOOM dial.

• When using slow zoom speeds, it may take longer for the lens to start moving.
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Onscreen Markers, Zebra Patterns and False Color
Using onscreen markers allows you to make sure your subject is correctly framed and is within the appropriate 
safe area. Zebra patterns help you identify areas that are overexposed. The false color overlay allows you to 
check if the exposure is correct. You can display the assistance overlays independently on the screen and HDMI 
OUT terminal. The assistance overlays will not affect your recordings.

Displaying Onscreen Markers
The camera offers several onscreen markers. You can display multiple onscreen markers simultaneously and 
select their color individually.

[Center Marker]: Displays a small marker that indicates the center of the screen. You can select the shape of the 
center marker.

[Horizontal Marker], [Vertical Marker]: Displays a horizontal or vertical line to help you compose level shots.

[Grid Marker]: Displays a grid that allows you to frame your shots correctly (horizontally and vertically).

[Aspect Marker]: Indicates various aspect ratios by displaying border lines or by masking the image outside the 
selected aspect ratio. The aspect ratio can be set freely by the user.

[Safe Area Marker]: Displays a margin from the edges of the image (using border lines or by masking the image) 
to indicate the action safe area, text safe area, etc. You can select the core area used as the basis for calculating 
the safe area and a percentage, relative to the side length or area.

[User Marker 1], [User Marker 2]: Displays up to two rectangular frames whose size and position you can set 
freely and independently of each other.

1 Select  > [A Assistance Functions] > Desired [Markers:] setting > [On].
• Onscreen markers will be displayed on the corresponding video output.
• You can also use direct touch control (A 49) to turn the [Markers: LCD] setting on/off.
• If the respective setting is set to [Off], onscreen markers will not be displayed on the corresponding video 

outputs even if individual markers are configured.

2 Select the marker(s) you wish to display and configure them with the following procedures.
• You can display multiple markers simultaneously.

Aspect guide 4:3Center marker 
([Cross 1] type)

Grid marker

Horizontal 
marker

Safe area 88% 
by side length

User marker 
(100, 250)

Vertical marker
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Center Marker / Horizontal Marker / Vertical Marker / Grid Marker

1 Select  > [A Assistance Functions] > [Center Marker], [Horizontal Marker], [Vertical Marker] or [Grid 
Marker] > Desired marker color.
• Select [Off] to turn off the marker.

2 For [Center Marker] only: Select  > [A Assistance Functions] > [Center Marker Type] > Desired marker 
shape.

Aspect Marker

1 Select  > [A Assistance Functions] > [Aspect Marker] > Desired marker color or transparency of the 
masked area.
• Select [Off] to turn off the marker.

2 Select  > [A Assistance Functions] > [Marker Aspect Ratio] > Desired option.

3 For [Custom] only: Select  > [A Assistance Functions] > [Marker Custom Asp. Ratio] and enter the 
aspect ratio using the data entry screen (A 25).

NOTESNOTES

Aspect markers will not be displayed in the following cases. 
- When the resolution is set to 3840x2160 or 1920x1080 and the marker aspect ratio is set to [16:9].
- When the resolution is set to 4096x2160 or 2048x1080 and the marker aspect ratio is set to [1.90:1].
- The same applies when the same aspect ratio is set manually using [Custom].

Safe Area Marker

The safe area is displayed using a border line or by masking the image outside the safe area. It can be calculated 
as a percentage of the total frame area or as a percentage of the width/height.

1 Select  > [A Assistance Functions] > [Safe Area Marker] > Desired marker color/mask opacity level.
• Select [Off] to turn off the marker.

2 Only when an aspect marker is already activated: Select  > [A Assistance Functions] > [Basis for 
Marker Safe Area] > [Whole Picture] or [Selected Aspect Marker].

3 Select  > [A Assistance Functions] > [Marker Safe Area %] > Desired percentage.
• You can select the margin as a percentage of the total frame area [(Area)] or as a percentage of the width/

height [(Side Length)].

User Markers

You can set 2 individual user markers ([User Marker 1] and [User Marker 2]) and adjust their color, size and 
position separately.

1 Select  > [A Assistance Functions] > [User Marker 1] or [User Marker 2] > Desired marker color.
• Select [Off] to turn off the marker.

2 Select  > [A Assistance Functions] > [User Marker 1 Size] or [User Marker 2 Size] and enter the width 
[W] and height [H] using the data entry screen (A 25).

3 Select  > [A Assistance Functions] > [User Marker 1 Position] or [User Marker 2 Position] and enter 
the [X] and [Y] coordinates using the data entry screen (A 25).

NOTESNOTES

• You can choose the onscreen display level to turn off all other onscreen displays, leaving only the markers 
(A 46).

• If you set an assignable button to one of the [Markers:] settings (A 105), you can press the button to turn the 
markers on and off on the corresponding video output.
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Displaying Zebra Patterns
The camera has a zebra pattern function that shows black and white diagonal stripes over 
areas that are overexposed. There are two types of zebra patterns and you can display both 
simultaneously. Zebra 1 lets you identify areas within a certain range (±5% of a specified level 
from 5% to 95%) while zebra 2 lets you identify areas that exceed a specified level (from 0% 
to 100%).

1 Press the ZEBRA button to activate the selected zebra 
pattern on all monitoring devices at once.
• You can also use direct touch control (A 49) to turn the [Zebra: 

LCD] setting on/off.
• Alternatively, you can press an assignable button set to one of 

the [Zebra:] settings (A 105), to turn the zebra pattern overlay 
on and off on the corresponding video output.

2 Select  > [A Assistance Functions] > [Zebra] > 
Desired option.

3 Select  > [A  Assistance Functions] > [Zebra 1 Level] or [Zebra 2 Level] > Desired option.

Displaying False Color
In CAMERA mode, you can display the false color overlay to check the brightness levels as different colors.

Select  > [A Assistance Functions] > Desired [False Color:] setting > [On].
• You can also use direct touch control (A 49) to turn the [False Color: LCD] setting on/off.
• Alternatively, you can press an assignable button (A 105) set to one of the [False Color:] settings to turn the 

false color overlay on and off on the corresponding output destination.

NOTESNOTES

• You can use the  > [A Assistance Functions] > [False Color Index] setting to check an index of the 
colors used in the false color overlay.

• When the Look File registered to the custom picture file is active, the color displayed might not be that of the 
correct brightness level.

Color Meaning

Red White clipping

Yellow Just below white clipping

Pink One stop over 18% gray

Green 18% gray (medium gray)

Blue Just above black clipping

Purple Black clipping

Zebra 1 Zebra 2
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Setting the Time Code
The camera generates a time code signal and records it with the recorded clips. The time code signal can be 
output from the TIME CODE terminal or HDMI OUT terminal.
Depending on the frame rate used, you may be able to select between a drop frame an non-drop frame time 
code signal (A 84). The default mode varies depending on the country/region of purchase and, though the time 
code display style is different for DF and NDF, in this section the NDF display style is used for simplicity’s sake.

Selecting the Time Code Mode
You can select the camera’s time code mode.

Select  > [B System Setup] > [Time Code Mode] > Desired option.

Options

[Preset]: The time code starts from an initial value you can select in advance. The default initial time code 
is 00:00:00:00.
See the following procedures to select the time code running mode and set the initial time code.

[Regen.]: The camera will read the selected card and the time code will continue from the last time code 
recorded on the card. The time code runs only while recording so clips recorded consecutively 
on the same card will have continuous time codes.

Setting the Time Code Running Mode

If you set the time code mode to [Preset], you can select the time code running mode.

Select  > [B System Setup] > [Time Code Run] > Desired option.

Options

[Rec Run]: The time code runs only while recording so clips recorded consecutively on the same card will 
have continuous time codes.

[Free Run]: The time code starts running the moment you confirm the selection and keeps running 
regardless of the camera’s operation.

Setting the Time Code’s Initial Value

If you set the time code mode to [Preset], you can set the initial value of the time code.

1 Select  > [B System Setup] > [Set Time Code] > [Change].
• The time code setting screen appears with an orange selection frame indicating the hours.
• To reset the time code to [00:00:00:00], select [Reset] instead. If the running mode is set to [Free Run], the 

time code will be reset the moment you confirm the selection and keep running continuously from 
00:00:00:00.

2 Enter the initial time code using the data entry screen (A 25).
• If the running mode is set to [Free Run], the time code will start running from the selected time code the 

moment you confirm the selection.
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Selecting Drop or Non-Drop Frame
When the frame rate is set to 59.94P, 59.94i or 29.97P, you can select between a drop frame (DF) or non-drop 
frame (NDF) time code, depending on how you plan to use your recordings.
With all other frame rates, the time code is set to non-drop frame (NDF) and cannot be changed.

Select  > [B System Setup] > [Time Code DF/NDF] > Desired option.
• The time code display will change depending on the setting. When you select [DF], the time code will appear 

as [00:00:00.00]; when you select [NDF], it will appear as [00:00:00:00].

About the time code display
A letter may appear next to the time code depending on the setting/status. Refer to the following table.

NOTESNOTES

• The frames value of the time code runs from 0 to 23 (frame rate set to 23.98P or 24.00P), from 0 to 24 (frame 
rate set to 25.00P, 50.00i or 50.00P), or from 0 to 29 (all other frame rates). 

• When slow & fast motion recording is activated, you cannot select the [Free Run] running mode. Conversely, 
when pre-recording is activated, [Free Run] is set automatically and cannot be changed.

• When slow & fast motion recording is activated, the time code signal will not be output from any of the 
terminals.

• When you mix drop frame and non-drop frame time codes, there might be a discontinuity in the time code at 
the point where the recording starts.

• When you are using the [Free Run] running mode, the time code will continue running as long as the built-in 
backup battery has some charge left, even if you disconnect all other power sources.

• If you set an assignable button to [Time Code] (A 105), you can press the button to open the 
[B System Setup] menu page with the time code settings.

Setting the User Bit
You can set a user bit composed of the date or the time of recording or an identification code consisting of 
8 characters in the hexadecimal system. There are sixteen possible characters: the numbers 0 to 9 and the 
letters A to F.
The user bit is recorded with clips and can be output from the HDMI OUT terminal. It can be used freely to 
categorize and manage recordings or to keep additional information about them.

1 Select  > [B System Setup] > [User Bit Type] > [Setting], [Date] or [Time].
• If you select [Time] or [Date] the rest of the procedure is not necessary.

2 Select [Change].
• To reset the user bit to [00 00 00 00], select [Reset] instead.

3 Enter the user bit using the data entry screen (A 25).

Letter Description

R The time code mode is set to [Regen.].

P The time code mode is set to [Preset] and the running mode is set to [Rec Run].

F The time code mode is set to [Preset] and the running mode is set to [Free Run].

E The time code signal is coming from an external source.

No letter Time code during clip playback.
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Synchronizing with an External Device
You can use the camera’s TIME CODE terminal to synchronize this camera’s time code to an external signal. 
Using the same external time code signal with multiple cameras allows you to set up a multi-camera recording. 
You can also output the time code signal from this camera to other cameras.

Connecting an External Device
When synchronizing a time code signal, connect the external device to the TIME CODE terminal on the camera.  
Be sure to set the TIME CODE terminal to input or output in advance.

Connection diagram

Time Code Signal Input
An external SMPTE-standard LTC timing signal received from the TIME CODE terminal can be recorded as the 
time code. The user bit of the external timing signal can also be recorded with clips. Before connecting the 
device, set the TIME CODE terminal to input with the procedure below and make sure the time code running 
mode is set to [Free Run] (A 83).

1 Select  > [B System Setup] > [TC In/Out] > [In].

2 To record the external signal’s user bit, select also  > [B System Setup] > [User Bit Recording 
Mode] > [External].

NOTESNOTES

• Synchronize the camera’s time code with an external time code signal that matches the camera’s system 
frequency. Use a 24-frame time code signal when the frame rate is set to 23.98P or 24.00P, a 25-frame time 
code signal when it is set to 25.00P, 50.00i or 50.00P and a 30-frame time code signal for other frame rates.

• When a suitable external time code signal is received, the camera’s own time code will be synchronized to it 
and the synchronization will be maintained even if you disconnect the cable from the TIME CODE terminal.

• If the external time code signal is incorrect or there is no input signal, the internal time code set in the camera 
will be recorded instead.

• When an external time code signal is received, the DF/NDF selection will follow the external time code signal’s 
settings.

• If an external time code signal is input while pre-recording is activated, there might be a discontinuity in the 
time code of the pre-recorded clip.

Standard TC signal

TIME CODE terminal

BNC cable (commercially available)
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• Performing any of the following actions while the cable is not connected will cause the synchronization to be 
disrupted; the correct time code will be restored once you reconnect the cable.
- Turning the camera on/off
- Switching to MEDIA mode
- Changing the video configuration

Time Code Signal Output
The time code signal output from the TIME CODE terminal will be a SMPTE-standard LTC timing signal. The user 
bit will also be output.

Select  > [B System Setup] > [TC In/Out] > [Out].

NOTESNOTES

• About the user bit output: The user bit set by the user (A 84) will be output. In MEDIA mode, the user bit is not 
output from the TIME CODE terminal.

• The time code and user bit will not be output when slow & fast motion recording is activated.
• With the  > [Æ Recording/Media Setup] > [HDMI Time Code] set to [On] you can output the time 

code signal from the HDMI OUT terminal (A 128).
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Recording Audio
The camera features the following options for audio recording and playback. You can record audio using an 
external microphone/line-in device (INPUT terminal), an external microphone (MIC terminal), or the built-in 
microphone. 
The audio signal will be output with the video signal from the HDMI OUT terminal. You can record the audio 
signal on an external recorder.

Available audio recording formats

Audio Settings and Recorded Audio Channels

* Menu items under the [¡ Audio Setup] menu.

NOTESNOTES

• You can press the AUDIO STATUS button to display only the [¡ Audio 
Setup] status screens. On these status screens (A 177) you can check the 
input source selected for each audio channel and other audio-related 
settings.

Primary clip Audio format

Video format Codec Sampling frequency Bit depth 
Number of audio 

channels
Bit rate

XF-AVC Linear PCM

48 kHz

24 bit 4 channels 4.5 Mbps

MP4
Linear PCM 16 bit 4 channels 3 Mbps

AAC 16 bit 2 channels 256 Kbps

Menu settings Recorded audio channels/audio sources

[Audio Input Selection]*
[CH2 Input]* CH1 CH2 CH3 CH4

[CH1/CH2] [CH3/CH4]

[INPUT Terminals] [INPUT Terminals] [INPUT 2] INPUT 1 terminal INPUT 2 terminal INPUT 1 terminal INPUT 2 terminal

[INPUT Terminals] [INPUT Terminals] [INPUT 1] INPUT 1 terminal INPUT 1 terminal INPUT 1 terminal INPUT 2 terminal

[INPUT Terminals] [MIC Terminal] [INPUT 2] INPUT 1 terminal INPUT 2 terminal MIC terminal (L) MIC terminal (R)

[INPUT Terminals] [MIC Terminal] [INPUT 1] INPUT 1 terminal INPUT 1 terminal MIC terminal (L) MIC terminal (R)

[INPUT Terminals] [Built-in Mic] [INPUT 2] INPUT 1 terminal INPUT 2 terminal Built-in microphone 
(L)

Built-in microphone 
(R)

[INPUT Terminals] [Built-in Mic] [INPUT 1] INPUT 1 terminal INPUT 1 terminal Built-in microphone 
(L)

Built-in microphone 
(R)

[MIC Terminal] [INPUT Terminals] – MIC terminal (L) MIC terminal (R) INPUT 1 terminal INPUT 2 terminal

[MIC Terminal] [MIC Terminal] – MIC terminal (L) MIC terminal (R) MIC terminal (L) MIC terminal (R)

[MIC Terminal] [Built-in Mic] – MIC terminal (L) MIC terminal (R) Built-in microphone 
(L)

Built-in microphone 
(R)

[Built-in Mic] [INPUT Terminals] – Built-in microphone 
(L)

Built-in microphone 
(R) INPUT 1 terminal INPUT 2 terminal

[Built-in Mic] [MIC Terminal] – Built-in microphone 
(L)

Built-in microphone 
(R) MIC terminal (L) MIC terminal (R)

[Built-in Mic] [Built-in Mic] – Built-in microphone 
(L)

Built-in microphone 
(R)

Built-in microphone 
(L)

Built-in microphone 
(R)
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Audio Format for MP4 Clips
Select the audio recording format for MP4 clips (primary clips or sub recording clips).

Select  > [ÆRecording/Media Setup] > [Main Audio Format (MP4)] or [Sub Audio Format 
(MP4)] > Desired option.

Connecting an External Microphone or External Audio Input Source to the Camera
To each of the INPUT terminals you can attach commercially available microphones or analog line in sources with 
a Mini XLR connector. To the MIC terminal you can attach commercially available condenser microphones with a 
∅ 3.5 mm stereo mini plug.
Using the supplied microphone holder, you can fix external microphones with a diameter of 19 mm to 20 mm.

1 To use a microphone, loosen the microphone lock 
screw (�), open the microphone holder and insert 
the microphone (�).

2 Tighten the lock screw (�) and put the microphone 
cable through the cable clamp.

3 When using any INPUT terminal, set the 
corresponding INPUT 1/INPUT 2 (audio source 
selection) switch to a position other than MIC+48V 
(�).

4 Plug the microphone/external line-in device cable 
into the desired INPUT terminal or the MIC terminal 
(�).

�

�

Microphone 
lock screw

�

� �

�

MIC terminal

Cable clamp

INPUT 2 terminal

INPUT 1 terminal

INPUT 1 / INPUT 2 switches
(audio source selection)
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IMPORTANT

• Do not connect or disconnect microphones and other audio devices from any INPUT terminal when the 
corresponding INPUT (audio source selection) switch is set to the MIC+48V position. This may damage the 
camera and/or device.

Selecting the Input Type for the INPUT 1/INPUT 2 Terminals

Change the position of the corresponding INPUT (audio source selection) switch according to the audio device 
connected to the INPUT 1/INPUT 2 terminals.

Set the INPUT 1 or INPUT 2 switch to LINE, MIC, or MIC+48V.
• When using the INPUT terminals to record to only one channel, use the INPUT 1 terminal.

IMPORTANT

• When using a microphone that requires phantom power, turn off the camera and set the respective INPUT 
switch to MIC. After connecting a +48V compatible microphone, switch the INPUT switch to MIC+48V.

• To connect a microphone or other audio device that is not compatible with phantom power to an INPUT 
terminal, make sure the respective INPUT (audio source selection) switch is set to LINE or MIC. Setting the 
switch to MIC+48V may damage the audio device.

Selecting the Input Type for the MIC Terminal

Change the setting according to the audio device connected to the MIC terminal.

1 Select  > [¡ Audio Setup] > [MIC Input]

2 Select [MIC (with Power Supply)], [MIC], or [LINE]
• Select [MIC (with Power Supply)] to supply plug-in power to the external microphone.

IMPORTANT

• Connecting an external microphone that does not require power supply when [MIC Input] is set to [MIC (with 
Power Supply)], may damage the microphone.

Selecting the Built-in Microphone Mode
Select  > [¡ Audio Setup] > [Built-in Mic Mode] > Desired option.

Options
[Voice Memo]: For adding comments that can be synchronized to the audio and video during editing, in 

monaural audio. 
[Normal]: Standard setting, in stereo. A wider audio band can be recorded (compared to [Voice Memo] 

mode).

NOTESNOTES

• Since [Normal] mode captures a wider audio band, the camera may pick up the fan and lens’s operating 
sound.
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Selecting the Audio Input Source for Audio Channels
You can select the audio input source that will be recorded on CH1/CH2 or CH3/CH4, independently for each 
pair of audio channels. For details refer to the Audio Settings and Recorded Audio Channels table (A 87).

1 Select  > [¡ Audio Setup] > [Audio Input Selection] > [CH1/CH2].

2 Select [INPUT Terminals], [MIC Terminal] or [Built-in Mic].

3 Select the audio input for [CH3/CH4], in the same way.

4 Press CANCEL to return to the previous screen.

Recording the Same Analog Audio Input to Two Channels

By default, each audio input is recorded to a separate audio channel (INPUT 1 to CH1 and INPUT 2 to CH2).
If necessary audio from the INPUT 1 terminal can be recorded on both CH1 and CH2 (CH2 as backup). In that 
case, you can adjust the audio recording levels of each channel independently of each other.

Select  > [¡ Audio Setup] > [CH2 Input] > Desired option.

Options
[INPUT 2]: Records audio to each channel separately. Audio input into INPUT 1 is recorded to CH1, while 

audio input into INPUT 2 is recorded to CH2.
[INPUT 1]: Audio input into INPUT 1 is recorded to both channels. Audio input into INPUT 2 will not be 

recorded.

Adjusting the Audio Recording Level
You can adjust the audio recording level of the INPUT terminals, MIC terminal or the built-in microphone. You can 
select automatic or manual audio level adjustment, and adjust each audio channel separately or adjust CH1/
CH2 or CH3/CH4 together (when the audio level adjustment of the audio channels is linked, A 91).
For the built-in microphone the audio recording level will be adjusted automatically when set to [Voice Memo]. 
When set to [Normal], the adjustments of CH1 apply to both CH1/CH2.

Automatic Audio Level Adjustment for CH1, CH2 or CH1/CH2

Set the audio level switch of the desired channel to A (automatic) to let 
the camera automatically adjust that channel’s audio level.

CH1/CH2 audio level switches
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Manual Audio Level Adjustment for CH1, CH2 or CH1/CH2

You can set the audio level manually from –  to +18 dB.

1 Set the audio level switch of the desired channel to M (manual).

2 Turn the corresponding audio level dial to adjust the audio level.
• For reference, the 0 corresponds to – , 5 corresponds to 

0 dB, and 10 corresponds to +18 dB.
• As a guideline, adjust the audio recording level so that the audio 

level meter on the screen will go to the right of the –18 dB mark 
(one mark right of the –20 dB mark) only occasionally.

Audio Level Adjustment for CH3, CH4 or CH3/CH4

1 Select  > [¡ Audio Setup] > [Audio Rec Level CH3], [Audio Rec Level CH4] or [Audio Rec Level CH3/
CH4] > [Automatic] or [Manual].
• If you selected [Automatic], the rest of the procedure is not necessary. If you selected [Manual], continue the 

procedure to set the audio recording level.

2 Select  > [¡ Audio Setup] > [CH3 Level], [CH4 Level] or [CH3/CH4 Level] > Adjust the audio level as 
needed.
• For reference, 0 corresponds to – , 50 corresponds to 0 dB, and 100 corresponds to +18 dB. 
• As a guideline, adjust the audio recording level so that the audio level meter on the screen will go to the right 

of the –18 dB mark (one mark right of the –20 dB mark) only occasionally.

NOTESNOTES

• We recommend using headphones when adjusting the audio level. If the input level is too high, audio may 
become distorted even if the audio level indicator shows an appropriate level.

• If you set an assignable button to [Audio Level Indicator] (A 105), you can press the button to turn the 
onscreen audio level indicator on and off.

Automatic Level Control (ALC): Linking the audio level adjustment of CH1/CH2 or CH3/CH4
• When both CH1 and CH2, or CH3 and CH4, are set to the MIC terminal or INPUT terminals and to the 

same type of analog audio source (external line input or external microphone), you can use the  > 
[¡ Audio Setup] > [CH1/CH2 ALC Link] or [CH3/CH4 ALC Link] setting to link the audio level adjustment 
of both channels.

• When linked, different channels can be adjusted together. Adjust the CH1 audio levels to affect both CH1 
and CH2 or adjust the CH3 audio levels to affect both CH3 and CH4.

Audio peak limiter
• You can set  > [¡ Audio Setup] > [INPUT Limiter] to [On] to activate the audio limiter to limit the 

amplitude of audio input signals when they start to distort.

CH1/CH2 audio level dials

CH1/CH2 audio level switches
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Advanced Audio Input Settings
You can adjust the audio input settings for the INPUT terminals, MIC terminal, and the built-in microphone. The 
corresponding menu settings become available only when the respective audio input is active and the following 
conditions are met:
INPUT terminals: INPUT 1 or INPUT 2 switch is set to MIC or MIC+48V
MIC terminal: [MIC Input] is set to [MIC] or [MIC (with Power Supply)]
Built-in microphone: [Built-in Mic Mode] is set to [Normal].

Microphone Sensitivity (INPUT Terminals)

You can select the external microphone’s sensitivity.

Select  > [¡ Audio Setup] > [INPUT 1 Mic Trimming] or [INPUT 2 Mic Trimming] > Desired 
sensitivity level.
• You can select one of 5 sensitivity levels from –12 dB to +12 dB.

Microphone Attenuator (INPUT Terminals)

You can activate the external microphone’s attenuator (20 dB).

Select  > [¡ Audio Setup] > [INPUT 1 Mic Att.] or [INPUT 2 Mic Att.] > [On].

Built-in Microphone Sensitivity

You can adjust the sensitivity according as necessary.

Select  > [¡ Audio Setup] > [Built-in Mic Sensitivity] > Desired option.

Options
[Normal]: For recording audio under usual conditions.
[High]: For recording audio at a higher volume (+6 dB).

Microphone Attenuator (MIC Terminal/Built-in Microphone)

You can activate the microphone attenuator for an external microphone or the built-in microphone (20 dB).

Select  > [¡ Audio Setup] > [MIC Att.] or [Built-in Mic Att.] > [On].

Microphone Characteristics (MIC Terminal/Built-In Microphone)

You can choose the microphone characteristics as necessary.

Select  > [¡ Audio Setup] > [MIC Low Cut] or [Built-in Mic Low Cut] > Desired option.

Options
[Off]: For recording audio under usual conditions.
[LC1]1: For recording mainly people’s voices.
[LC2]1, [On]2: For reducing the background sound of wind when recording outdoors in windy surroundings (for 

example, on a beach or close to buildings). Note that when you use this setting some 
low-frequency sounds may be suppressed along with the sound of wind.

1 Only when using the built-in microphone.
2 Only when using an external microphone.
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Monitoring the Audio with Headphones
Connect headphones with a ∅ 3.5 mm stereo mini-plug to the 
× (headphone) terminal to monitor the recorded audio.

NOTESNOTES

• You can adjust the headphone volume with the  > [¡ Audio 
Setup] > [Headphone Volume] setting. If you set an assignable button to 
[Headphones +] or [Headphones –] (A 105), you can press the button 
to adjust the headphone volume without using the menu.

× (headphone) 
terminal
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Colors Bars/Audio Reference Signal
You can have the camera generate color bars and a 1 kHz audio reference signal and output them from the 
following terminals.

Color Bars
The camera offers SMPTE, EBU and ARIB color bars.

1 Select  > [v Camera Setup] > [Color Bars] > [On].
• The selected color bars appear on the screen.

2 Select  > [v Camera Setup] > [Color Bar Type] > Desired option.
• The selected color bars will be recorded when you press the REC button.
• Turning off the camera or changing the operating mode to MEDIA mode will deactivate the color bars.

NOTESNOTES

• If you set an assignable button to [Color Bars] (A 105), you can press the button to turn the color bars on/off.
Color bars cannot be displayed in the following cases: 

- When slow & fast motion recording is activated.
- When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to an 

option other than [BT.709 Wide DR] or [BT.709 Normal].

Audio Reference Signal
The camera can output a 1 kHz audio reference signal with the color bars.

Select  > [¡ Audio Setup] > [1 kHz Tone] > Desired option.
• You can select one of three audio levels (–12 dB, –18 dB, –20 dB), or [Off] to turn off the signal.
• The reference signal will be output at the selected level when you display the color bars, and will be recorded 

when you press the REC button.

LCD monitor HDMI OUT terminal × (headphone) terminal

Color bars Ü Ü –

Audio reference signal – Ü Ü
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Video Scopes
The camera can display a simplified waveform monitor or a vectorscope to check your recordings. The selected 
video scope is displayed on the screen and can be output to other monitoring devices as well.

Displaying a Video Scope

1 Select  > [A Assistance Functions] > 
[WFM Function] > [Waveform Monitor] or [Vectorscope].

2 Press the WFM button.
• You can also use direct touch control (A 49) to turn the 

[Waveform Monitor]/[Vectorscope] setting on/off.
• Alternatively, you can use one of the  > [A Assistance 

Functions] > [WFM:] settings to turn the video scope on/off 
separately on the desired video output.

• By default, the video scope will appear on the right of the screen. Using the  > [A Assistance 
Functions] > [Waveform Settings] or [Vectorscope Settings] > [Position] settings, you can select where to 
display it (left or right side).

NOTESNOTES

• The waveform monitor will not be affected even if a LUT is applied to the image, the range is changed or 
anamorphic desqueeze is used on the selected video output or screen.

• The video scopes will also be displayed while adjusting a custom picture file's image settings (A 110).

Changing the Waveform Monitor Settings
1 Select  > [A Assistance Functions] > [Waveform Settings] > [Type] > Desired option.

• If you selected an option other than [Select Line], skip to step 4.

2 Select  > [A Assistance Functions] > [Waveform Settings] > [Select Line].

3 Enter the Y coordinate of the red horizontal line to display using the data entry screen (A 25).
• The available range of lines that can be selected depends on the vertical component of the resolution used.

For 2160: 0 to 2158 (in 2-line increments)
For 1080: 0 to 1079 (in 1-line increments)
For 720: 0 to 719 (in 1-line increments)

4 Select  > [A Assistance Functions] > [Waveform Settings] > [Vertical Scale for HDR] > 
Desired option.
• Select the Y axis (luminance) scale used when displaying the waveform monitor of an HDR image.

5 Select  > [A Assistance Functions] > [Waveform Settings] > [Gain] > [1x] or [2x].
• If you selected [1x], the rest of the procedure is not necessary. 

6 Select  > [A Assistance Functions] > [Waveform Settings] > [Y Position] > Desired option.
• The display range of the waveform monitor’s Y axis will be reduced by half. Select the minimum luminance 

value (in %) shown on the Y axis.
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Options for [Type]
[Line]: Sets the waveform monitor to line display mode.
[Line+Spot]: The waveform of the area in the red frame is displayed in red on top of the [Line] mode 

waveform.
[Select Line]: The selected horizontal line (in red) will be displayed along with its waveform.
[RGB]: Shows 3 side-by-side waveforms in an RGB parade.
[YPbPr]: Shows 3 side-by-side waveforms in a YPbPr parade.

Options for [Vertical Scale for HDR]
[IRE]: Displays the video scope in IRE units.
[PQ/HLG]: For HDR-PQ images, displays the video scope in nits (cd/m2) and the narrow range’s (video 

range) waveform monitor.
For HDR-HLG images, the Y axis shows a relative-index value between 0.0 and 1.0. 

NOTESNOTES

• If the waveform monitor is activated and the  > [/ Custom Picture] > [Edit / File] > [Knee] > [Point] 
setting is changed, when you display the waveform monitor, a horizontal line will appear indicating the 
luminance (Y) level* corresponding to the knee point.

 * When a Look File registered to the custom picture file is active, the displayed luminance may not be at the correct level.

• When the waveform monitor’s Y axis is set to display in IRE units, a level of 10 bit 64 maps to 0 IRE and 10 bit 
940 maps to 100 IRE, regardless of the custom picture settings.

Changing the Vectorscope Settings
1 Select  > [A Assistance Functions] > [Vectorscope Settings] > [Type] > Desired option.

2 Select  > [A Assistance Functions] > [Vectorscope Settings] > [Gain] > [1x] or [2x].

Options for [Type]
[Normal]: Displays the usual vectorscope.
[Spot]: The color signal of the area in the red frame is displayed in red on top of the [Normal] mode 

waveform.
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Adding Marks to Clips in CAMERA Mode
When the main recording format is set to XF-AVC, while recording, you can add shot marks (!) to flag an 
important shot or frame. After recording a clip, you can add an OK mark ($) or check mark (%) to help you 
identify particular clips. 
You can add and delete marks also in MEDIA mode (A 125, 125). 
Marks cannot be added to proxy clips.

Adding a Shot Mark while Recording
To add a shot mark to a clip while recording, you must set an assignable button to [Add Shot Mark] in advance.
 

1 Set an assignable button to [Add Shot Mark] (A 105).

2 While you are recording, press the assignable button at the beginning of the shot you wish to mark.
• [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.

NOTESNOTES

• Up to 100 shot marks can be added to a single clip.
• There may be up to a 0.5 second delay from when you press the button to when the camera adds the shot 

mark.
• When a clip contains a shot mark, ! will appear next to the clip’s thumbnail in the playback index screen.
• When pre-recording is activated, you cannot add a shot mark before the REC button is pressed.

Adding an $ Mark or % Mark to the Last Clip Recorded
$ marks can be used to protect important clips, as clips with an $ mark cannot be deleted with the camera.
To add a mark in CAMERA mode, you must set an assignable button to [Add $ Mark] or [Add % Mark] in 
advance.

1 Set an assignable button to [Add $ Mark] or [Add % Mark] (A 105).

2 After recording a clip, press the assignable button.
• [$Mark] or [%Mark] will appear briefly and the selected clip mark will be added to the clip.

NOTESNOTES

• A clip cannot have both an $ mark and a % mark at the same time.
• When a clip has an $ mark or % mark, the respective icon will appear next to the clip's thumbnail in the 

playback index screen.
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Using Metadata
When the main recording format is set to XF-AVC, the camera automatically adds metadata to the recorded 
clips. You can use Canon XF Utility to check and search for specific metadata. You can also create and transfer 
a user memo remotely using Browser Remote on a connected network device (A 161).

Metadata components

1 User memo files need to be created using the software and saved on an SD card in advance.
2 Only when a GP-E2 GPS Receiver is connected to the camera. While recording, GPS information is recorded automatically by 

the camera.
3 GPS information can only be added to clips already recorded.
4 Recording data is logged automatically by the camera.

NOTESNOTES

• When  > [  Network Settings] > [Network] is set to [Enable], the GP-E2 GPS Receiver cannot be 
used.

Setting a User Memo Created with Canon XF Utility
Before you can add a user memo, you must first install Canon XF Utility (A 134). Next, create the user memo 
and then save it to an SD card. Once you insert the SD card in the camera and select the user memo, it will be 
added to clips you record.

1 Use Canon XF Utility to save a user memo to an SD card.
• For details, refer to Managing User Memo Profiles in the Canon XF Utility Instruction Manual.

2 Insert the SD card into the camera’s SD card slot B.

3 Select  > [Æ Recording/Media Setup] > [Metadata] > [Setting] > [SD Card].

4 Select  > [Æ Recording/Media Setup] > [Metadata] > [User Memo] > Desired user memo file.
• The Q icon appears on the left of the screen. (only when [¢ Monitoring Setup] > [Custom Display 2] > 

[User Memo] is set to [On].)
• Select [Off] to record clips without a user memo.

NOTESNOTES

• After you set a user memo, do not remove SD card B while you are recording. If the SD card is removed, the 
user memo will not be added to the clip.

• You must set the user memo before you start recording for it to be added to the clips. You cannot change the user 
memo already added to a clip using the camera but you can do so with Canon XF Utility.

Metadata
Entering content Checking content

Camera Canon XF Utility Browser Remote Canon XF Utility

User Memo: clip title, creator, location and description. – Ü1 Ü Ü

GPS information: altitude, latitude and longitude. –2 Ü3 Ü Ü

Information about the recording: scene and take. Ü Ü

Information about camera settings: shutter speed, ISO 
speed/gain value, etc.

–4 Ü

Unique Material Identifiers (UMID): country, organization 
and user codes based on the SMPTE standard.

Ü

(A 166) 
– – –
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Entering Slate Information About the Recording
You can enter scene and take information to help identify the recording later on.

1 Select  > [Æ Recording/Media Setup] > [Metadata] > [Scene] or [Take] > [Change]. 

2 Enter the desired text using the keyboard screen (A 25).
• To clear the scene/take information, select [Reset] instead.
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Special Recording Modes
The camera features the following special recording modes.

Slow & fast motion recording: This mode allows you to change the shooting frame rate to achieve a slow motion 
or fast motion effect during playback. Recording audio in WAV format is also possible.

Pre-recording: The camera will start recording a few seconds before you press the REC button. This is especially 
useful when it is difficult to predict when to start recording.

Continuous recording: The camera keeps a continuous recording on the SD card in the second slot (MP4 format 
only) to avoid any missed shooting opportunities.

Slow & Fast Motion Recording
The camera can record using a progressive frame rate (shooting frame rate) that is different from the playback 
frame rate. Recording a clip with a shooting frame rate higher than the [Frame Rate] setting will result in a slow 
motion effect during playback. Conversely, a lower shooting frame rate will result in a fast motion effect.
Sound is not recorded with the clip, but it can be recorded separately as a WAV file. The maximum recording 
time of a single clip is the equivalent of approximately 6 hours of playback time. 

Available shooting frame rates

* It cannot be used when [Super 16 Digital IS] (A 78) is set to [On].

1 To record audio, insert an SD card into the card slot where video is not being recorded.

2 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Slow & Fast Motion] or [S&F 
Clip/Audio (WAV)].
• Slow & fast motion recording is activated. [S&F STBY] appears on the screen and the shooting frame rate 

appears next to the frame rate setting (the playback frame rate).
• You can also use direct touch control (A 49).

3 Select  > [Æ Recording/Media Setup] > [Slow & Fast Frame Rate] > Desired frame rate.
• You can also use direct touch control (A 49). You can also choose a preset value (half, same or double the 

playback frame rate).

Sensor mode Resolution Available range

[Super 35mm] 4096x2160,
3840x2160,
2048x1080,
1920x1080

Ü –

[Super 16mm (Cropped)] 2048x1080,
1920x1080

Ü Ü*

Frame Rate Shooting frame rate (fps)

59.94P 15, 30, 44, 48, 52, 56, 60, 90, 120 150, 180

29.97P
15, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 
60, 90, 120

150, 180

23.98P, 
24.00P

12, 16, 18, 20, 22, 24, 26, 28, 30, 32, 36, 40, 44, 
48, 52, 56, 60, 72, 96, 120

144, 168, 180

50.00P 15, 25, 34, 38, 42, 46, 50, 54, 58, 60, 75, 100, 120 125, 150, 175, 180

25.00P
15, 17, 19, 21, 23, 25, 26, 28, 30, 34, 38, 42, 46, 
50, 54, 58, 60, 75, 100, 120

125, 150, 175, 180
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4 Press the REC button to begin recording.
• The tally lamp changes from green (power indicator) to red.
• [S&F STBY] changes to [S&F ÜREC] while recording. 

5 Press the REC button again to stop recording.
• The clip is recorded on the selected SD card.
• When [S&F Clip/Audio (WAV)] is selected, audio in WAV format will be recorded on the SD card where video 

is not being recorded.
• The tally lamp changes from red to green (power indicator) and the onscreen display changes back to [S&F 

STBY].

6 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to turn off 
slow & fast motion recording.

NOTESNOTES

• The shooting frame rate cannot be changed while recording.
• If you change the system frequency, slow & fast motion recording will be canceled and the shooting frame rate 

will be reset to its default value.
• About the time code when slow & fast motion recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. 
- If the time code running mode was set to [Free Run], the time code running mode will be changed 

automatically to [Rec Run] when slow & fast motion recording is activated. 
- When the special recording mode is turned off, the time code running mode will return to its previous setting.
- The time code signal will not be output from any terminal.

• Recording Audio (WAV)
- Audio is recorded with the following settings: 48 kHz, 24 bit, 4 channels.
- If video cannot be recorded due to a card problem, audio will also not be recorded.
- However, video will be recorded even if audio cannot be recorded due to a card problem.
- Audio will not be recorded if there is an existing WAV file with the same file name.
- Audio recording will stop automatically after reaching 60 minutes (video recording will continue).
- A maximum of 999 WAV files can be recorded.

Pre-recording
When pre-recording is activated, the camera starts recording continuously onto a temporary memory (approx. 
3 seconds) so when you press the REC button, the clip will contain also a few seconds of video and audio 
recorded before you pressed the button.

1 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Pre-Recording].
• [PRE STBY] appears on the screen.
• You can also use direct touch control (A 49).

2 Press the REC button to begin recording.
• The tally lamp changes from green (power indicator) to red.
• [PRE STBY] changes to [PRE ÜREC] while recording.

3 Press the REC button again to stop recording.
• The clip is recorded. The recorded clip will include a few seconds of video and audio recorded before the 

REC button was pressed.
• The tally lamp changes from red to green (power indicator) and the onscreen display changes back to [PRE 

STBY].
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4 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop pre-
recording.

NOTESNOTES

• Pre-recording will be canceled if the recording mode is changed.
• About the time code when pre-recording is activated:

- The time code of the clip will start a few seconds before the REC button was pressed.
- The time code will be recorded with the running mode set to [Free Run].
- If the time code mode was set to [Regen.], or to [Preset] with [Rec Run] running mode, the time code 

running mode will be changed automatically to [Free Run] when pre-recording is activated.
- When the special recording mode is turned off, the time code running mode will return to its previous 

setting.

Continuous Recording
Audio and video are recorded on both cards in this mode, normal recording on SD card A, and continuous 
recording on SD card B. This function can be used when the main recording format is set to MP4. Video will be 
recorded in MP4 format and audio will be recorded in linear PCM format.

1 Insert an SD card into each card slot (slot A for normal recording, slot B for continuous recording).

2 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [ Main / Continuous Rec].
• The continuous recording mode is activated and [CONT] appears on the screen next to the SD card B 

indicator. 

3 Select  > [Æ Recording/Media Setup] > [Continuous Recording] > [REC].
• The tally lamp changes from green (power indicator) to red and continuous recording starts on SD card B. 

The onscreen display changes to [ÜCONT].

4 Press the REC button to start recording.
• Normal recording on SD card A starts.
• If you press the button before step 3, recording will start on both cards.

5 Select  > [Æ Recording/Media Setup] > [Continuous Recording] > [STBY].
• The tally lamp changes from red to green (power indicator) and recording stops on both cards. The 

onscreen display changes to [CONT].

6 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to turn off 
continuous recording.

NOTESNOTES

• When continuous recording is activated, if recording on SD card B (continuous recording) is not available, 
normal recording on SD card A will not be possible either.

• Continuous recording will continue even if SD card A becomes full.
• If [Continuous Recording] is set to [STBY] and the main recording format is changed to an option other than 

MP4, continuous recording will be canceled.
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Using Anamorphic Lenses
You can attach an anamorphic lens to the camera and set the anamorphic desqueeze ratio used to display the 
image from the camera on monitoring devices while shooting or during playback.

1 Select  > [¢ Monitoring Setup] > Desired [Anamorphic:] setting > [On].

2 Select  > [¢ Monitoring Setup] > [Anamorphic Desqueeze] > Desired option.

3 If necessary, select  > [¢ Monitoring Setup] > [Desqueeze for S&F] > [Reduced Display].
• When slow & fast motion recording is activated, the desqueezed image can only be displayed windowboxed 

([Reduced Display]).

Options
[Lens Squeeze Factor]:

The desqueeze factor is linked to the  > [Æ Recording/Media Setup] > [Metadata] > 
[Lens Squeeze] setting.

[x2.0]: Stretches the video horizontally by a factor of 2.
[x1.3]: Stretches the video horizontally by a factor of 1.3.

NOTESNOTES

• You can record the lens’s squeeze factor in the clip’s metadata with the  > [Æ Recording/Media 
Setup] > [Metadata] > [Lens Squeeze] setting.

• If [Anamorphic: HDMI] is set to [On] when the HDMI OUT terminal’s resolution is set to [4096x2160 / 
3840x2160] and the frame rate is set to 59.94P or 50.00P, the video output from the HDMI OUT terminal will 
be a 1920x1080 image.

• The image displayed during photo playback and the camera’s live view image in the Browser Remote 
application will not be desqueezed.
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Using the RC-V100 Remote Controller
You can connect the RC-V100 Remote Controller to the camera in order to control the camera (including 
advanced recording functions) from a distance. The remote controller lets you turn the camera on, navigate the 
menus and remotely control the aperture and shutter speed, change picture-related settings like the knee and 
sharpness, and more.
For details on how to connect and use the remote controller, refer to its instruction manual.

1 Turn off the camera and connect the RC-V100 Remote Controller to the camera.

2 Turn on the camera in CAMERA mode.

3 Select  > [B System Setup] > [REMOTE Term.] > [RC-V100 (REMOTE A)].

Options
[RC-V100 (REMOTE A)]: 

Select this option to use the RC-V100 connected to the camera with the RC-V100’s remote 
cable.

[Standard]: Select this option to use commercially available remote controls.

NOTESNOTES

• The AUTO KNEE button and AF button will have no effect on the camera.
• The AUTO IRIS button on the remote controller can operate the camera only when a lens compatible with auto 

iris (A 203) is attached to the camera.
• The ZOOM dial on the remote controller can operate the lens only when a compatible lens (A 203) is 

attached to the camera.

Remote cable
(supplied with the RC-V100)
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Assignable Buttons
The camera offers a number of assignable buttons to which you can assign various function. Assign often-used 
functions to the buttons you find most convenient to personalize the camera to your needs and preferences. 
You can find 13 assignable buttons on the camera’s body, and 4 assignable buttons on the RC-V100 Remote 
Controller. In most cases, the names of the buttons printed on the camera and accessories also indicate their 
default settings.

Changing the Assigned Function
Functions can be set separately in CAMERA mode and MEDIA mode.

1 Press the MENU button and, while holding it pressed down, press the assignable button whose 
function you wish to change.
• A list of available functions appears.
• You can also select the appropriate menu setting from the various pages of the  > [ Assignable 

Buttons] menu.

2 Select the desired function.
• The selected function will be assigned to the selected button.

3 If you selected [User Setting], select the menu setting you want to register.
• The selected menu setting will be assigned to the selected button. User-selected settings will be indicated 

with a  icon in the [ Assignable Buttons] menu.

4 Press the assignable button to use the assigned function as described in the following table.
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NOTES

• You can check the [ Assignable Buttons] status screens (A 176) to see what functions are currently 
assigned to each button.

• You can reset only the functions assigned to the assignable buttons, without affecting other camera settings, 
with the  > [B System Setup] > [Reset] > [Assignable Buttons] function. All the assignable buttons will 
return to their default function.

• Assignable button Camera 8 can only be used as an assignable button in CAMERA mode.

Assignable functions
Functions whose names include a video output destination (LCD, terminal name) affect only the specified video 
output, while [All] indicates the function affects all video outputs.

Function name Description
CAMERA 

mode
MEDIA 
mode

A

[(NONE)] No function assigned – the button is disabled. Ü Ü –

[One-Shot AF] The camera focuses automatically one time only (one-shot AF function). Ü – 72

[AF Lock] Turns the AF lock function on/off.
Ü – 74

[AF Lock (While Pressed)]1 Activates the AF lock function while the button is held pressed down.

[AF Frame] Toggles the size of the AF frame. Ü – 75

[Face AF] Toggles the [Face AF] setting between [Face Priority] and [Face Only]. Ü – 75

[Face Det. & Tracking] Turns the face detection & tracking function on/off. Ü – 75

[Tracking] Enters/cancels tracking standby mode. Ü – 76

[Focus Guide] Turns the focus guide on/off. Ü – 70

[Peaking: All], 
[Peaking: LCD], 
[Peaking: HDMI]

Turns peaking on/off. Ü – 71

[Magnification], 
[Magn.: LCD], 
[Magn.: HDMI]

Turns magnification on/off. Ü – 71

[Push Auto Iris]
The camera automatically adjusts the aperture only while the button is held 
pressed down.

Ü – 64

[Iris Mode] Switches the aperture adjustment mode between automatic and manual. Ü –
62

[Iris +], [Iris –] Opens up/closes the aperture, respectively. Ü –

[ND +], [ND –]
Cycles through ND filter settings in increasing (higher density) or decreasing 
(lower density) order, respectively.

Ü – 61

[ISO/Gain Mode] Changes the ISO speed/Gain adjustment mode. Ü – 59

[AE Shift +], [AE Shift –] Compensates the exposure making the image brighter/darker, respectively. Ü – 65

[Backlight], [Spotlight]
Toggles the light metering mode between [Standard] and [Backlight]/[Spotlight], 
respectively.

Ü – 65

[Zebra: All], [Zebra: LCD], 
[Zebra: HDMI]

Turns zebra patterns on/off. Ü – 82

[WFM: All], [WFM: LCD], 
[WFM: HDMI]

Turns the selected video scope on/off. Ü Ü 95

[LUT: LCD] Turns on/off the application of the selected LUT. Ü Ü 131

[False Color: All], 
[False Color: LCD], 
[False Color: HDMI]

Turns the false color overlay on/off.
Ü – 82

[False Color Index] Displays/hides the false color index screen.

[White Balance]
Enters the direct setting mode with the white balance mode highlighted and 
ready to be adjusted.

Ü – 66
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[Set White Balance] Starts the white balance calibration for a custom white balance setting. Ü – 67

[AWB Lock]1 While using auto white balance (AWB), locks the current white balance settings. Ü – 68

[  AWB], 
[Å Set A], [Å Set B], 
[¼ Daylight], 
[É Tungsten], 
[È Kelvin]

Changes the white balance mode/setting to the respective option. Ü – 66

[Digital IS] Turns the digital image stabilizer (digital IS) on/off.
Ü – 78

[Pause Digital IS] Turns digital IS off as long as the button is held pressed down.

[LCD Setup]
Opens the [¢ Monitoring Setup] menu page with the settings for adjusting the 
LCD screen.

Ü Ü 167

[OSD Output: HDMI] Turns the camera’s onscreen displays on/off. Ü Ü 129

[OSD Opacity: All], 
[OSD Opacity: LCD], 
[OSD Opacity: HDMI]

Changes the transparency level of onscreen displays. Ü Ü 129

[DISP] Changes the onscreen display level. Ü Ü 46

[OSD Orientation: LCD]
Changes the onscreen display direction in the following order: standard, 
90 degrees rotation, 270 degrees rotation.

Ü – 47

[Markers: All], 
[Markers: LCD], 
[Markers: HDMI]

Turns onscreen markers on/off. Ü – 80

[Color Bars] Turns color bars on/off. Ü – 94

[IP Streaming] Turns the IP streaming function on/off. Ü – 154

[Photo]1 Records a photo. Ü – 42

[Review Recording]1 Plays back the last clip recorded in CAMERA mode. Ü – 47

[Time Code] Opens the [B System Setup] menu page with the time code settings. Ü – 83

[Add Shot Mark]1 Adds a shot mark to the clip. Ü Ü 97, 
125, 
125

[Add $ Mark], 
[Add % Mark]

Adds an $ or % mark to the clip. Ü Ü

[Headphones +], 
[Headphones –]

Increases/reduces the headphone volume, respectively. Ü Ü 122

[Monitor Channels]
Switches the audio channels output from the × (headphone) terminal and the 
built-in speaker.

Ü Ü 133

[Audio Level Indicator] Turns the audio level meter on/off. Ü Ü 90

[FUNC] Enters the direct setting mode. Ü – 50

[Slow & Fast Motion] Turns slow & fast motion recording on/off.

Ü – 100
[Slow & Fast Frame Rate]

When slow & fast motion recording is activated, highlights the shooting frame 
rate in order to adjust it.

[Output: 60 � 60 (24) fps], 
[Output: 60 � 60 (30) fps]

When the frame rate is 59.94P or 59.94i, toggles the frame rate of video output 
terminals and the LCD screen between said frame rates and 24 fps or 30 fps, 
respectively.

Ü – –

[Iris]
Enters the direct setting mode with the aperture value highlighted and ready to 
be adjusted.

Ü – 62

[Shutter]
Enters the direct setting mode with the shutter speed highlighted and ready to be 
adjusted.

Ü – 57

[ISO/Gain]
Enters the direct setting mode with the ISO speed or gain value highlighted and 
ready to be adjusted.

Ü – 59

[Status]1 Displays the status screens. Ü Ü 173

Function name Description
CAMERA 

mode
MEDIA 
mode

A



Assignable Buttons

108

1 Function can be used only by assigning it to a button.

[Audio Status]
Displays the [¡ Audio Setup] status screens. You can press SET to open the 
[¡ Audio Setup] menu. 

Ü Ü 177

[Custom Picture] Opens the [/ Custom Picture] menu. Ü – 109

[My Menu] Opens the [¥ My Menu] customized menu. Ü – 24

[Initialize Media] Opens the [Initialize Media] submenu. Ü Ü 32

[Play/Pause] Pauses and resumes the playback. – Ü 120

[INDEX/Cancel Resume]
Returns to the index screen. The next time the clip is selected, playback will start 
from the beginning.

– Ü 120

[INDEX]
Returns to the index screen. The next time the clip is selected, playback will start 
from the frame where it stopped.

[Focus Mode] Toggles the focus mode between AF (autofocus) and MF (manual focus). Ü – 43

[REC]
Functions as the REC button. Can only be assigned to assignable button 
Camera 4.

Ü – 41

[  User Setting]1
Customizable slot. Assign to the button any menu setting you would like to 
register.

Ü Ü –

Function name Description
CAMERA 

mode
MEDIA 
mode

A



109

Custom Picture Settings

Custom Picture Settings
The camera lets you change many settings (A 113) that control various aspects of the image produced. As a 
set, all these settings are treated as a single custom picture file. After adjusting the desired settings to your 
preference, you can save up to 20 custom picture files (in the camera or on an SD card), and load them later to 
apply exactly the same settings (A 112). You can also save the custom picture file as part of the metadata 
recorded with XF-AVC clips (A 112).

Selecting Custom Picture Files
In CAMERA mode, select a custom picture file to apply its settings to your recordings or to edit, rename, protect, 
or transfer it.

1 Select  > [/ Custom Picture] > [Select / File].
• The custom picture file selection screen is displayed.
• Select one of the custom picture files saved in the camera (C1 to C20). To use the settings of a custom 

picture file saved on an SD card, copy the file to the camera in advance (A 112).
• You can also use direct touch control's Æ recording settings (A 49).

2 Select the desired file.
• When you close the menu, the selected custom picture file’s settings will be applied.

Preset Picture Settings
The following settings are saved to custom picture files C1 to C20 as preset custom picture settings. Custom 
picture files C1 to C5 are protected by default and need to be unprotected before they can be edited.

* This setting is found under  > [/ Custom Picture] > [Edit / File].
** ITU-R BT.2100 is a standard for a color bit depth of 10 or 12 bits. When the video configuration is set to one of the 8 bit color 

options, the gamma curve is approximately equivalent to this standard.

Preset custom 
picture file

[Gamma/Color Space]* [Color Matrix]* Characteristics

C1: [BT.709]
[BT.709 Wide DR / 

BT.709]

[Neutral]

These settings produce a wide dynamic range and are appropriate for playback 
on a TV monitor.

C2: [LOG2]
[Canon Log 2 / 

C.Gamut]
These settings use Canon Log 2 gamma and require post-production processing. 
They achieve superior gradation in the shadows (dark areas of the image).

C3: [LOG3]
[Canon Log 3 / 

C.Gamut]

These settings use Canon Log 3 gamma and require post-production processing. 
They keep the [Canon Log] gamma characteristics while expanding its dynamic 
range.

C4: [PQ] [PQ / BT.2020]
These settings use a high dynamic range gamma curve compliant with the PQ 
standard defined by ITU-R BT.2100.**

C5: [HLG] [HLG / BT.2020]
These settings use a high dynamic range gamma curve compliant with the HLG 
standard defined by ITU-R BT.2100.**

C6: [USER06] to 
C20: [USER20]

[BT.709 Wide DR / 
BT.709]

These settings use a gamma curve with a very wide dynamic range, optimized 
for playback on TV monitors.
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NOTES

About the logarithmic gamma curves (Canon Log settings)
- These gamma curves require post-production processing. They were designed to make the most of the 

imaging sensor characteristics in order to obtain impressive levels of dynamic range.
- In CAMERA mode, you can apply a LUT to the LCD screen's image to use gamma curve settings more 

suitable for viewing on a monitor screen.
- There are also other LUTs available that can be applied for processing in post-production. For the latest 

information on available LUTs, please visit your local Canon website.
About changing custom picture related settings using the RC-V100 Remote Controller

- When an RC-V100 Remote Controller is connected to the camera, you can press the remote controller’s 
CUSTOM PICT. button to open the [/ Custom Picture] menu.

- If a protected custom picture file is selected on the camera, custom picture related settings cannot be 
changed using the remote controller.

- Adjusting custom picture related settings using the remote controller will change the settings registered 
under the currently selected custom picture file. If you want to keep an important custom picture file, copy it 
in advance to an SD card or select in advance a custom picture file you do not mind changing.

Editing a Custom Picture File’s Settings
In CAMERA mode, adjust the image quality to your preference and save the settings as part of a custom picture 
file.

1 Select a custom picture file (A 109).

2 Select  > [/ Custom Picture] > [Edit / File].
• Select an unprotected custom picture file.

3 Select a setting you wish to change and select the desired option.
• Refer to Available Custom Picture Settings (A 113) for details on the various settings.
• Repeat step 3 for other settings as necessary.
• When you close the menu, the new custom picture settings will be applied.

Renaming Custom Picture Files

1 Select a custom picture file (A 109).

2 Select  > [/ Custom Picture] > [Edit / File] > [Rename] > [Input].
• Enter the desired file name (A 25).

Protecting Custom Picture Files

Protecting a custom picture file prevents its settings from being accidentally changed.

1 Select a custom picture file (A 109).

2 Select  > [/ Custom Picture] > [Edit / File] > [Protect] > [Protect].
• i will appear next to the file name.
• To remove the protection, select [Unprotect] instead.
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Resetting Custom Picture Files

1 Select a custom picture file (A 109).

2 Select  > [/ Custom Picture] > [Edit / File] > [Reset].

3 Select a preset custom picture setting and then select [OK].
• The custom picture file will be reset to the selected values.

Look Files
You can register 3D LUT files (.cube format) created with Blackmagic Design’s DaVinci Resolve or other software 
as Look Files in the custom picture file. Using a Look File allows you to adjust the video quality of the recorded 
video. These adjustments apply also to proxy clips, photos, and screen/output terminals.

1 Insert the SD card with the desired Look File (.cube format, located in the root directory of the SD 
card) into the camera’s SD card slot B.

2 Select a custom picture file. (A 109)

3 Select  > [/ Custom Picture] > [Edit / File] > [Gamma/Color Space] > Desired option.

4 Select  > [/ Custom Picture] > [Edit / File] > [Look File Setup] > [Register].
• The Look Files in the SD card will be displayed.

5 Select the desired Look File.

6 Select the [Gamma/Color Space] setting to use after the Look File is applied.

7 Select [OK] twice.
• The selected Look File will be loaded and registered to the custom picture file.

8 Select  > [/ Custom Picture] > [Edit / File] > [Look File] > [On].
• The image quality adjustments set in the Look File will be applied, and  will appear on the screen.

NOTES

About Look files
- The camera supports Look Files (.cube format) in 17 grid or 33 grid format created with Blackmagic 

Design’s DaVinci Resolve or other software.
- Look Files with input ranges outside the 0 to 1 range in the header (“LUT_3D_INPUT_RANGE”) are not 

supported.
- Look Files 2 MB and larger, as well as files with a name containing over 65 characters are not supported.
- Only the following characters can be used in the file name: 

Numbers 0 to 9, upper/lower case letters a to z, underscore (_), hyphen (-), period (.) and a single byte 
space.

• If the correct input/output gamma curve and color space conversion are not selected, video will not be output 
correctly.

• A Look File cannot be used if the [Gamma/Color Space], [HLG Color] or [Over 100%] settings are changed 
after registering it.

• When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to either 
[BT.709 Normal] or [BT.709 Wide DR], super-white (video signal above 100%) and super-black (video signal 
below 0%) levels of brightness will be clipped. When the video signal contains super-white brightness levels, 
select  > [/ Custom Picture] > [Edit / File] > [Other Functions] > [Over 100%] > [Press] and then 
activate the Look File to apply it to a signal compressed to 100%.
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Deleting a Look File

You can delete Look Files registered in custom picture files.

1 Select a custom picture file (A 109).

2 Select  > [/ Custom Picture] > [Edit / File] > [Look File Setup] > [Delete] > [OK].
• The Look File will be deleted and the image quality adjustments will be reversed to the original settings of the 

selected custom picture file.

Saving a Custom Picture File

Copying Custom Picture Files

You can copy custom picture files between the camera and SD card. Insert in advance into the camera the card 
where you want to save your custom picture files or the card that contains the custom picture file you want to 
load.

Copying a File from the Camera to an SD Card

1 Select a custom picture file (A 109).

2 Select  > [/ Custom Picture] > [Save / File] > [Copy to SD Card B].

3 Select the destination file on the card and then select [OK].
• Select an existing custom picture file to overwrite it or [New File] to save the settings as a new custom 

picture file on the card.

4 When the confirmation message appears, press SET.

NOTES

• Custom picture files are exclusively compatible for use only with the same camera model.

Replacing a File in the Camera with a File on an SD Card

1 Select the custom picture file that you wish to replace (A 109).

2 Select  > [/ Custom Picture] > [Save / File] > [Load from SD Card B].

3 Select the file with the settings that you want to replicate and then select [OK].
• The file in the camera will be overwritten by the one on the card. 

4 When the confirmation message appears, press SET.

Embedding the Custom Picture File in Clips (CAMERA Mode)

When you record in XF-AVC format after having set custom picture settings, you can have the custom picture file 
embedded in the metadata and saved along with the clips. When displaying the information screen in MEDIA 
mode, you can check the custom picture settings used at the time of recording.

Select  > [Æ Recording/Media Setup] > [Metadata] > [Add / File] > [On].
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Available Custom Picture Settings

Menu items Options / Additional information

[Gamma/Color Space] [Canon Log 2 / C.Gamut], [Canon Log 3 / C.Gamut], [Canon Log 3 / BT.2020], 
[Canon Log 3 / BT.709], [PQ / BT.2020], [HLG / BT.2020], [BT.709 Wide DR / BT.2020], 
[BT.709 Wide DR / BT.709], [BT.709 Normal / BT.2020], [BT.709 Normal / BT.709]

Combination of gamma curve and color space settings that affects the overall look and color space of 
the image.

Gamma curve
[Canon Log 2]: Logarithmic gamma curve that obtains a richer color gradation in the dark areas of 

the image. Requires image processing in post-production.
[Canon Log 3]: Logarithmic gamma curve that keeps the characteristics of the [Canon Log] setting 

while expanding its dynamic range. Requires image processing in post-production.
[PQ]: HDR (high dynamic range) gamma curve compliant with the PQ standard defined by ITU-R 

BT.2100.*
[HLG]: HDR (high dynamic range) gamma curve compliant with the HLG standard defined by ITU-R 

BT.2100.*
[BT.709 Wide DR]: Gamma curve with a very wide dynamic range. Optimized for playback on TV 

monitors. Equivalent to the [Wide DR] setting in previous camera models.
[BT.709 Normal]: Standard picture for playback on TV monitors. Equivalent to the [Normal1] setting in 

previous camera models.
* ITU-R BT.2100 is a standard for a color bit depth of 10 or 12 bits. When the video 

configuration is set to one of the 8 bit color options, the gamma curve is approximately 
equivalent to this standard.

Color space
[C.Gamut]: Color space developed by Canon based on the specific characteristics of the camera’s 

imaging sensor. It covers a wider color gamut than that of BT.2020. Use this setting with 
workflows that require ACES2065-1 color space.

[BT.2020]: Color space that meets ITU-R BT.2020 standards, which defines parameters for ultra-
high-definition television (4K/8K).

[BT.709]: Standard color space that is compatible with sRGB specifications.

[Color Matrix] [Neutral], [Production Camera], [Video]

The color matrix affects the overall color tonality of the image.
[Neutral]: Reproduces neutral colors.
[Production Camera]: Reproduces colors more suitable for motion picture production.
[Video]: Reproduces colors with a contrast suitable for TV broadcasting.

[Look File] [On], [Off]

Image quality adjustments set in the Look File will be applied.

[Look File Setup]

[Register] Registers a Look File (.cube format) to a custom picture file.

[Delete] Deletes a Look File registered to a custom picture file.

[HLG Color] [BT.2100], [Vivid]

Changes the quality of color reproduction when using the hybrid log gamma (HLG). This setting is 
only available when [Gamma/Color Space] is set to [HLG / BT.2020].
[BT.2100]: Color reproduction according to ITU-R BT.2100 specifications.
[Vivid]: More saturated color reproduction according to the 'Traditional Colour' approach in ITU-R 

BT.2390.
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[Black]

[Master Pedestal] –50 to +50 (±0)

Increases or decreases the black level. Higher settings will make dark areas brighter but decrease 
contrast. This setting is not available when the gamma curve component of the [Gamma/Color 
Space] setting is set to one of the [Canon Log 2] or [Canon Log 3] options.

[Master Black Red], 
[Master Black Green], 
[Master Black Blue]

–50 to +50 (±0)

These settings correct the color cast in blacks. These settings are not available when the gamma 
curve component of the [Gamma/Color Space] setting is set to one of the [Canon Log 2] or [Canon 
Log 3] options.

[Black Gamma]

[Level] –50 to +50 (±0)

[Range], [Point] –20 to +50 (±0)

These settings control the lower part of the gamma curve (dark areas of the image). These settings 
are only available when the gamma curve component of the [Gamma/Color Space] setting is set to 
one of the [BT.709 Normal] options.
[Level]: Raises or lowers the lower part of the gamma curve. 
[Range]: Selects the adjustment range from the selected [Point].
[Point]: Determines the shape of the lower part of the gamma curve. 

[Low Key Saturation]

[Activate] [On], [Off]

Set this setting to [On] to enable the adjustment of color saturation in dark areas with the [Level] 
setting.

[Level] –50 to +50 (±0)

Specifies how saturated colors are in dark areas.

[Knee]

[Activate] [On], [Off]

Set this setting to [On] to enable the adjustment of the knee point with the following settings. These 
settings are only available when the gamma curve component of the [Gamma/Color Space] setting is 
set to one of the [BT.709 Normal] options.

[Slope] –35 to +50 (±0)

[Point] 50 to 109 (95)

[Saturation] –10 to +10 (±0)

These settings control the upper part of the gamma curve (highlights of the image). By compressing 
the highlights, you can prevent parts of the image from being overexposed.
[Slope]: Determines the slope of the gamma curve above the knee point.
[Point]: Sets the knee point of the gamma curve.
[Saturation]: Adjusts the color saturation in the highlights.

Menu items Options / Additional information
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[Sharpness]

[Level] –10 to +50 (±0)

Sets the sharpness level of the video output signal and the recorded signal.

[Detail Frequency] –8 to +8 (±0)

Sets the center frequency of horizontal sharpness. Setting higher values increases the frequency, 
which, in turn, increases the sharpness.

[Coring Level] –30 to +50 (±0)

Sets the level of correction of artifacts caused by high sharpness levels (coring). Higher values 
prevent sharpness from being applied to minute details, resulting in less noise.

[Limit] –50 to +50 (±0)

Restricts how much sharpness is applied.

[Noise Reduction]

[Spatial Filter] [Off], 1 to 12

Reduces noise by applying a soft focus-like effect on the entire picture. When set to a value other 
than [Off], afterimages are not produced but the whole image will have a softer look.

[Frame Correlation] [Off], 1 to 3

Reduces noise elements by comparing the current image to the previous one (field). When set to a 
value other than [Off], the perceived resolution will not be affected but an afterimage may appear for 
moving subjects.

[Skin Detail]

[Effect Level] [Off], [Low], [Middle], [High]

[Hue] –16 to +16 (±0)

[Chroma], [Area], [Y Level] 0 to 31 (16)

The camera applies a softening filter to areas in the picture with skin tones to give a more pleasant 
appearance. By changing these settings, you can determine what areas will be detected as skin 
tones. A zebra pattern will appear on the screen or video output terminal over areas of the image that 
are detected as having skin tones.
[Effect Level]: Adjusts the level of the filter. 
[Hue]: Adjusts the hue for detection of skin tones. 
[Chroma]: Adjusts the color saturation for detection of skin tones. 
[Area]: Adjusts the color range for detection of skin tones.
[Y Level]: Adjusts the brightness for detection of skin tones.

[Color Matrix Tuning]

[Gain] –50 to +50 (±0)

[Phase] –18 to +18 (±0)

These settings adjust the color intensity ([Gain]) and color phase ([Phase]) of the color matrix, 
affecting the color tones of the whole image.

[R-G], [R-B], [G-R], [G-B], 
[B-R], [B-G]

–50 to +50 (±0)

Each matrix changes the tint of the picture along the color gradations detailed below, affecting the 
color tones of the whole image.
[R-G]: cyan/green and red/magenta; [R-B]: cyan/blue and red/yellow; 
[G-R]: magenta/red and green/cyan; [G-B]: magenta/blue and green/yellow;
[B-R]: yellow/red and blue/cyan; [B-G]: yellow/green and blue/magenta.

Menu items Options / Additional information
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NOTES

• Depending on other menu settings, you may not be able to obtain the desired image effect even after 
changing the custom picture settings.

• When an RC-V100 Remote Controller is connected to the camera, the following custom picture settings can 
be changed using the buttons and dials on the remote controller.
- [Black] > [Master Pedestal], [Master Black Red], [Master Black Blue]
- [Black Gamma] > [Level]
- [Knee] > [Slope], [Point] (only when [Knee] > [Activate] is set to [On])
- [Sharpness] > [Level]
- [White Balance] > [R Gain], [B Gain]

[White Balance]

[R Gain], [B Gain] –50 to +50 (±0)

These settings adjust the amount of white balance throughout the whole image by changing the 
intensity of red tones ([R gain]) and blue tones ([B Gain]).

[Color Correction]

[Select Area] [Off], [Area A], [Area B], [Area A&B]

The camera detects areas with certain color characteristics (color phase, chroma, area and Y level) 
and corrects them when recording. You can set the color correction for up to two different areas 
(A and B) and apply the color correction to either one ([Area A] or [Area B]) or both of them ([Area 
A&B]). 
While color correction is activated, parts of the image that are not detected as having the 
characteristics specified for area A or B will appear colorless on the screen or the image output from 
the output terminals (except when adjusting the [Revision Level]/[Revision Phase] settings).

[Area A Setting Phase],
[Area B Setting Phase]

0 to 31 (0)

These settings determine the color phase of the area to be corrected (A or B, respectively).

[Area A Setting Chroma],
[Area B Setting Chroma],
[Area A Setting Area],
[Area B Setting Area],
[Area A Setting Y Level],
[Area B Setting Y Level]

0 to 31 (16)

These settings determine the following color characteristics of the area to be corrected (A or B, 
respectively).
[Area A Setting Chroma], [Area B Setting Chroma]: Color saturation. 
[Area A Setting Area], [Area B Setting Area]: Color range. 
[Area A Setting Y Level], [Area B Setting Y Level]: Brightness.

[Area A Revision Level],
[Area B Revision Level]

–50 to +50 (±0)

These settings adjust the amount of correction applied to the color saturation in the corrected area 
(A or B, respectively).

[Area A Revision Phase],
[Area B Revision Phase]

–18 to +18 (±0)

These settings adjust the amount of correction applied to the color phase in the corrected area 
(A or B, respectively).

[Other Functions]

[Over 100%] [Through], [Press], [Clip]

Determines how the camera handles video signals exceeding 100%. This setting is not available 
when the gamma curve component of the [Gamma/Color Space] setting is set to one of the 
[Canon Log 2], [Canon Log 3], [PQ] or [HLG] options.
[Through]: Leave the signal unchanged.
[Press]: Compress a signal of up to 108% down to 100% levels.
[Clip]: Clip the signal at 100%.

Menu items Options / Additional information
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Saving and Loading Menu Settings

After you adjust settings in the various menus, you can save those settings in the camera or on SD card B. You 
can load those settings at a later date or on another camera of the same model so that you can use that camera 
in the same way.

Saving Menu Settings
1 Select  > [B System Setup] > [Transfer Menu//] > [Save].

2 Select [To Camera] or [To SD Card B] and then select [OK].
• The camera’s menu settings will be saved to the selected destination. If menu settings were previously 

saved, the old file will be overwritten by the current menu settings.

Loading Menu Settings
1 Select  > [B System Setup] > [Transfer Menu//] > [Load].

2 Select [From Camera] or [From SD Card B] and then select [OK].
• The camera’s menu settings will be replaced by the settings in the previously saved file. Then, the screen will 

turn black momentarily and the camera will restart.

NOTES

• The following menu settings are not saved with this operation.
-  > [v Camera Setup] > [Color Bars]
-  > [/ Custom Picture] > [Edit / File] > [Look File Setup] (only when saved using the [To Camera] 

setting)
-  > [Æ Recording/Media Setup] > [Metadata] > [User Memo]
-  > [A Assistance Functions] > [Magnification], [Magn. Output]

• The root certificate for secure FTP transfers is not saved.
• When menu settings are loaded with this operation, even protected custom picture files in the camera will be 

replaced.
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Playback
This section explains how to play back files recorded with the camera. For details on playing back recordings 
using an external monitor, refer to Connecting to an External Monitor or Recorder (A 128).

Displaying the Index Screen
Press the MEDIA button (A 15)
• The camera is set to MEDIA mode and the clip thumbnails will appear in the index screen.
• Use the joystick or the SELECT dial to move the orange selection frame.
• Flick up/down on the screen or turn the front control dial to move to the next/previous page. 

1 XF-AVC clips only. 
2 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.

NOTES

• If the card contains XF-AVC clips recorded at a system frequency other than the one currently used by the 
camera, you will not be able to play back the clips and the clip thumbnails will not appear in the index screen. 
To play back such clips, change the camera’s system frequency (A 53) to match the recordings on the card.
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1 Key lock (A 15)
2 Shot mark1 (A 125)
3 $ mark1/% mark1 (A 125)
4 Orange selection frame 
5 Proxy clip (A 56) 
6 Clip identification (camera index, reel number, clip 

number and clip/audio file name) (A 37)
7 Recording date and time
8 Network status / functions (A 152)
9 Recording media  / 

• The card currently selected appears in white.
10 Index screen currently displayed (A 120)

11 Clip thumbnail
12 Power supply level (A 45)
13 Clip number / Total number of clips
14 Recording date (month and day only) and time
15 Clip’s start time code
16 Clip duration
17 Custom picture file embedded1 (A 112) 
18 Special recording mode (A 100) 
19 Color sampling1 and resolution, audio recording 

format
20 Frame rate2 (A 53)
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Switching Card Slots

If both card slots contain a card, press the SLOT SELECT button to play 
back recordings from the other card.

Switching Index Screens

The clip index screen that appears when you switch to MEDIA mode 
depends on the current recording settings. 

1 Press the INDEX button.
• The index screen selection menu appears.

2 Select the desired index screen.
• The selected index screen appears.
• Select [Cancel] to return to the previous index screen.

Options
[XF-AVC Index]: Clips in XF-AVC format.
[MP4 Index]: Clips in MP4 format.
[Photo index]: Photos recorded on the card.
[WAV Index]: Audio files (WAV format) for a slow & fast motion recording.

Playing Back Recordings

After selecting the desired index screen, play back the desired clips, 
photos or audio files. You can use the touch screen, assignable 
buttons, or joystick guide to play back the recordings.

Touch the thumbnail of the recording you want to play back.
• Playback will start.
• You can also move the orange selection frame using the joystick or 

the SELECT dial, and then press and hold the SET button (for 
approximately 1 second) to start playback. 

• Touch the screen or press the joystick to pause/resume playback.
• Press the INDEX button or flick the screen down to stop the 

playback and return to the index screen.
• While browsing photos, press the joystick left/right to move to the 

previous/next photo.

NOTES

• The following image files may not be displayed correctly.
- Images not recorded with this camera.
- Images edited on a computer.
- Images whose file names have been changed.
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Onscreen Displays During Clip Playback

1 Only when [¢ Monitoring Setup] > [Custom Display] > [Camera Data] is set to [On].
2 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.
3 XF-AVC clips only. 
4 Only when [¢ Monitoring Setup] > [Custom Display] > [Audio Level Indicator] is set to [On].
5 Only when [¢ Monitoring Setup] > [Custom Display] > [Date/Time] is set to [On].

NOTES

• You can press the DISP button repeatedly to change the level of onscreen displays (A 46).
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1 Fan operation (A 39) and temperature warning 
(A 184)

2 LUT (A 131) 
3 Output onscreen displays (A 129)
4 Recording date and time5

5 Joystick guide (A 122)
6 Playback operation

7 Frame rate2 (A 53)

8 Custom picture file embedded3 (A 112) 
9 $ mark3/% mark3 / Proxy clip (A 125, 56)
10 Time code (A 83)
11 Video format (A 53) 
12 Color sampling and color bit depth (A 53)
13 Resolution (A 53)
14 Headphone volume (A 122) 
15 Audio level meter4

16 Aperture value1 (A 62)
17 ISO speed/Gain1 (A 59)
18 Progress bar
19 Shutter speed1 (A 57)
20 User bit (A 84)
21 Audio output channels (A 133)

Ð PLAY Playback
Ý PAUSE Playback pause

Ô/Ó Frame reverse/Frame advance
F FWD x5* × Fast playback
Ø F REV x5* Fast reverse playback
* Approximate playback speed: x5 / x15 / x60
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Audio (WAV) playback screen
See Onscreen Displays During Clip Playback (A 121) for the description of onscreen displays that are common 
on all playback screens.

Clip Playback Controls
The following playback types are available using the joystick and onscreen joystick guide. You can press the 
DISP button to show/hide the joystick guide.
You can also change the position in the video using the progress bar.

1 You may notice some anomalies (blocky video artifacts, banding, etc.) in the playback picture.
2 The speed indicated on the screen is approximate.

NOTES

• There is no audio during any of the playback types listed in the previous table.

Adjusting the Volume
You can use headphones or the built-in speaker to listen to the audio during 
normal playback. When you connect headphones to the × (headphone) 
terminal, the speaker will be muted. The audio signal will also be output 
from the HDMI OUT terminal. 

1 Select  > [¡ Audio Setup] > [Headphone Volume] or 
[Speaker Volume].

2 Select the desired level.

NOTES

• For details on changing the audio channel, refer to Audio Output (A 133).
• If you set an assignable button to [Headphones +] or [Headphones –] (A 105), you can press the button to 

adjust the headphone volume without using the menu.

Playback type Operation

Fast playback1 During playback, push the joystick up or down.
Repeat to increase the playback speed to approximately 5x � 15x � 60x the normal speed2.

Frame advance/reverse During playback pause, push the joystick up or down.

Skip to the beginning of the next clip During playback, push the joystick right.

Skip to the beginning of the current clip During playback, push the joystick left.

Skip to the previous clip During playback, push the joystick left twice.

Change the playback/playback pause 
position in the video

During playback/playback pause, touch or slide the progress bar.

1
2

3

1 Audio file name
2 Sampling frequency and bit depth

3 Audio level meter

× (headphone) 
terminal
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File Operations
You can perform various operations on the file selected in the index screen using the file menu. Available options 
will depend on the type of recording selected. 

File Menu Operations
1 Select the desired recording. 

2 Press SET.
• The file menu will be displayed. Available functions will differ depending on the recording.

3 Select a menu item.

File menu options

1 Excluding proxy clips.
2 If the clip already contains an $ or %mark, the option to delete the mark will appear in the menu.

Menu item Description
Index screen

[XF-AVC] [MP4] [Photos] [WAV]

[Cancel] Closes the menu. Ü Ü Ü Ü

[Play] Starts playback. Ü Ü Ü Ü

[Display Clip Info] Displays the information screen (A 124). Ü Ü – –

[Add $ Mark] or 
[Delete $ Mark]1,2 Adds or deletes an $ mark (A 125, 125). Ü – – –

[Add % Mark] or 
[Delete % Mark]1,2 Adds or deletes a % mark (A 125, 125). Ü – – –

[Del. All Shot Marks]1 Deletes all the shot marks (A 126). Ü – – –

[Recover] Recovers a recording. Ü Ü – Ü

[Delete] Deletes a recording (A 126). Ü Ü Ü Ü

[Delete User Memo] Deletes the user memo and GPS information of a clip (A 126). Ü – – –

[FTP Transfer] Transfers a clip using the FTP protocol (A 153). Ü Ü – –

[Stop] Ends photo playback. – – Ü –
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Displaying Clip Information
1 Select the desired clip in the clip index screen.

2 On the file menu, select [Display Clip Info].
• The [Clip Info] screen will appear. 
• Push the joystick left/right to move to the previous/next clip. Press the CANCEL button to return to the index 

screen.

 

1 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.
2 XF-AVC clips only. 

Displaying Additional Information (XF-AVC Clips Only)

From the [Clip Info] screen of an XF-AVC clip, you can push the joystick up/down or turn the SELECT dial to 
display additional information screens.

[Lens & Q] screen: Details about the lens used to record the clip. If a user memo was recorded with the clip’s 
metadata, this screen will show also the user memo details.

[/ Data 1/3] to [/ Data 3/3] screens: If a custom picture file was embedded with the clip, these screens show 
the custom picture settings used.

Push the joystick down repeatedly or turn the SELECT dial right to check the information screens in 
the following order: [/ Data 1/3] to [/ Data 3/3] screens � [Lens & Q] screen � [Clip Info] screen.
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1 Thumbnail of the selected clip
2 Clip geotagged with GPS information
3 Thumbnail of the previous clip
4 Thumbnail of the next clip
5 Special recording mode (A 100) 
6 Recording date and time
7 Clip file name (A 37)
8 Compression, bit rate and resolution (A 52)
9 Frame rate1 (A 53)

10 Shot mark (A 125) and $ mark / % mark2 
(A 125)

11 Custom picture file embedded2 (A 112)
12 Proxy clip (A 56)
13 Color sampling2 and color bit depth (A 53)
14 Clip’s start time code
15 Clip’s end time code
16 Clip duration
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Adding $ Marks or % Marks
You can add an OK mark ($) or check mark (%) to XF-AVC clips to help you identify particular clips. Since clips 
with an $ mark cannot be deleted with the camera, you can use this mark also to protect important clips.

Adding an $ Mark or % Mark During Playback

You can add an $ mark or % mark to a clip during playback or playback pause.

1 Set an assignable button to [Add $ Mark] or [Add % Mark] (A 105).

2 During playback/playback pause of an XF-AVC clip, press the assignable button to add the clip mark.
• [$Mark] or [%Mark] will appear briefly and the selected clip mark will be added to the clip.
• Playback will be paused.

Adding an $ Mark or % Mark from the Index Screen

1 Select the desired clip from the XF-AVC index screen.

2 Press SET (file menu) and select [Add $ Mark] or [Add % Mark] > [OK].
• The selected clip mark is added to the clip.

NOTES

• A clip cannot have both an $ mark and % mark at the same time. When you add a % mark to a clip with an 
$ mark, the $ mark will be deleted. Similarly, when you add an $ mark to a clip with a % mark, the % 
mark will be deleted.

Deleting $ Marks or % Marks
You can delete an $ mark or % mark added to an XF-AVC clip.

1 Select the desired clip from the XF-AVC index screen.

2 Press SET (file menu) and select [Delete $ Mark] or [Delete % Mark] > [OK].
• The selected mark is deleted.

Adding/Deleting Shot Marks
During the playback of a clip recorded in XF-AVC format, you can add shot marks (!) to particular frames in the 
clip that you want to single out. You can also delete all shot marks at once.

Adding Shot Marks during Playback

1 Set an assignable button to [Add Shot Mark] (A 105).

2 During playback/playback pause of an XF-AVC clip, press the assignable button at the point in the clip where 
you want to add the shot mark.
• [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.
• Playback will be paused.
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Deleting All the Shot Marks from a Clip
1 Select the desired XF-AVC clip in the index screen.

2 Press SET (file menu) and select [Del. All Shot Marks] > [OK].
• All shot marks in the selected clip are deleted.

Deleting Recordings
You can delete clips, photos and audio files for slow & fast motion recording. To delete clips with an $ mark, 
you need to delete the $ mark beforehand (A 125). 

1 Select the desired file in the index screen.
• Photos are selectable on the playback screen.

2 Press SET (file menu) and select [Delete] > [OK].
• The file is deleted.
• The operation cannot be canceled.

IMPORTANT

• Be careful when deleting recordings. Once deleted, they cannot be recovered.

Deleting the User Memo and GPS Information from a Clip
1 Select the desired XF-AVC clip in the index screen.

2 Press SET (file menu) and select [Delete User Memo] > [OK].
• The user memo and GPS information that were recorded in the selected clip’s metadata are deleted.
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Video Output Configuration
The video signal output from the HDMITM OUT terminal, depends on the clip’s video configuration and on various 
menu settings. 

HDMI OUT Terminal Video Output Configuration (Recording/Playback)

1 In most cases, the output signal’s frame rate will be the same as that used for recording (except when slow & fast motion 
recording is activated).

2 The video signal's effective bit depth will be output.
3 The output signal’s frame rate is fixed and determined by the system frequency. 24.00 Hz recordings are output in 60.00P or 

60.00i.
4 Only in XF-AVC format.

Main recording video configuration  > [B System Setup] Video output configuration1

Main recording 
format

Resolution Frame rate [HDMI Scan Mode] [HDMI Max Res.] HDMI OUT terminal2

XF-AVC

MP4

4096x2160

59.94P
50.00P
29.97P
25.00P
24.00P
23.98P

[P] [4096x2160 / 3840x2160] 4096x2160

[P] [1920x1080] 1920x1080

[P] [1280x720]
1280x720

59.94P / 50.00P / 60.00P3

[PsF (Forced 1080i)] –
1920x1080

59.94i / 50.00i / 60.00i3

3840x2160

59.94P
50.00P
29.97P
25.00P
24.00P
23.98P

[P] [4096x2160 / 3840x2160] 3840x2160

[P] [1920x1080] 1920x1080

[P] [1280x720]
1280x720

59.94P / 50.00P / 60.00P3

[PsF (Forced 1080i)] –
1920x1080

59.94i / 50.00i / 60.00i3

2048x1080
1920x1080

59.94P
50.00P
29.97P
25.00P
24.00P
23.98P

[P]
[4096x2160 / 3840x2160],

[1920x1080]
1920x1080

[P] [1280x720]
1280x720

59.94P / 50.00P / 60.00P3

[PsF (Forced 1080i)] –
1920x1080

59.94i / 50.00i / 60.00i3

1280x720
59.94P
50.00P

[P] –
1280x720 /

59.94P or 50.00P3

[PsF (Forced 1080i)] –
1920x1080 /

59.94i or 50.00i3

1920x1080
59.94i
50.00i

– – 1920x10804
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Connecting to an External Monitor or Recorder
When you connect the camera to an external device, be it a monitor (to monitor the recording or for playback) or 
an external video recorder (for recording), adjust the required settings in the menu. For details about output 
signals, refer to Video Output Configuration (A 127).

Connection diagram

NOTES

• Powering the camera from a power outlet using an AC adapter is recommended.

Using the HDMI OUT Terminal
The digital signal that is output from the HDMITM OUT terminal includes the video signal and audio signal. You 
can output also the time code signal, recording command and various assistance displays (onscreen displays, 
markers, etc.) in order to check them also on an external monitor. In CAMERA mode, the camera’s time code 
can be output as well.

1 Connect the HDMI cable to the HDMI OUT terminal.

2 Select  > [B System Setup] > [HDMI Max Res.] > Desired option.

3 Select  > [B System Setup] > [HDMI Scan Mode] > Desired option. 

4 To output the time code signal, select  > [Æ Recording/Media Setup] > [HDMI Time Code] > 
[On].

NOTES

• You can set  > [B System Setup] > [Linked to HDMI Monitor] to [On] to automatically change the HDMI 
OUT terminal’s output resolution according to the capabilities of the connected monitor. When this setting is 
set to [Off], the output resolution is set according to the menu settings and if the connected monitor is not 
compatible with the signal output from the camera, HDMI output will stop.

• The HDMI OUT terminal is for output only. Do not connect the camera to another device’s output terminal 
using the HDMI OUT terminal as this will cause a malfunction.

• Correct operation cannot be guaranteed when connecting the camera to DVI monitors.

HDMI OUT terminal

HDMI cable (commercially available)

External 
monitor/

digital video 
recorder

HDMI inputs
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• If the camera’s time code is being output and  > [Æ Recording/Media Setup] > [Rec Command] is set 
to [On], you can use the camera’s REC button to control also the recording operation of an external recorder 
connected to the HDMI OUT terminal.

• During continuous recording, the recording command will not be output.
• The time code will not be output from the HDMI OUT terminal in the following cases.

- In MEDIA mode.
- When the video output signal is 720x480 / 59.94P or 720x576 / 50.00P.

• If  > [B System Setup] > [HDMI Scan Mode] is set to [PsF (Forced 1080i)] or if  > [B System 
Setup] > [HDMI Max Res.] is set to [1280x720], even when the frame rate is set to 23.98P or 24.00P, the 
frames value of the time code output from the HDMI OUT terminal will be converted so it runs from 0 to 29.

Superimposing Onscreen Displays on Video Outputs
You can output the camera's onscreen displays along with the video output from the HDMI OUT terminal to 
check the onscreen displays on an external monitor. You can also adjust the opacity level of superimposed 
onscreen displays. This setting will not affect your recordings.

Select  > [¢ Monitoring Setup] > [OSD Output: HDMI] > [On].
• T appears on the right of the screen (In CAMERA mode, only if  > [¢ Monitoring Setup] > 

[Custom Display 2] > [OSD Output] is set to [On]).

NOTES

• When the HDMI OUT terminal’s output resolution is 720x480 or 720x576, the camera’s onscreen displays will 
not be output.

• If you set an assignable button to [OSD Output: HDMI], you can press the button to turn the camera’s 
onscreen displays on and off.

Changing the Opacity Level of Onscreen Displays
You can make onscreen displays more visible or less conspicuous by changing their opacity level. You can select 
to which screens to apply the opacity levels.

1 To change the visibility of onscreen displays on individual video outputs, select  > 
[¢ Monitoring Setup] > Desired [OSD Opacity:] setting > [On].

2 Select  > [¢ Monitoring Setup] > [OSD Opacity Level] > Desired option.
• The smaller the percentage the more transparent the onscreen displays.

3 Select  > [¢ Monitoring Setup] > [OSD Opacity: Appl. Screens] > [All] or [Only Rec/Playback 
Screens].
• You can apply the selected opacity level to all onscreen displays (including menus, etc.) or only to onscreen 

displays on the shooting and playback screens.

NOTES

• If you set an assignable button to one of the [OSD Opacity:] settings, you can press the button to change the 
opacity level of onscreen displays on the corresponding video outputs.
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Selecting the Output Range
You can select the output range of video signals (when using log gamma or PQ/HLG HDR) output from the HDMI 
OUT terminal to determine how the image levels are mapped to code values. Moreover, you can select the 
setting independently for Canon Log output and for HDR output.

Applied output range settings

1 Select  > [¢ Monitoring Setup] > [Range: HDMI].

2 Select [During Canon Log Output] or [During HDR Output] > Desired option.

Options
[Full Range Priority]:

The signal output will use full range coding whenever possible but will change the range 
automatically according to the capabilities of the connected monitor.

[Narrow Range]:
The signal output will use narrow range (video range) coding.

NOTES

• During playback, the applied range is determined according to the gamma used at the time of recording.

Custom picture file Applied range settings

[Gamma] [Look File]
[Gamma/Color Space] 

after the Look File is applied
 > [¢ Monitoring Setup] > [Range: HDMI]

[Canon Log 2]
[Off] –

[During Canon Log Output]
[On] [Conform to Custom Picture]

[Canon Log 3]
[Off] –

[On] [Conform to Custom Picture]

[PQ]
[Off] –

[During HDR Output]
[On] [Conform to Custom Picture]

[HLG]
[Off] –

[On] [Conform to Custom Picture]

[BT.709 Wide DR]
[Off] –

–
(Fixed narrow range)

[On] [Conform to Custom Picture]

[BT.709 Normal]
[Off] –

[On] [Conform to Custom Picture]

– [On]

[SDR BT.709]

[SDR BT.2020]

[HDR PQ(BT.2100)]
[During HDR Output]

[HDR HLG(BT.2100)]
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Applying a LUT to the LCD Screen
While recording using special gamma curves, you can apply a LUT to the image displayed on the LCD screen. 
When a LUT is applied, the displayed image will look as if a standard gamma curve were used, making it easier 
to check the image on the display device used. Whether or not a LUT can be used and the available LUTs 
depend on the [Gamma/Color Space] and [Look File] settings in the custom picture file (A 111).

List of LUTs

Available LUTs

Available LUTs (when not using a Look File)

Applied LUT

Output settings 
with LUT applied Description

Gamma curve Color space

[BT.709]
BT.709 

Wide DR
BT.709

LUT for viewing on the LCD screen.

[HDR Assist. (1600%)] Original 
gamma curve

BT.709
LUT for viewing HDR (high dynamic range) images. The LUT follows the ITU-R 
BT.2100 transfer function to convert a brightness range of 1600% or 400% 
respectively into a linear brightness scale.[HDR Assist. (400%)]

Custom picture file Available LUT

[Look File]
[Gamma/Color Space] 

after the Look File is applied
[BT.709] [HDR Assist. (1600%)] [HDR Assist. (400%)]

[Off] –
See the following table.

[On]

[Conform to Custom Picture]

[SDR BT.709] – – –

[SDR BT.2020] Ü – –

[HDR PQ(BT.2100)] Ü Ü Ü

[HDR HLG(BT.2100)] Ü – Ü

[Gamma/Color Space]
Available LUTs

[BT.709] [HDR Assist. (1600%)] [HDR Assist. (400%)]

[Canon Log 2 / C.Gamut], [Canon Log 3 / C.Gamut] Ü Ü Ü

[Canon Log 3 / BT.2020] Ü Ü Ü

[Canon Log 3 / BT.709] Ü – –

[PQ / BT.2020] Ü Ü Ü

[HLG / BT.2020] Ü – Ü

[BT.709 Wide DR / BT.2020] Ü – –

[BT.709 Wide DR / BT.709], [BT.709 Normal / BT.2020], 
[BT.709 Normal / BT.709]

– – –
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1 Select  > [¢ Monitoring Setup] > [LUT: LCD] > [On].
• The LUT is applied and the gamma curve and color space of the displayed image will change.
• You can also use direct touch control (A 49).

2 Select  > [¢ Monitoring Setup] > [LUT Selection: LCD] > Desired LUT.

NOTES

• If you set an assignable button to [LUT: LCD] (A 105), you can press the button to turn the selected LUT on 
and off.

• The LUT will be temporarily disabled when you select  > [A Assistance Functions] > [False Color: 
LCD] > [On].

• When applying one of the HDR assistance LUTs, the  > [¢ Monitoring Setup] > [LCD Brightness] and 
[LCD Contrast] settings are reset to their default value, and [LCD Luminance] is set to [+2].

Adjusting the Gain Difference When Converting HDR to SDR
When the video displayed on the screen or recorded as a proxy clip is set to HDR* and a LUT is applied, you can 
adjust the difference in gain between the SDR output relative to the HDR image (±7.5 dB in 0.5 dB intervals).
* When the [Gamma/Color Space] setting in the custom picture file is set to [PQ / BT.2020] or [HLG / BT.2020], or when the 

[Gamma/Color space] setting after applying a Look File is set to [HDR PQ (BT.2100)] or [HDR HLG (BT.2100)].

Select  > [¢ Monitoring Setup] > [Gain for HDR�SDR Conv.] > Desired option.
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Audio Output Channels
The camera can output audio from the HDMI OUT terminal, × (headphone) terminal or speaker. When recording 
or playing back clips recorded with 4-channel audio, you can select which audio channels are output from the 
HDMI OUT terminal and headphones.

Audio output configuration

To select the audio channels for headphone output

Select  > [¡ Audio Setup] > [Monitor Channels] > Desired audio output option (L/R).
• Options like [CH1+2] indicate that two audio channels (CH1 and CH2 in this example) are mixed and output 

from the same side.

To select the audio channels for HDMI output

Select  > [¡ Audio Setup] > [HDMI OUT Channels] > [CH1/CH2] or [CH3/CH4].

Recorded audio configuration Audio output during recording/playback

Audio format Audio bit depth HDMI OUT terminal × (headphone) terminal

4-channel 
linear PCM

24 bit
2-channel 
linear PCM 

16 bit
2 channels
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Working with Files on a Computer
Canon offers software applications as free downloads that allow you to save on a computer files recorded with 
the camera.

Saving Files
Use Canon XF Utility to save and organize XF-AVC clips and other recorded files on a computer. You can use the 
Canon XF plugins to easily use XF-AVC clips directly from Avid non-linear editing (NLE) software. The software 
and plugins are available as free downloads from your local Canon website. Check the download page for the 
system requirements and latest information. 
You will find detailed instructions about installing and uninstalling the software in the "Read This First" file 
(Install-XF Utility.pdf) included in the compressed file you will download from the website. For details about using 
the software, refer to the instruction manual (PDF file) that is installed with the software.

Canon XF Utility (for Windows/macOS): Software application that allows you to save clips on a computer, 
check, play back and organize clips and grab still frames from clips.

Canon XF Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import clips 
from a card or a local folder in the computer to the compatible version of Avid Media Composer (an NLE 
application compatible with Avid Media Access), directly from within the application.

Saving MP4 Clips
Make sure to save clips recorded with this camera to a computer. To do so, you will need a card reader 
connected to a computer or a computer with an SD card slot. For details on transferring files from the SD card, 
refer to the computer’s instruction manual or OS’s help modules.
Under certain circumstances, clips may be split and recorded as separate files. Using MP4 Join Tool you can join 
the split files of and save them as a single seamless clip.

Transferring Files to a Computer

1 Insert an SD card with the desired clips into the SD card slot of the computer or card reader connected to the 
computer.

2 Follow the OS’s onscreen instructions.

3 Copy the clips on the SD card to the computer.
• Recordings on the SD card are located in folders named "XXX_mmdd" under the "DCIM" folder, where XXX 

is the folder number (100 to 999) and mmdd stands for the recording date (A 38).

Joining Clips Split by the Camera

Use MP4 Join Tool to join MP4 clips split by the camera in the following cases.
• When the camera switches to the other SD card while recording video due to the relay recording function 

(A 35).
• The video (stream) file in the clip will be split approximately every 4 GB.

MP4 Join Tool is available as a free download (for Windows or macOS) from your local Canon website. Check 
the download page for the system requirements and latest information.
You will find detailed instructions about installing and uninstalling the software in the "Read This First" file (Install-
MP4 Join Tool.pdf) included in the compressed file you download. For details about using the software, refer to 
the instruction manual (PDF file) that is installed with the software.
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Saving Audio Files (WAV)
Audio files in WAV format can be saved to a computer in the same way as MP4 files. Copy the desired audio files 
(located in the “/PRIVATE/AUDIO” folder of the SD card) to the computer.
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Network functions and connection types
To be able to use the following function networks, you will need to connect a commercially available Wi-Fi or 
Ethernet adapter* to the camera’s USB terminal. For more details about Wi-Fi or Ethernet adapters tested for 
use with the camera, visit your local Canon website.
* A Type-C (male) to Type-A (female) adapter/cable that is compatible with the same speed standard as the network adapter is 

necessary when using a network adapter with a Type-A connector.

1 Connection to a Wi-Fi network via an external access point (wireless router, etc.)
2 Direct connection to one Wi-Fi-enabled device where the camera serves as the Wi-Fi access point.

Before using the network functions
• The instructions in this chapter assume you already have a correctly configured and working network and 

correctly configured network device(s). If necessary, refer to the documentation provided with the network 
devices you plan to use.

• Configuring the network settings requires adequate knowledge about configuring and using wired (Ethernet) 
and/or wireless (Wi-Fi) networks. Canon cannot provide support regarding network configurations.

IMPORTANT

• Canon shall not be liable for any loss of data or damage resulting from incorrect network configuration or 
settings. Additionally, Canon shall not be liable for any loss or damage caused by the use of network functions.

• Avoid using open networks or networks without sufficiently strong security settings. Using an unprotected 
network can expose your data to monitoring by unauthorized third parties.

NOTES

• Do not open the card compartment cover while using network functions.
• Do not place cables connected to the camera’s HDMI OUT terminal, INPUT terminals or MIC terminal near the 

Wi-Fi adapter (commercially available). Doing so may negatively affect the wireless communication or the 
audio recorded.

• Connecting devices to the camera's USB terminal:
- When using a terminal converter or adapter cable, make sure to connect the converter to the Wi-Fi or 

Ethernet adapter before connecting both to the camera's USB terminal. If you plug in the converter or 
adapter cable to the terminal alone and only then connect the network adapter, it will not be recognized by 
the camera.

- Do not connect to the camera devices other than Wi-Fi or Ethernet adapters tested for use with the camera 
or the GP-E2 GPS Receiver.

Network function Description
Wired network 

(Ethernet)

Wi-Fi

A
Infrastructure1 Camera Access 

Point2

FTP File Transfer
Transfer clips recorded with the camera to 
another device connected to the network 
using the FTP protocol.

Ü Ü

Ü 153

IP Streaming
Stream the camera’s live video and audio over 
IP to a compatible IP video decoder connected 
to the network.

– 154

Browser Remote
Control the camera remotely from the Web 
browser of a connected device.

Ü 156
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Using a Wi-Fi Network
To use a Wi-Fi network, connect a commercially available Wi-Fi adapter to the camera’s USB terminal. For more 
details about the Wi-Fi adapter, refer to the manufacturer’s instruction manual.

Connecting

1 Turn off the camera.

2 Insert the Wi-Fi adapter into the camera’s USB terminal.
• If necessary, use a Type-C (male) to Type-A (female) adapter/cable.

Wi-Fi Connection Types

You can connect the camera in Infrastructure mode, using an access point (wireless router etc.), or in Camera 
Access Point mode, directly to a network device. The type of connection you can use, depends on the network 
function you wish to use (A 137).
For an Infrastructure connection, the camera offers 4 ways to configure an access point and the method you use 
will depend on the type and specifications of the access point and network you plan to use. 

Camera Access Point: When shooting in a location where there are no access points available, the camera can 
serve as a wireless access point*. Wi-Fi enabled devices will be able to connect to the camera directly.
* Limited only to the connection between the camera and supported Wi-Fi enabled devices. The functionality is not the same as 

that of commercially available access points. 

Infrastructure connection: 
WPS (button): If your wireless router supports Wi-Fi Protected Setup (WPS), setup will be 
easy and require minimal configuring and no passwords. To check if your wireless router 
has a WPS button and for details about how to activate the Wi-Fi protected setup, refer to 
the instruction manual of your wireless router.

WPS (PIN code): Even if your wireless router does not have a dedicated WPS button, it may support WPS using 
a PIN code instead. For setup using a PIN code, you will need to know in advance how to activate the wireless 
router’s WPS function. For details refer to the instruction manual of your wireless router.

Searching for Access Points: If your access point does not support the WPS function or you cannot activate it, 
you can have the camera search for access points in the area.

Entering the SSID and authentication method: Manually enter the SSID and other information about the access 
point.

IMPORTANT

• Depending on the country/region of use, some restrictions on outdoor use or Camera Access Point 
connections may apply when using the IEEE 802.11b/g/a/n/ac wireless standard. Check in advance the Wi-Fi 
adapter used (commercially available) and its applicable areas  of use and restrictions.

USB terminal

Wi-Fi adapter 
(commercially available)
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Using a Wired (Ethernet) Network
Connect a commercially available Ethernet adapter to the camera’s USB terminal to use a wired network with an 
Ethernet cable. Use Category 5e, shielded twisted pair (STP) Ethernet cables compatible with Gigabit Ethernet 
(1000BASE-T) and with good shielding capability. For more details about the Ethernet adapter and Ethernet 
cables, refer to the manufacturer’s instruction manual.

Connecting

1 Turn off the camera.

2 Insert the Ethernet adapter into the camera’s USB terminal.
• If necessary, use a Type-C (male) to Type-A (female) adapter/cable.

3 Connect an Ethernet cable to the Ethernet adapter and the desired network device.

USB terminal

Ethernet cable 
(commercially available)

Ethernet port on a 
network device

Ethernet adapter 
(commercially available)
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Configuring Connection Settings
To connect to a network you will need to define in advance a connection setting (SET), which is a combination of 
one or two communication settings (networks, NW) and one or two network function settings (MODE). You can 
save in the camera up to 25 individual communication settings and function settings, and up to 20 combinations 
of connection settings (SET1 to SET20).
To configure a connection setting for the first time, you will follow the setup wizard (A 141). Using the wizard, 
you can set up only one network and one function per connection setting. After having configured multiple 
connection settings, you can change them (for example to add a secondary network or second function) and 
you can create new ones combining existing communication and function settings (A 148).
If you configure a connection setting with both the [IP Streaming] and [Browser Remote] network functions, you 
will be able to use both functions simultaneously. 

Activating a Network Connection
Activate the desired network connection to use network functions or to configure the connection setting online.

1 Select  > [  Network Settings] > [Network] > [Enable].
•  will flash on the screen while the camera recognizes the Wi-Fi or Ethernet adapter.

2 When using connection settings that you saved previously, select  > [  Network Settings] > 
[Connect] > Desired connection setting ([SET1] to [SET20]) > [OK].
• To end the network connection, set [Connect] to [Disconnect] instead.

Configure the necessary connection settings for the networks and network functions 
you wish to use.

Select a connection setting appropriate for the network function you wish to use and 
start using the function.

FTP transfer (A 153)
IP streaming (A 154) 
Browser Remote (A 156) 

Step 1

Step 2

Connection setting (SET)

Communication 
Setting 1* (NW)

Communication 
Setting 2

Function 
Setting 1* (MODE)

Function 
Setting 2**

Wi-Fi

* Configured using the wizard.
** Only in CAMERA mode.

Ethernet

Camera Access Point
Infrastructure

WPS (push button)
WPS (PIN code)
Detected access points
SSID/authentication mode input

FTP transfer
IP streaming
Browser Remote
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Adding a New Connection Setting Using the Wizard
You can use the wizard to set up a new connection setting. This section uses a connection to a Wi-Fi network 
using the WPS push button method as an example. Refer to the instruction manual of the access point for 
details about the location and operation of the WPS button.

1 Enable the network functions (A 140).

2 Select  > [  Network Settings] > [New Conn. Setting (Wizard)] > Desired network function > 
[OK].

3 Select [Create New Comm. Setting].
• Once you have added multiple communication settings, you can select [Select Existing Setting] to reuse the 

settings for a network that you saved previously.

4 Select [Wi-Fi ].
• To configure a wired (Ethernet) network (A 144).

5 Select [Connect with WPS] > [WPS (Push Button)].
• To use a different configuration method, complete the corresponding procedure.

Camera Access Point (A 145)
WPS using a PIN code (A 145) 
Detected access points (A 146) 
SSID/authentication mode input (A 146) 
Manual setup without connecting to the network (A 147) 

6 Press and hold the WPS button on the wireless router and then, on the camera, select [OK].

7 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] > 
[Disable].
• To configure IPv4 settings manually (A 147).
• To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6 

settings as necessary (A 150).

8 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings.

FTP transfer (A 141), IP streaming (A 143), Browser Remote (A 144)

NOTES

• The [WPS (Push Button)] method may not work correctly depending on the devices used or the surrounding 
conditions. In such case try using [WPS (PIN Code)] (A 145) or selecting one of the detected networks 
(A 146).

Function Settings
FTP Transfer

This section continues the connection settings wizard (A 141). In the function settings you will configure the 
FTP server settings and other settings related to the handling of folders and files. If necessary, consult the 
network administrator in charge of the FTP server.

1 Select [Create New Func. Setting].
• Once you have added multiple function settings, you can select [Select Existing Setting] to reuse the 

settings for an FTP server that you saved previously.

2 Select the desired transfer mode.
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3 Configure the destination FTP server. Select [Server] and [Port No.] > [OK].
• Enter the FTP server’s IP address or host name using the keyboard screen. Enter the port number using the 

data entry screen (A 25). 
• Usually, the port number used is 21 (FTP or FTPS transfers) or 22 (SFTP transfers).
• Depending on the FTP mode selected in step 2, perform either step 4 or steps 4-5 and then continue to 

step 6.

SFTP transfers

4 Enter the user name and password for the SSH protocol’s authentication. Select [User Name] and [Password] 
> [OK].
• Enter the desired user name and password using the keyboard screen (A 25).

FTP/FTPS transfers

4 Select [Enable] to use passive mode or [Disable] to use active mode.
• In most cases, select [Disable].

5 Enter the user name and password for the FTP server. Select [User Name] and [Password] > [OK].
• Enter the desired user name and password using the keyboard screen (A 25).

All transfer modes

6 Select the destination folder on the server.

7 Select [OK]
• The function settings are saved to a [MODE] file.

8 Select the connection setting (SET1 to SET20) where to save the settings and then select [OK].
• The camera will connect to the network and will be ready to use the FTP transfer function (A 153).

Options for [FTP Mode]
[FTP]: Transfer method where the data is not encrypted.
[FTPS]: Secure transfer method using a root certificate (A 147).
[SFTP]: Secure transfer method using an SSH secure channel.

Options for [Destination Folder]
[Root Directory]:

Files are saved on the root directory of the destination FTP server.
[Select Folder]: Enter the desired path using the keyboard screen (A 25). If the folder does not exist on the 

destination FTP server, it will be created automatically.
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IP Streaming

This section continues the connection settings wizard (A 141). In the function settings you will configure the 
streaming video bit rate and resolution, the protocol used and the receiver’s settings. For details refer to the 
instruction manual of the decoder device or software you will use.

1 Select [Create New Func. Setting].
• Once you have added multiple function settings, you can select [Select Existing Setting] to reuse IP 

streaming settings that you saved previously.

2 Select the desired protocol.

3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].
• Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry 

screen (A 25).
• Using the default port number is recommended.
• Depending on the streaming protocol selected in step 2, perform step 4 if necessary and then continue to 

step 5.

[RTP+FEC] streaming

4 Configure the settings used to send FEC packets. Select [FEC Port No.] and [FEC Interval] > [OK].
• Enter the port number using the data entry screen (A 25).
• Using the default settings is recommended.

[RTSP+RTP] streaming

4 Enter the user name and password of the RTSP client. Select [RTSP: User Name] and [RTSP: Password] > 
[OK].
• Enter the desired user name and password using the keyboard screen (A 25).

All streaming protocols

5 Select the video streaming configuration.

6 Select the audio channels.

7 Depending on the resolution and frame rate, a screen may prompt you to change other settings. Change the 
settings as necessary.

8 Select [OK].
• The function settings are saved to a [MODE] file.

9 Select the connection setting (SET1 to SET20) where to save the settings and then select [OK].
• The camera will connect to the network and will be ready to start streaming.

10 Connect the decoder to the network and complete any necessary configurations on the receiving side so the 
decoder is ready to receive video over IP.

• To start streaming, refer to IP Streaming (A 154).

Options for [Protocol]
[UDP]: This protocol prioritizes transfer speeds but does not guarantee the reliability/integrity of the 

data. Lost or delayed IP packets are ignored.
[RTP]: Standard protocol for video/audio broadcasts over the Internet. Lost or delayed IP packets are 

ignored.
[RTP+FEC]: This setting uses the RTP protocol and adds a layer of FEC error correction so the receiving 

side* can recover lost or delayed IP packets.
[RTSP+RTP]: This setting uses the RTSP (real time streaming) protocol to control the streaming server 

(camera) in real time and the RTP protocol for the broadcast over IP. With the RTSP protocol, 
the receiver can control when to start and stop the broadcast.

* A decoder compatible with FEC error correction is required.
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Browser Remote

This section continues the connection settings wizard (A 141). A user name and password are required to log 
in to the Browser Remote application. In the function settings you will configure up to three different users for 
single-user or two-user operation.

1 Select [Create New Func. Setting].
• Once you have added multiple function settings, you can select [Select Existing Setting] to reuse Browser 

Remote settings that you saved previously.

2 Select the number of users.

3 Enter the user names and passwords as necessary. 
• Single user: Select [Full: User Name] and [Full: Password].

Two users: Select [Camera: User Name], [Camera: Password], [Meta: User Name] and [Meta: Password].
• Enter the desired user name and password using the keyboard screen (A 25).

4 Select [OK] twice.
• The function settings are saved to a [MODE] file.

5 Select the connection setting (SET1 to SET20) where to save the settings and then select [OK].
• The camera will connect to the network and will be ready to accept commands from the Browser Remote 

application (A 156).

Options for [User Setting]
[One User (Full)]:

A single user who can access all Browser Remote screens.
[Two Users (Camera/Meta)]:

You will set up two user names and passwords, one who can access the main Browser Remote 
screen to control the camera ([Camera]) and one who can access the metadata screen to 
update the user memo and GPS information ([Meta]).

NOTES

• The same user name cannot be set for both the [Camera] and [Meta] users.

Other Connection Methods
This section explains how to configure communication settings using methods other than the WPS push button.

Ethernet Settings

1 In the [Network Type] screen, select [Ethernet ].

2 Make sure the Ethernet cable is correctly connected (A 139) and select [Setup with Network Connection].
• Select [Setup without Network Connection] to only configure the settings, without connecting to the 

network.

3 Set the IP address (A 147).

4 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings.

FTP transfer (A 141), IP streaming (A 143), Browser Remote (A 144)
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Camera Access Point

Connect a network device with the camera’s access point. Two configuration methods are available: easy 
connection and manual connection.

1 In the [Select a network] screen, select [Camera Access Point Mode].

2 Select the configuration method.
• Depending on the selected method, perform either step 3 or steps 3-7 and then continue to step 8.

[Easy Connection]

3 The camera will assign the network name (SSID) and password automatically. Review the settings for the 
camera’s Wi-Fi access point and select [OK].
• These settings are necessary to connect a network device to the camera.

[Manual Connection]

3 Enter the SSID (network name) for the Camera Access Point and then select [OK].
• Enter the desired network name using the keyboard screen (A 25).

4 Select the Wi-Fi channel.
• Select [Automatic Setting] to have the camera select the channel automatically, or select [Manual Setting] > 

Desired channel.

5 Select the encryption settings.
• Select [AES] to use AES encryption, or [Disable] to use no encryption. 
• If you selected [Disable], skip to step 7.

6 Enter the password for the Camera Access Point and then select [OK].
• Enter the desired password using the keyboard screen (A 25).

7 Set the IP address (A 147).

Both configuration methods

8 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings.

FTP transfer (A 141), Browser Remote (A 144)

9 Before you can save the connection setting, connect the network device to the camera.
• Activate the device’s Wi-Fi function, select the camera’s SSID (network name) from the list and enter the 

password to connect to the camera.

WPS using a PIN Code

Connect to an access point using a PIN code. For most wireless routers, you must use a Web browser to 
access the setup screen. For details on how to set up the access point, refer to the access point’s user manual.

1 In the [Select a network] screen, select [Connect with WPS] > [WPS (PIN Code)].
• The camera will generate and display an 8-digit PIN code.

2 Enter the PIN code into the wireless router’s WPS (PIN code) setup screen and then, on the camera, select 
[OK].

3 Set the IP address (A 147).

4 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings.

FTP transfer (A 141), IP streaming (A 143), Browser Remote (A 144)
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Detected Access Points

The camera will automatically detect access points in the vicinity. After you select the desired access point, you 
only need to enter the selected network’s password to connect the camera. For details about the access point’s 
network name (SSID) and password refer to the wireless router’s instruction manual or consult the network 
administrator in charge of the access point.

1 In the [Select a network] screen, scroll through the list of detected networks and select the desired network.
• If the access point is encrypted, enter the password of the access point using the keyboard screen (A 25).

2 Set the IP address (A 147).

3 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings.

FTP transfer (A 141), IP streaming (A 143), Browser Remote (A 144)

SSID/Authentication Mode Input

You can connect to a specific access point by manually entering its details. For details about the access point’s 
network name (SSID) and password refer to the wireless router’s instruction manual or consult the network 
administrator in charge of the access point. 

1 In the [Select a network] screen, select [Enter SSID/Authentication Method].

2 Enter the SSID (network name) of the desired network and then select [OK].
• Enter the desired network name using the keyboard screen (A 25).

3 Select the network’s authentication method.
• If you select [Open System], select [Disable] (no encryption) and skip to step 6, or select [WEP] and continue 

the procedure.
• If you select [Shared Key] or [Open System] > [WEP], select the key index.

4 Enter the password of the desired network and then select [OK].
• Enter the desired password using the keyboard screen (A 25).

5 Set the IP address (A 147).

6 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings.

FTP transfer (A 141), IP streaming (A 143), Browser Remote (A 144)

A list of active networks detected in the vicinity 
will appear after the menu settings

Network name 
(SSID, only ASCII characters)

Encrypted access point
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Offline Configuration without Connecting to a Network

1 In the [Select a network] screen, select [Configure Offline].

2 Select the network type.
• If you select [Infrastructure], continue with the procedure to enter the SSID and authentication mode, from 

step 2 (A 146).
If you select [Camera Access Point Mode], continue from that procedure, from step 2 (A 145).

Configuring the Camera’s IP Address

This section explains how to configure the IP address. Available settings will change depending on the network 
function selected.

1 Select the method used to configure IPv4 settings, [Automatic Setting] or [Manual Setting].
• When using the wizard to add a new connection setting, make the selection in the [IP Address Settings 

(IPv4)] screen.
• If you select [Automatic Setting], skip to step 4.

[Manual Setting]

2 Select [IP Address] and [Subnet Mask] and enter the desired addresses using the data entry screen (A 25).
• To use a default gateway, select [Use Gateway] > [Enable] and then select [Gateway] and enter the address.
• To use a DNS address, select [Use DNS Address] > [Manual Setting] and enter the address.

3 Select [OK].

Both methods

4 Select whether to use TCP/IPv6 settings or not.
• To use IPv4 settings, select [Disable].
• To configure IPv6 settings (A 150).

Other Network Settings

Reading/Deleting a Root Certificate for FTP Transfer

When you use the [FTPS] transfer mode, you will need to read onto the camera the same root certificate saved 
on the FTP server. You can also check the content of a previously loaded root certificate or delete it.

1 Set the camera to MEDIA mode.

2 Save the desired root certificate file onto the root directory of a card and insert it into card slot B.

3 Select  > [  Network Settings] > [Advanced Settings] > [FTP Transfer Settings] > [Read Root 
Certificate] > [OK].
• The root certificate file is read from the card.
• After reading a root certificate file, you can select [Root Certificate Details] to check the certificate’s issuer 

and expiration date, or select [Delete Root Certificate] to delete the root certificate in the camera. 

NOTES

• Only one root certificate, with one of the following file names, can be read by the camera: “ROOT.CER”, 
“ROOT.CRT” and “ROOT.PEM”.

• If you transfer files using FTPS transfer with a self-signed certificate, you may not be able to trust the 
destination server.
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Giving a Nickname to the Camera

You can give the camera a nickname that is used on network connections and network devices to make it easier 
to identify.

Select  > [  Network Settings] > [Nickname].
• Enter the desired nickname using the keyboard screen (A 25).

Checking and Changing Connection Settings (SET)
You can check and, if necessary, change the settings of connection settings (SET) registered in the camera. In 
addition to deleting and renaming connection settings, you can also add to a connection setting a secondary 
network or second function.

Checking the Content of a Connection Setting

Select  > [  Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20]) 
> [Check Settings].
• The detailed content of the connection setting is displayed.
• Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to 

return to the menu.

Changing Settings using the Wizard

1 Select  > [  Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to 
[SET20]) > [Change with Wizard].

2 Select the desired network function and then follow the wizard as described in the previous procedure (from 
step 3, A 141) and make any changes as necessary.

Changing Connection Settings using Existing Settings

You can use previously registered communication settings ([NW] files) or function settings ([MODE] files) to easily 
replace the content of a connection setting or to add a second network or network function in addition to those 
registered using the wizard.

1 Select  > [  Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to 
[SET20]) > [Select Existing Setting].

To add/replace a communication or function setting

2 Select the setting you want to change > [Select Existing Setting] > Desired NW or MODE file.
• In the list of communication settings and function settings registered in the camera, only those that can be 

selected will be displayed in white and others will be grayed out. 

3 Select [Set].
• If necessary, select [Check Comm. Settings] or [Check Function Settings] to check the content of the 

selected file before making the change.

To delete a communication or function setting

2 Select the setting you want to remove > [Clear Selected] > [OK].
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NOTES

• A connection setting can have two communication settings (primary/secondary network) and up to two 
function settings (only for [IP Streaming] and [Browser Remote]).

• If both communication settings are deleted, the connection setting itself will be reset and will appear as 
[Unspecified].

Renaming Connection Settings

You can rename connection setting (SET) files to make them easier to identify from the list.

Select  > [  Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20]) 
> [Settings Name].
• Enter the desired name (up to 12 characters) using the keyboard screen (A 25).

Deleting Connection Settings

Select  > [  Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20]) 
> [Delete Settings] > [OK].
• The connection setting will be deleted.

NOTES

• Even if you delete a connection setting, the individual communication/function settings stored in it are not 
deleted. You can reuse these settings to configure other connection settings.

Checking and Changing Communication Settings (NW)/Function Settings (MODE)
You can check the content of communication settings ([NW] files) and function settings ([MODE] files) saved in 
the camera and change or delete them as necessary.

Checking the Content of a Communication Setting/Function Setting

1 Select  > [  Network Settings] > [Advanced Settings] > [Communication Settings] or [Function 
Settings].

2 Select the desired communication setting ([NW1] to [NW25]) or function setting ([MODE1] to [MODE25]).

3 Select [Check Settings].
• The detailed content of the selected setting is displayed.
• Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to 

return to the menu.

Changing/Deleting Communication Settings/Function Settings

1 Select  > [  Network Settings] > [Advanced Settings] > [Communication Settings] or [Function 
Settings].

2 Select the desired communication setting ([NW1] to [NW25]) or function setting ([MODE1] to [MODE25]).

3 Select [Change Settings] and change the various settings as necessary.
• If in step 2 you selected an [Unspecified] settings file, the only option available is [Create New with Wizard] 

(A 141).
• Select [Delete Settings] > [OK] to delete the communication setting/function setting.
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Configuring TCP/IPv6 Settings
If in the wizard you selected [Enable] to use IPv6 settings, change the settings as necessary after completing the 
wizard.

1 After step 3 in the previous procedure, select [TCP/IPv6] > [TCP/IPv6 Settings] > [Enable].
• This step is not necessary if you selected [Enable] when you used the wizard to add a new connection 

setting.
• Continue the procedure to change the default IPv6 settings.

2 To configure the IPv6 settings manually, select [Manual Setting] > [Enable].
• [DNS Server] changes to [Manual Setting].

3 Select [DNS Server] > Desired option.
• If you selected [Disable] in step 2, you can set [DNS Server] to [Auto Assign].
• When not using a DNS server, select [Disable].

4 If you set [DNS Server] to [Manual Setting] in step 3, configure the [DNS Address].
• Enter the IP address using the data entry screen (A 25).

When [Manual Setting] is set to [Enable]

5 Select [Manual Address] (manually entered IPv6 address), [Prefix Length] (bits available for the network 
address) and [Gateway] (gateway’s IP address) and enter the necessary information.
• Enter the IP addresses and prefix length using the data entry screen (A 25).

Individual settings available for manual change (communication settings)

Menu item Setting options and additional information

[Wi-Fi]

[SSID] –

[Advanced Settings] [Authentication Method], [Password]

[TCP/IPv4]

[IP Address Settings]* [Automatic Setting], [Manual Setting]

[DNS Server] [Disable], [Auto Assign], [Manual Setting]

[DNS Address]*, [IP Address]*, 
[Subnet Mask]*, [Gateway]*

[TCP/IPv6]

[TCP/IPv6 Settings]* [Disable], [Enable]

[Manual Setting] [Disable], [Enable]

[DNS Server] [Disable], [Auto Assign], [Manual Setting]

[DNS Address], 
[Manual Address], 
[Prefix Length], [Gateway]

Enter the desired address using the data entry screen (A 25).
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Individual settings available for manual change (function settings)

* Change these settings as explained in the wizard (A 141).

Changing Browser Remote Settings

1 Select  > [  Network Settings] > [Advanced Settings] > [Browser Remote Settings].

2 Change the various settings as necessary.
• You can select [Port No. (HTTP)] or [Port No. (HTTPS)] to change the port numbers used for each 

connection. Using the default port numbers (HTTP: 80, HTTPS: 443) is recommended.
• To use an HTTPS connection, select [HTTPS] > [Enable].

To use a secure HTTPS connection, use a Camera Access Point connection setting and connect the 
network device to the camera using a normal HTTP connection (A 156) and download the necessary 
certificate from the Browser Remote’s settings tab (A 161). After you import the certificate you 
downloaded to your Web browser, you will be able to use a secure HTTPS connection.

Menu item Setting options and additional information

[FTP Transfer]

[Destination Server]

[Server]*, [Port No.]*

[User Name/Password]

[User Name]*, 
[Password]*

[Destination Folder]*

[Dest. Folder Structure] [Default], [Camera]

[Overwrite Files] [Skip], [Save As (New Name)], [Overwrite]

Determines how to deal with files to be transferred when files with the same name already exists in the 
destination folder.
[Skip]: The file will not be transferred.
[Save As (New Name)]: The file will be transferred and “_1” will be added to the end of the file name.
[Overwrite]: The file will be transferred, overwriting any file with the same name on the FTP server.

[Passive Mode]* [Disable], [Enable]

[New Folder by Date] [Enable], [Disable]

[Enable]: A new subfolder under the transfer destination folder “YYYYMMDD\HHMMSS” will be created for every 
transfer operation.
[Disable]: All the files will be transferred to the folder specified for the [Destination Folder] setting.

[IP Streaming]

[Protocol]* [UDP], [RTP], [RTP+FEC], [RTSP+RTP]

[Destination Server]*, 
[Dest. Port No.]*,
[FEC Port No.]*

[FEC Interval] 10 to 100 (intervals of 5)

[RTSP: User Name]*, 
[RTSP: Password]*

[Video Output Conf.]* [9Mbps/1920x1080 59.94P], [4Mbps/1920x1080 59.94P], [9Mbps/1920x1080 50.00P], 
[4Mbps/1920x1080 50.00P], [9Mbps/1920x1080 59.94i], [4Mbps/1920x1080 59.94i], 
[9Mbps/1920x1080 50.00i], [4Mbps/1920x1080 50.00i],

[Audio Out Channels]* [CH1/CH2], [CH3/CH4]
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Checking the Network’s Status
Unless you selected to configure a connection setting offline (without connecting to the network), immediately 
after configuring a new connection setting, the camera will connect to the network automatically and the 
selected function settings will be activated. The icons displayed on the screen will indicate the type of network 
selected and the connection status. When you disable the network functions or disconnect from the network, 
the icons will disappear.

Network connection icons
 Wi-Fi  (Infrastructure): 

In yellow – the camera is connecting to or disconnecting from the network. In white – the 
network function can be used.

 Wi-Fi  (Camera Access Point): 
In yellow – starting the camera’s access point. In white – the camera’s access point is ready. 
Connect the Wi-Fi enabled device to the camera.

 Ethernet: In yellow – the camera is connecting to or disconnecting from the network. In white – the 
network function can be used.

Network function icons
: FTP file transfer (A 153)
: IP streaming (A 154)

: Browser Remote (A 156)

Others
: Recognizing the Wi-Fi or Ethernet adapter.
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FTP File Transfer
In MEDIA mode, you can transfer clips from the camera to another device connected to the network, using the 
FTP protocol.
The following explanations assume that the FTP server is on, ready and correctly configured.

Transferring a Single Clip
1 Connect the camera to the desired network and activate the network functions (A 140).

• Select a connection setting with the [FTP Transfer] function setting.

2 Select the desired clip in the [XF-AVC] or [MP4] index screen (A 119).

3 Press SET to open the file menu and select [FTP Transfer] > [OK].
• The camera will connect to the FTP server and the file will be transferred.
• Select [Cancel] to interrupt the file transfer in progress.

Transferring All Clips
1 Connect the camera to the desired network and activate the network functions (A 140).

• Select a connection setting with the [FTP Transfer] function setting.

2 Open the [XF-AVC] or [MP4] index screen (A 119).

3 Select  > [  Network Settings] > [FTP Transfer All Clips] > [OK].
• The camera will connect to the FTP server and all the files will be transferred.
• Select [Cancel] to interrupt the file transfer in progress.

IMPORTANT

• Observe the following precautions when transferring files. Failing to do so may interrupt the transfer and 
incomplete files may remain at the transfer destination.
- Do not open the card compartment cover.
- Do not remove the power source or turn off the camera.

• If incomplete files remain at the transfer destination, check the content and make sure they are safe to delete 
before deleting them.

NOTES

• Depending on the access point’s settings and capabilities, it may take some time to transfer files.
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IP Streaming
In CAMERA mode, you can stream the camera’s live video and audio over IP to a compatible IP video decoder* 
connected to the network. You can use IP streaming for live broadcasts or to send video reports from a location 
with poor network connectivity.
* This can be a dedicated video transfer device or decoder software on a computer. For details about compatible decoders, 

please visit your local Canon website.

Configuration of video streamed over IP

* When the audio of the primary clip uses 4 channels, you can select which channels to stream over IP.

1 On the receiver’s side: Connect the decoder to the network and complete any necessary 
configurations so it is ready to receive video over IP.
• For details refer to the instruction manual of the decoder device or software you will use.

2 On the camera: Connect the camera to the desired network and activate the network functions 
(A 140).
• Select a connection setting with the [IP Streaming] function setting.

3 Select  > [  Network Settings] > [Activate IP Streaming] > [Enable].
• The camera will start streaming video over the selected network.
• You can press the REC button to simultaneously record the same image in the camera.

4 On the receiver’s side: Only when the streaming protocol is [RTSP+RTP], access the following URL 
and log in using the RTSP user name and password (A 143). 

5 On the camera: To end the streaming, select  > [  Network Settings] > [Activate IP 
Streaming] > [Disable].

IMPORTANT

• Streamed data is not encrypted.

NOTES

• Except when the streaming protocol is [RTSP+RTP], once IP streaming is activated, the camera will continue 
to broadcast video and audio data over the network, regardless of the status of the receiver. Be careful to set 
up the correct IP address and test in advance that the receiving decoder can indeed receive the signals.

• Depending on the network used and the connection conditions, you may experience lost or delayed IP 
packets.

• After streaming continuously for 24 hours, the camera will stop the IP streaming momentarily and then restart 
it automatically.

• When using IP streaming together with the Browser Remote function, you may experience stuttering issues in 
the streamed video or audio. When the two functions are used simultaneously, it is recommended not to log 
out from/reconnect to Browser Remote.

Main recording video configuration Streamed video configuration

Video format Resolution Frame rate
Video Audio

Bit rate Resolution Frame rate Audio format Bit rate

XF-AVC,
MP4 (H.264)

3840x2160,
1920x1080

59.94P

4 Mbps,
9 Mbps

1920x1080

59.94P, 59.94i

MPEG-2 AAC
2 channels*

256 Kbps
59.94i 59.94i

50.00P 50.00P, 50.00i

50.00i 50.00i

rtsp://xxx.xxx.xxx.xxx/stream

Camera’s IP address
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• Opening the card compartment cover and removing a card while IP streaming is activated may cause brief 
stops in the streamed video and audio.

• IP streaming cannot be used in the following cases:
- When using a recording mode other than [Normal Recording].
- When [2nd Card Rec Functions] is set to an option other than [Off].
- When the system frequency is set to 24.00 Hz.



Browser Remote: Controlling the Camera from a Network Device

156

Browser Remote: Controlling the Camera from a Network Device
In CAMERA mode, you can operate the camera remotely using Browser Remote, an application that can be 
accesses on a connected network device. Using Browser Remote you can check the camera’s live image and 
control various recording settings*. You can also set and change metadata (only for XF-AVC clips) and check 
other important indications, such as remaining recording time on the card, remaining battery charge/power 
source details, time code, etc.
* White balance, ISO speed/gain, shutter speed, ND filter, aperture, focus and zoom.

Starting Browser Remote
After connecting the camera to the network In CAMERA mode, you can start the Browser Remote application 
on the Web browser* of any network device** connected to the same network.
* A Web browser that supports JavaScript and is enabled to accept cookies is required.
** For details about compatible devices, operating systems, Web browsers, etc., please visit your local Canon website.

Preparations on the Camera

1 Connect the camera to the desired network and activate the network functions (A 140).
• Select a connection setting with the [Browser Remote] function setting.

2 Check the Browser Remote’s URL in the [  Network Settings] status screen (A 181).
• When using IPv6 settings, check the camera’s IP address instead (A 180).
• Write down the URL or IP address if necessary.

On the Network Device

1 Connect the network device to the camera or to the same access point as the camera.

2 Start the Web browser on the network device.

3 Enter Browser Remote’s URL.
• Enter the URL / IP address you checked previously into the Web browser’s address bar as follows.

• To use an HTTPS connection, enter "https:" instead of "http:".
• When using IPv6 settings, enter the camera's IPv6 IP address instead.

4 Enter the user name and password.
• Be sure to log in with the user name and password of one of the 

users that were set on the camera (A 144). If necessary, consult 
the administrator who configured the camera’s settings.

• The Browser Remote screen will appear. The screen displayed may 
be different depending on the user information used to log in.

5 To change the application’s language, select [ ] > [Language H] > 
Desired language.
• Most buttons and controls emulate physical controls on the camera 

and are labeled in English only, regardless of the language selected.

6 Use the Browser Remote controls to operate the camera.
• Descriptions of the controls are given in the following pages.

http://xxx.xxx.xxx.xxx:nnn

Camera’s IP address Port No. (can be omitted when using the default port no.)

Example of the login screen. The screen may 
differ depending on the Web browser and 
version used.
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7 When you have finished using Browser Remote, select [ ] > [Log Out] on the Browser Remote screen to end 
the application.

NOTES

• Depending on the network used and the connection performance, you may notice delays in the refreshing of 
the live view image and other settings. If the delay is too long, changing the resolution of the live view image is 
recommended (A 161).

• If Browser Remote is set to a language other than the language set on the network device, the application may 
not be displayed correctly.
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Using Browser Remote
The Browser Remote application has two screens: [v] the main screen for controlling the camera remotely in 
recording mode and [ ] the metadata screen. The screen displayed will be different depending on the user 
information used to log in.

NOTES

•  Browser Remote does not support multi-touch gestures.

The Main Remote Operation Screen [v] ([Full]/[Camera] user only)

1 [Zoom] button
Touch to display the zoom slider.

2 Zoom slider
When [Zoom] is active, drag the slider up/down to adjust the zoom.
• When using a slow zoom speed, it may take some time until the lens starts moving.

3 Manual focus controls
When [Focus] is active, touch [ ], [ ] or [ ] to focus closer or [ ], [ ] or [ ] to focus farther. There are 
three levels of adjustment - [ ]/[ ] is the smallest and [ ]/[ ] the largest. Keep touching the button (long 
press) for a continuous operation.

4 [Focus] button
Touch to display the manual focus controls.

5 Camera’s nickname (A 148)

6 Lens information

12 1314 15 165 7 8 9 10 116

28

34 37 42 433635 4440 413938

29 32 3330 31

1

4

26

27

2

17
18
19
20
21
22
23
24
25

3



159

Browser Remote: Controlling the Camera from a Network Device

7 Live view screen
Shows the camera’s live view image.

8 Browser Remote screen selection ([Full] user only)
Touch [v] to open the main remote recording screen, or [ ] to open the metadata screen (A 161).

9 ISO speed/Gain mode (automatic/manual)

10 Shutter mode

11 Aperture mode (automatic/manual)

12 Detailed camera settings (A 160)
Detailed settings for ND filter, aperture, ISO speed/gain and AF operations.

13 White balance mode

14 [AWB Lock] button / Å (register white balance) button
When the white balance mode is set to , touch to lock the current white balance settings. Touch again to 
resume the automatic white balance (AWB).
When the white balance mode is set to ÅA or ÅB, touch to register a custom white balance.

15 Key lock button
Touch the icon to lock the Browser Remote screens in order to prevent settings from being changed 
inadvertently. Controls on the camera are not locked.

16 Browser Remote settings (A 161)

17 ND filter

18 Aperture value

19 Shutter speed

20 ISO speed/gain value

21 AE shift

22 Color temperature

23 Color compensation (CC) value

24 Face AF function
Touch to select the Face AF mode (A 75).

25 AF speed

26 [LIVE VIEW] button
Touch the button to display the camera’s live view image on the Browser Remote screen.

27 [D Touch Focus] button
Touch the button to unlock (enable) the touch focus mode.

28 Add a shot mark

29 IP streaming
Available only when using a connection setting with both the [Browser Remote] and [IP Streaming] function 
settings.

30 Card selection and approximate remaining recording time

31 Status indicators
: Network connection indicator. While Browser Remote is correctly connected to the camera, the 

dots will keep turning on and off in a loop.
4: Appears during double slot recording (A 35).
è, etc. : Remaining battery charge / Power supply level (A 45)



Browser Remote: Controlling the Camera from a Network Device

160

32 [Focus Guide] button
Touch to display the focus guide (A 70).

33 [ONE-SHOT AF] button / [AF Lock] button
When the AF mode (A 160) is set to [One-Shot], touch to focus automatically once.
When the AF mode is set to [Continuous] or [AF-Boosted MF], touch to lock the current focus. Touch again 
to resume the previous focus mode.

34 Add an $ mark

35 Add a % mark

36 [REC] button
• Touch the button to start recording. The recording operation indicator changes to [ÜREC] and the center 

of the button turns red.
• The time code will advance while recording.
• Touch the button again to stop recording. The recording operation indicator changes back to [STBY].

37 [SLOT SELECT] button
Touch to select the other card when both card slots contain a card.

38 Recording operation (A 45) and recording command (A 166) (same as on the camera)

39 Main recording format (A 53)

40 Time code (same as on the camera)

41 [Tracking] button (A 76) 

42 Cancel the tracking function

43 [PUSH AUTO IRIS] button
Touch to have the camera adjust the aperture automatically once.

44 [Face Detection] button** (A 75) 

h Detailed Camera Settings Tab

1 ND extended range

2 Aperture increment

3 Fine aperture adjustment
Fine adjustment lets you use the smallest aperture increment allowed by 
the lens. (The aperture value displayed will be the closest value in the 
selected increment scale.)

4 Shutter speed increment

5 ISO speed/gain selection

6 ISO speed/gain increment

7 ISO speed/gain extended range

8 AF mode

9 AF frame position

1
2
3
4

6
5

7
8
9
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 Browser Remote Settings Tab

1 Language selection
Changes the language used for controls in the [ ] (metadata input) screen 
and for error messages. Still, most of the application’s controls emulate 
physical buttons on the camera and appear in English only, regardless of 
the language selected. 

2 Display style
Touch to select the background color of the Browser Remote screens.

3 Secured connection
Touch to download the certificate required to use a secure HTTPS 
connection.

4 Live view resolution
Select [Large] (higher resolution) or [Small] (lower resolution) depending on the quality of the connection.

5 Log out
Touch to log out from the Browser Remote application.

The Metadata Screen [ ] ([Full]/[Meta] user only)

Using Browser Remote you can create, edit and transfer to the camera a metadata profile that can be 
embedded with the recorded clips. This metadata profile includes the user memo information (clip title, creator, 
location and description), as well as GPS information. For details, refer to Using Metadata (A 98).

To open the metadata screen, touch the [ ] icon at the top of the Browser Remote screen.
• This step is not necessary when logging in with the user name and password of the [Meta] user.

1 User memo information

2 GPS information

1
2
3
4
5

4 5 6 73

2

1
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3 [  Activate] button 
• Touch the button to give priority to the metadata entered in this screen when recording clips. This overrides 

the metadata read from a file saved on the SD card.
• Alternatively, on the camera, you can set  > [Æ Recording/Media Setup] > [Metadata] > [Setting] 

to [Remote].

4 [Overwrite Previous] button
Send the user memo information from the application, overwriting the metadata of the last clip recorded.

5 [Apply from Next] button
Send the user memo information from the application to the camera to be used in clips recorded after that. 
(Does not overwrite the metadata of already recorded clips.)

6 [Overwrite] button
Send the user memo information from the application, overwriting the metadata of the clip currently being 
recorded.

7 [Clear All] button
Touch to delete all the data entered.

NOTES

• The metadata sent to the camera from Browser Remote will be lost in the following cases.
- The camera is turned off.
- The  > [Æ Recording/Media Setup] > [Metadata] > [Setting] setting was changed.

• Using Browser Remote ([  Activate] button) you can give priority to metadata sent from the application. 
However, you cannot return the priority back to the SD card. To use a user memo file saved on a card you will 
need to set  > [Æ Recording/Media Setup] > [Metadata] > [Setting] to [SD Card] on the camera itself.

• If you use Browser Remote to transfer user memo information to a relay clip after the switch, the user memo 
will not be recorded with the metadata of the clip recorded before the camera switched cards.
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Additional Information

Menu Options
For details about how to select an item, refer to Using the Menus (A 23). For details about each function, see 
the reference page or the explanation accompanying the menu entry. Setting options in boldface indicate default 
values.
Depending on the camera’s operating mode and the settings, some menu items may not be available. Such 
menu items do not appear or appear grayed out in menu screens.

To skip directly to the page of a specific menu:

[v Camera Setup] menu (CAMERA mode only)

[v Camera Setup] menu A 163
[/ Custom Picture] menu A 164
[Æ Recording/Media Setup] menu A 165
[¡ Audio Setup] menu A 166
[¢ Monitoring Setup] menu A 167

[A Assistance Functions] menu A 169
[  Network Settings] menu A 170
[  Assignable Buttons] menu A 170
[B System Setup] menu A 171
[¥ My Menu] customized menu A 172

Menu item Setting options and additional information

[Iris Mode] [Automatic], [Manual] (A 62)

This setting is available only when a compatible lens (A 203) is attached to the camera.

[Iris Increment] [1/2 stop], [1/3 stop] (A 62)

[Fine Increment] [On], [Off]

[Zoom-Iris Correction] [On], [Off]

If you are using a compatible lens, when this setting is set to [On], the camera will adjust as needed to 
keep the selected aperture value while zooming. Because of this adjustment, the brightness of the image 
might flicker slightly or you may hear the operation sound. When the setting is set to [Off], there will be no 
flickering or operation sounds but the aperture value will gradually increase (the picture will get darker) as 
you zoom.

[Extended ND Range] [On], [Off] (A 61)

[Shutter Mode] [Speed], [Angle], [Clear Scan], [Slow], [Off] (A 57)

[Shutter Increment] [1/3 stop], [1/4 stop]

[ISO/Gain] [ISO], [Gain] (A 59)

[ISO/Gain Mode] [Automatic], [Manual] (A 60)

[ISO/Gain Extended Range] [On], [Off] (A 59)

[ISO Increment] [1 stop], [1/3 stop]

[Gain Increment] [Normal], [Fine]

[Limit for Auto Mode] When [ISO/Gain] is set to [ISO]:
ISO 320 to [Off/ISO 102400] in 1/3 stop intervals ([Off/ISO 25600])

When [ISO/Gain] is set to [Gain]:
4 dB to [Off/54 dB] in 3 dB intervals ([Off/42 dB])

(A 60)

[Light Metering] [Backlight], [Standard], [Spotlight] (A 65)

[AE Shift] –2.0 to +2.0 in 0.25 point intervals (±0) (A 65)

[AE Response] [High], [Normal], [Low] (A 64)

Determines how quickly the exposure (aperture, shutter speed and gain) changes when using the 
automatic adjustment mode. 

[Shockless WB] [On], [Off] (A 66)
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* The default value depends on the country/region of purchase.

[/ Custom Picture] menu (CAMERA mode only)

[AWB Response] [High], [Normal], [Low] (A 68)

[C. Temp. Increment] [Mired], [Kelvin] (A 66)

[AF Mode] [One Shot], [AF-Boosted MF], [Continuous] (A 69)

[AF Frame] [Large], [Small] (A 75)

[AF Frame Position] [Selectable], [Center Frame]

[AF Speed] –7 to +2 (0) (A 73)

[AF Response] –3 to +3 (0)

[Focus Mode] [AF], [MF] (A 69)

[Face Det. & Tracking] [On], [Off] (A 75)

[Face AF] [Face Priority], [Face Only]

[Camera Grip Zoom] [On], [Off] (A 79)

[Camera Grip Zoom Speed] 1 to 16 (8)

[ABB] – (A 40)

[Color Bars] [On], [Off] (A 94)

[Color Bar Type] [SMPTE], [EBU]*, [ARIB]

[Periph. Illum. Corr.], 
[Chromatic Aberr. Corr.],
[Diffraction Correction],
[Distortion Aberr. Corr.]

[On], [Off] (A 28)

[EF-S Lens] [On], [Off] (A 26)

If peripheral brightness fall-off or vignetting occurs when using an EF-S lens, you can set [EF-S Lens] to 
[On] to slightly crop the imaging area. The image is enlarged digitally by a factor of about 1.04x, affecting 
image quality. In most cases, leaving the [Off] option is recommended.

[Digital IS], [Super16 Digital IS] [On], [Off] (A 78)

[Lens Focal Length] 1 to 1000 (50)

[Anamorphic Corr.] [Lens Squeeze Factor], [x2.0], [x1.3], [Off]

Menu item Setting options and additional information

[Select / File] [C1: BT.709], [C2: LOG2], [C3: LOG3], [C4: PQ], [C5: HLG],
[C6: USER06] to [C20: USER20]

(A 109)

[Edit / File]

[Rename] – (A 110)

[Protect] [Unprotect], [Protect]

[Reset] [BT.709], [LOG2], [LOG3], [PQ], [HLG], [USER (BT.709)]

Detailed custom picture 
settings

Refer to the tables in the Available Custom Picture Settings section. (A 113)

[Save / File] (A 112)

[Copy to SD Card B], 
[Load from SD Card B]

–

Menu item Setting options and additional information
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[Æ Recording/Media Setup] menu

Menu item Setting options and additional information

[Initialize Media] [SD Card A], [SD Card B] (A 32)

[Sensor Mode] [Super 35mm], [Super 16mm (Cropped)] (A 53)

[System Frequency] [59.94 Hz], [50.00 Hz]1, [24.00 Hz] (A 53)

[Main Rec Format] [XF-AVC YCC422 10 bit], [MP4(HEVC) YCC422 10 bit], [MP4(HEVC) YCC420 10 bit], 
[MP4(H.264) YCC420 8 bit]

(A 53)

[Main Resolution/Bit Rate] XF-AVC: 
[4096x2160 Intra-frame], [4096x2160 Long GOP], [3840x2160 Intra-frame], 
[3840x2160 Long GOP], [2048x1080 Intra-frame], [2048x1080 Long GOP],
[1920x1080 Intra-frame], [1920x1080 Long GOP], [1280x720 Long GOP]

MP4:
[4096x2160], [3840x2160], [2048x1080], [1920x1080], [1280x720]

(A 53)

Available options vary depending on the sensor mode and frame rate. 
The bit rate is affected by the selected resolution, frame rate and other factors. After you make the 
selection, the automatically determined bit rate will be shown next to this menu item.

[Frame Rate] When [System Frequency] is set to [59.94 Hz]:
[59.94i]*, [59.94P]1, [29.97P], [23.98P]

When [System Frequency] is set to [50.00 Hz]:
[50.00i]*, [50.00P]1, [25.00P]

When [System Frequency] is set to [24.00 Hz]:
[24.00P]

* XF-AVC clips only. Not available when slow & fast motion recording is activated.

(A 53)

Available options vary depending on the main resolution/bit rate.

[Main Audio Format (MP4)] [AAC 16 bit 2CH], [LPCM 16 bit 4CH] (A 88)

[Recording Mode] [Normal Recording], [Slow & Fast Motion], [S&F Clip / Audio (WAV)], 
[Pre-Recording], [ Main / Continuous Rec]

(A 35, 100)

[Slow & Fast Frame Rate] 12 to 180 (A 100)

Available options and default value vary depending on other settings. See the tables on the reference 
page.

[Continuous Recording] [REC], [STBY] (A 102)

[2nd Card Rec Functions] [Off], [ Main / Proxy Rec], [ Main / Sub Rec], [Relay Recording], 
[Double Slot Recording]

(A 35)

[Sub Rec Format] [XF-AVC YCC422 10 bit], [MP4(HEVC) YCC422 10 bit], [MP4(HEVC) YCC420 10 bit], 
[MP4(H.264) YCC420 8 bit]

(A 54)

Available options vary depending on the main recording format.

[Sub Resolution/Bit Rate] Main recording: XF-AVC, Sub recording [XF-AVC YCC422 10 bit]:
[4096x2160 Long GOP], [3840x2160 Long GOP], [2048x1080 Intra-frame], 
[2048x1080 Long GOP], [1920x1080 Intra-frame], [1920x1080 Long GOP],
[1280x720 Long GOP]

Main recording: XF-AVC, Sub recording [MP4(H.264) YCC420 8 bit]:
[4096x2160], [3840x2160], [2048x1080], [1920x1080], [1280x720]

Main recording: MP4, Sub recording [MP4(HEVC) YCC422 10 bit]:
[2048x1080], [1920x1080], [1280x720]

Main recording: MP4, Sub recording [MP4(HEVC) YCC420 10 bit]:
[4096x2160], [3840x2160], [2048x1080], [1920x1080], [1280x720]

Main recording: MP4, Sub recording [MP4(H.264) YCC420 8 bit]:
[2048x1080], [1920x1080], [1280x720]

(A 54)

Available options vary depending on the main recording’s video configuration.

[Sub Rec Frame Rate] [Same as Main Recording], [59.94i], [50.00i] (A 54)

[Sub Audio Format (MP4)] [AAC 16 bit 2CH], [LPCM 16 bit 4CH] (A 88)

[Proxy Rec Color Conversion] [Conform to Custom Picture], [BT.709] (A 56)
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1 The default value depends on the country/region of purchase.

[¡ Audio Setup] menu

[Metadata]

[Camera Index] [A] to [Z] (A 37)

[Reel Number], [Clip Number] [001] to [999]

[User Defined] User defined string up to 5 characters ([CANON]) (A 38)

[Scene], [Take] Scene description up to 16 characters / Take description up to 8 characters (A 99)

[Lens Squeeze] [x2.0], [x1.3], [Off] (A 103)

[Setting] [Remote], [SD Card] (A 98, 161)

[User Memo] [Off], list of available user memo files (A 98)

[Country Code], [Organization], 
[User Code]

Identifiers up to 4 characters ([00__] default for [Organization] only)

[Country Code]: This identifier is the country code defined by ISO-3166-1 and is to be entered starting 
from the left.

[Organization]: This identifier represents the organization that owns or operates the camera and can be 
obtained by registering with the SMPTE Registration Authority. If the organization is not registered, 
enter [0000].

[User Code]: This identifier designates the user. Leave this blank if [Organization] is set to [0000].

[Add / File] [On], [Off] (A 112)

[Clip Numbering] [Reset], [Continuous] (A 37)

[Rec Command] [On], [Off] (A 128)

When this setting is [On] and you connect the camera to an external recorder, if you start or stop recording 
with the camera, the external recorder will also start or stop recording. To output the recording command 
from the HDMI OUT terminal, you will need to set also [HDMI Time Code] to [On].

[HDMI Time Code] [On], [Off] (A 128)

[MP4 Clip/Photo Numbering] [Reset], [Continuous] (A 38)

[Volume Label] [Canon], [Canon + Metadata] (A 33)

Menu item Setting options and additional information

[Audio Input Selection]

[CH1/CH2], [CH3/CH4] [INPUT Terminals], [MIC Terminal], [Built-in Mic] (A 90)

[CH2 Input] [INPUT 2], [INPUT 1] (A 90)

[CH1/CH2 ALC Link], 
[CH3/CH4 ALC Link]

[Linked], [Separated] (A 91)

[Audio Rec Level CH3],
[Audio Rec Level CH4],
[Audio Rec Level CH3/CH4]

[Automatic], [Manual] (A 91)

[CH3 Level], [CH4 Level],
[CH3/CH4 Level]

0 to 100 (50)

[INPUT 1 Mic Trimming],
[INPUT 2 Mic Trimming]

[+12 dB], [+6 dB], [0 dB], [–6 dB], [–12 dB] (A 92)

[INPUT 1 Mic Att.], [INPUT 2 Mic Att.] [On], [Off] (A 92)

[INPUT Limiter] [On], [Off] (A 91)

[MIC Att.] [On], [Off] (A 92)

[MIC Low Cut] [On], [Off] (A 92)

[MIC Input] [MIC (with Power Supply)], [MIC], [LINE] (A 89)

[Built-in Mic Mode] [Normal], [Voice Memo] (A 89)

[Built-in Mic Sensitivity] [Normal], [High] (A 92)

Menu item Setting options and additional information
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[¢ Monitoring Setup] menu

[Built-in Mic Att.] [On], [Off] (A 92)

[Built-in Mic Low Cut] [Off], [LC1], [LC2] (A 92)

[1 kHz Tone] [–12 dB], [–18 dB], [–20 dB], [Off] (A 94)

[Headphone Volume] [Off], 1 to 15 (8) (A 122)

[Speaker Volume] [Off], 1 to 15 (8)

In MEDIA mode only, this setting is an alternative way to adjust the built-in speaker's volume.

[Monitor Channels] [CH1/CH2], [CH1/CH1], [CH2/CH2], [CH1+2/CH1+2], [CH3/CH4], [CH3/CH3], [CH4/CH4], 
[CH3+4/CH3+4], [CH1/CH3], [CH2/CH4], [CH1+3/CH2+4]

(A 133)

[HDMI OUT Channels] [CH1/CH2], [CH3/CH4]

Menu item Setting options and additional information

[LCD Brightness],
[LCD Contrast]

–50 to 50 (±0) (A 21)

[LCD Color] –20 to 20 (±0)

[LCD Sharpness] 1 to 4 (2)

[LCD Luminance] [Normal], [+1], [+2]

[LCD Mirror Image] [On], [Off]

[Anamorphic: LCD], 
[Anamorphic: HDMI]

[On], [Off] (A 103)

[Anamorphic Desqueeze] [Lens Squeeze Factor], [x2.0], [x1.3]

[Desqueeze for S&F] [Reduced Display], [Off]

[B&W Image: LCD], 
[B&W Image: HDMI]

[On], [Off] (A 21)

[OSD Output: HDMI] [On], [Off] (A 129)

[DISP Level 1] [All Displays], [All Displays (Periph. Border)] (A 46)

[DISP Level 2] [Main Recording Displays], [Only FUNC/MENU]

[DISP Level 3] [Only REC/STBY], [No Displays]

[Apply Peripheral Border] [DISP Level 1/2/3], [DISP Level 1/2], [DISP Level 1], [DISP Level 2], [DISP Level 3], [Off] (A 47)

[Custom Display 1] (A 43)

[Light Metering], 
[Custom Picture], 
[Focal Length], 
[Object Distance (Numeric)]*, 
[Object Distance (Bar)]*, 
[ND Filter], [Focus Mode], 
[Key Lock], [White Balance], 
[AE Shift], [Exposure Bar], [Iris], 
[ISO/Gain], [Shutter], [Peaking], 
[Digital IS], [Magnification], 
[LUT], [Lens]

[On], [Off]

The default setting for items marked with an asterisk (*) is [Off].

Menu item Setting options and additional information
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1 The default value depends on the country/region of purchase.

[Custom Display 2] (A 43)

[Remaining Battery], 
[Remaining Rec Time]

[Only Warnings], [Normal], [Off]

[Recording Mode], [Time Code], 
[Reel/Clip Number]

[On], [Off]

[Photo] [Only Warnings], [Normal], [Off]

[Temperature/Fan], 
[Sensor Mode],
[Resolution/Color Sampling], 
[Frame Rate], 
[Output Terminals Status], 
[OSD Output]*, 
[Rec Command], 
[User Memo]*, [User Bit]*, 
[Monitor Channels]*, 
[Audio Level Indicator], 
[Network Functions], [GPS]

[On], [Off]

[On], [Normal]: Show the icon/onscreen display always or whenever the necessary conditions are 
triggered.

[Only Warnings]: Show the icon/onscreen display only when a critical level is reached.
• The default setting for items marked with an asterisk (*) is [Off].

[Date/Time] [Date/Time], [Time], [Date], [Off]

[Custom Display] (A 121)

These settings are available only in MEDIA mode and determine whether the following onscreen displays 
will appear on the playback image.

[Audio Level Indicator] [On], [Off]

[Date/Time], [Camera Data] [On], [Off]

[Audio Level Indicator]: The audio level meter (clips only).
[Date/Time]: The date and time when the clip/photo was recorded.
[Camera Data]: The aperture value, shutter speed and ISO speed/gain value used to record the clip (clips 

only).

[Displayed Units] [Meters], [Feet]1

Changes the distance units used in camera displays between meters and feet.

[OSD Opacity: LCD], 
[OSD Opacity: HDMI]

[On], [Off] (A 129)

[OSD Opacity Level] [75%], [62.5%], [50%], [37.5%], [25%]

[OSD Opacity: Appl. Screens] [All], [Only Rec/Playback Screens]

[OSD Orientation: LCD] [0 degrees], [90 degrees], [270 degrees] (A 47)

[OSD Orientation: HDMI] [Linked to LCD], [90 degrees], [270 degrees]

[LUT: LCD] [On], [Off] (A 131)

[LUT Selection: LCD] [BT.709], [HDR Assist. (1600%)], [HDR Assist. (400%)]

[Gain for HDR�SDR Conv.] –7.5 dB to +7.5 dB in 0.5 dB intervals (–3.0 dB) (A 132)

[Range: HDMI] (A 130)

[During Canon Log Output] [Full Range Priority], [Narrow Range]

[During HDR Output] [Full Range Priority], [Narrow Range]

Menu item Setting options and additional information
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[A Assistance Functions] menu

Menu item Setting options and additional information

[Focus Guide] [On], [Off] (A 70)

[Focus Guide 2nd Frame] [On], [Off]

[Peaking: LCD], [Peaking: HDMI] [On], [Off] (A 71)

[Peaking] [Peaking 1], [Peaking 2]

[Peaking 1]

[Color] [White], [Red], [Yellow], [Blue]

[Gain] [Off], 1 to 15 (8)

[Frequency] 1 to 4 (2)

[Peaking 2]

[Color] [White], [Red], [Yellow], [Blue]

[Gain] [Off], 1 to 15 (15)

[Frequency] 1 to 4 (1)

[Magnification] [On], [Off] (A 71)

[Magn. Output] [LCD], [HDMI]

[False Color: LCD], 
[False Color: HDMI]

[On], [Off] (A 82)

[False Color Index] –

[Zebra: LCD], [Zebra: HDMI] [On], [Off] (A 82)

[Zebra] [Zebra 1], [Zebra 2], [Zebra 1+2]

[Zebra 1 Level] [5 ±5%] to [95 ±5%] in 5 percentage point intervals ([70 ±5%])

[Zebra 2 Level] 0% to 100% in 5 percentage point intervals (100%)

[WFM: LCD], [WFM: HDMI] [On], [Off] (A 95)

[WFM Function] [Waveform Monitor], [Vectorscope]

[Waveform Settings] (A 95)

[Position] [Right], [Left]

[Type] [Line], [Line+Spot], [Select Line], [RGB], [YPbPr]

[Gain] [1x], [2x]

[Vertical Scale for HDR] [IRE], [PQ/HLG]

[Y Position] [0%], [15%], [30%], [45%], [50%]

[Select Line] 0 to 719 in 1-line increments (360), 0 to 1079 in 1-line increments (540), 
0 to 2158 in 2-line increments (1080)

Available options depend on the resolution and operating mode (CAMERA/MEDIA mode).

[Vectorsope Settings] (A 96)

[Position] [Right], [Left]

[Type] [Normal], [Spot]

[Gain] [1x], [2x]

[Markers: LCD], [Markers: HDMI] [On], [Off] (A 80)

[Center Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (A 81)

[Center Marker Type] [Cross 1], [Cross 2], [Dot 1], [Dot 2]

[Horizontal Marker], 
[Vertical Marker], [Grid Marker]

[Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off]

[Aspect Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 75%], [Mask 50%], 
[Mask 25%], [Off]

(A 81)

[Marker Aspect Ratio] [4:3], [13:9], [14:9], [16:9], [1.375:1], [1.66:1], [1.75:1], [1.85:1], [1.90:1], [2.35:1], [2.39:1], 
[9:16], [Custom]

[Marker Custom Asp. Ratio] 1.00:1 to 9.99:1 (1.00:1)
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[ Network Settings] menu

[  Assignable Buttons] menu

Following are the default settings for each assignable button. For a complete list of the functions that can be 
assigned, refer to the detailed table (A 106).

[Safe Area Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 75%], [Mask 50%], 
[Mask 25%], [Off]

(A 81)

[Basis for Marker Safe Area] [Whole Picture], [Selected Aspect Marker]

[Marker Safe Area %] [80% (Side Length)], [88% (Side Length)], [90% (Side Length)], [93% (Side Length)], 
[95% (Side Length)], [80% (Area)], [90% (Area)], [92.5% (Area)], [95% (Area)]

[User Marker 1], [User Marker 2] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (A 81)

[User Marker 1 Size], 
[User Marker 2 Size]

2x2 to 2048x1080 only even numbers (100x100)

[User Marker 1 Position], 
[User Marker 2 Position]

(–1024, –540) to (1024, 540) (0, 0)

Menu item Setting options and additional information

[Network] [Enable], [Disable] (A 140)

[Connect] [Disconnect], [SET1] to [SET20]

[Connection Setting] [SET1] to [SET20] (A 148)

[Check Settings] –

[Change with Wizard] –

[Select Existing Setting] –

[Settings Name] File name up to 12 characters 

[Delete Settings] –

[New Conn. Setting (Wizard)] [FTP Transfer], [IP Streaming], [Browser Remote] (A 141)

[Advanced Settings] (A 149)

[Communication Settings] [NW1] to [NW25]

[Function Settings] [MODE1] to [MODE25]

[Browser Remote Settings] [User Setting], [User Name/Password], [Port No. (HTTP)], [Port No. (HTTPS)], [HTTPS] (A 151)

[FTP Transfer Settings] [Read Root Certificate], [Root Certificate Details], [Delete Root Certificate] (A 147)

[Nickname] User defined string up to 16 characters ([C70]) (A 148)

[View Error Info] Displays the latest network related error message.

[Activate IP Streaming] [Enable], [Disable] (A 154)

[FTP Transfer All Clips] – (A 153)

Menu item Setting options and additional information

[Camera] 1: [White Balance], 2: [Set White Balance], 3: [Peaking: All], 4: [WFM: All], 5: [DISP], 
6: [Zebra: All], 7: [Push Auto Iris], 8: [Magnification], 9: [FUNC], 10: [One-Shot AF], 
11: [(NONE)], 12: [AF Lock], 13: [Audio Status]

[REMOTE A] 1: [Magnification], 2: [Peaking: All], 3: [Zebra: All], 4: [WFM: All]

Menu item Setting options and additional information
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[B System Setup] menu

Menu item Setting options and additional information

[Reset] [All Settings], [Assignable Buttons]

These settings reset the following camera settings to default values/settings.
[All Settings]: All the camera’s settings except for the hour meter.
[Assignable Buttons]: Only the assignable buttons.

[Transfer Menu//] (A 117)

[Save] [To Camera], [To SD Card B]

[Load] [From Camera], [From SD Card B]

[Time Zone] List of world time zones. 
[UTC-05:00 New York] or [UTC+01:00 Central Europe]1

(A 22)

[Date/Time] –

[Date Format] [YMD], [YMD/24H], [MDY], [MDY/24H], [DMY], [DMY/24H]1

[Language H] [Deutsch], [English], [Español], [Français], [Italiano], [Polski], [Português], 
[Русский], [Українська], [ ], [ ], [ ]

(A 22)

[REMOTE Term.] [RC-V100 (REMOTE A)], [Standard] (A 104)

[HDMI Max Res.] [4096x2160 / 3840x2160], [1920x1080], [1280x720] (A 128)

[Linked to HDMI Monitor] [On], [Off]

[HDMI Scan Mode] [P], [PsF (Forced 1080i)]

[Time Code Mode] [Preset], [Regen.] (A 83)

[Time Code Run] [Rec Run], [Free Run]

[Time Code DF/NDF] [DF], [NDF] (A 84)

[Set Time Code] [00:00:00:00] to 59.94 Hz: [23:59:59:29] 
50.00 Hz: [23:59:59:24]
24.00 Hz: [23:59:59:23]

(A 83)

[TC In/Out] [In], [Out] (A 85, 86)

[User Bit Recording Mode] [Internal], [External] (A 85)

[User Bit Type] [Setting], [Time], [Date] (A 84)

[Front Control Dial], 
[Rear Control Dial], 
[Control Ring]

[Iris], [ISO/Gain], [White Balance Mode], [White Balance (K)], 
[White Balance (CC)], [Off]

(A 59,
63, 67)

Determines the function assigned to the respective control dial/control ring.
• The default function for the rear control dial and control ring is [Off].

[Front Control Dial Dir.], 
[Rear Control Dial Dir.], 
[Control Ring Dir.], 
[SELECT Dial Dir.]

[Reverse], [Normal]

Changes the direction of the adjustment when operating the front/rear control dial, the control ring on the 
lens/adapter or the SELECT dial, respectively.

[Ctrl Dial in Menus] [Disable], [Enable] (A 23)

Enables or disables the use of the front and rear control dials to navigate the setup menus, direct touch 
control, direct setting mode and status screens.

[Focus Ring Operation] [Enable During AF], [Disable During AF]

[Focus Ring Direction] [Reverse], [Normal]

Changes the direction of the adjustment when operating the focus ring on an RF lens.

[Focus Ring Response] [Varies with Rotation Speed], [Linked to Rotation Degree]

[Key Lock] [All Buttons], [All Except REC Button] (A 15)

[REC Button] [Disable], [Enable] (A 41)

Enables or disables the use of the REC buttons. 
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1 The default value depends on the country/region of purchase.
2 Only when the GP-E2 GPS Receiver is connected to the camera.

[¥ My Menu] menu (CAMERA mode only)

[Assign. Button 4 as REC] [On], [Off] (A 105)

When this setting is set to [On], assignable button 4's function changes to [REC] and cannot be changed. 
This turns assignable button 4 to an alternative REC button.

[Onscreen REC/STBY Button] [On], [Off] (A 41)

When this setting is set to [On], the recording operation indicator (REC/STBY) on the CAMERA mode 
screen becomes an onscreen button you can touch to start/stop recording.

[Touch Screen Response] [Normal], [Low] (A 21)

[Tally Lamp], 
[SD Card Access LED]

[On], [Off]

These settings determine whether the following LEDs and indicators will illuminate.
[Tally Lamp]: The tally lamp (red, A 13) when the camera starts up and while recording. When this 

setting is set to [Off], the power indicator (green) will also be disabled.
[SD Card Access LED]: The card access indicator (A 32) when the camera is accessing the card.

[Fan Mode] [Automatic], [Always On] (A 39)

[Fan Speed (STBY)] [Maximum], [High], [Middle], [Low]

[Fan Speed (REC)], 
[Fan Speed (Always)], [Fan Speed]

[High], [Middle], [Low]

[Review Recording] [Entire Clip], [Last 4 sec] (A 47)

[GPS Auto Time]2 [On], [Off]

When this setting is set to [On], the camera automatically adjust its date and time settings according to 
the information received from the GPS signal.
• While the automatic date/time adjustment is activated, the  > [B System Setup] > [Date/

Time] setting will not be available.
• The time will not be updated while recording video.

[DC IN Warning (V)] 11.5 V to 15.0 V in 0.1 V intervals (13.0 V) (A 20)

[Retract Lens] [On], [Off]

When a compatible lens (A 204) is attached to the camera and the focus mode switch on the lens is set 
to AF, if this setting is set to [On], the lens will retract fully when the camera is turned off. 

[Reset Hour Meter] The camera has two “hour meters” – the first keeps track of total operation time and the second keeps 
track of operation time since the last time the second hour meter was reset with this function. 

[Certification Information] This displays select certification information that apply to this camera.

[Firmware]

[Camera], [Lens], 
[Mount Adapter]

Check/update the firmware version of the camera, lens (A 28) or mount adapter.

Menu item Setting options and additional information

[CAMERA-1: Edit] to 
[CAMERA-5: Edit]

[Register], [Move], [Delete], [Reset All], [Rename] (A 24)

Menu item Setting options and additional information
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Displaying the Status Screens
You can use the status screens to check the camera’s various settings. You can also output the status screens 
to an external monitor.

1 Set an assignable button to [Status] (A 105).

2 Press the assignable button to open the status screens.
• The status screen most recently displayed will appear unless you turned off the camera or changed the 

operating mode.
• You can also press the AUDIO STATUS button to open directly only the [¡ Audio Setup] status screen.

3 Scroll through the status screens to check the desired settings.
• Bring the cursor to a page number and push the joystick left/right to move between the status screens.
• You can also use front/rear control dials and the SELECT dial to navigate the status screens in the same way 

as the setup menus.

4 Press the assignable button again or select [X CLOSE] to close the status screens.
• You can also press the MENU button to close the status screens and open the menu instead.

To skip directly to the page of a specific status screen:

[ Gamma/Color Space/Range] status screens (CAMERA mode only)

[ Gamma/Color Space/Range] (A 173)
[/] (custom picture file in use) (A 174)
[v Camera Setup] (A 175)
[  Assignable Buttons] (A 176)

[¡ Audio Setup] (A 177)
[B System Setup] (A 178)
[Æ Recording/Media Setup] (A 179)
[ Network Settings] (A 180)

1

3
2

5

4

1 Gamma curve, color space (A 113) and range 
used for clips recorded on the cards

2 Look File applied (A 111)
3 Gain for HDR-to-SDR conversion (A 132) 
4 HLG color quality (A 113) 

5 Gamma curve, color space (A 113, 131) and 
range (A 130) used for video outputs/monitoring 
devices
[HDMI]: Video output from the HDMI OUT 
terminal
[LCD]: LCD screen
[IP Strm. (8 bit)]: IP streaming signal (A 154) 
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[/] status screens (CAMERA mode only)

2 2

2

1

1 Custom picture file name (A 109)
2 Custom picture settings (A 113)
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[v Camera Setup] status screens (CAMERA mode only)

1

2

4

5

6

7

8

9

10

3

1 ISO speed/Gain (A 59) 
Selected mode, extended range, ISO increment, 
gain increment and limit for automatic adjustment

2 Aperture (A 62) 
Iris increment, fine increment, aperture correction 
while zooming

3 Shutter speed increment (A 57) 
4 Focus (A 69)

AF mode, AF frame settings, AF speed and AF 
response settings

5 Automatic exposure (AE)
AE shift (A 65), AE response (A 64)

6 White balance (A 66)
Shockless white balance, auto white balance 
(AWB) response

7 In-camera lens correction (A 28) 
Peripheral illumination, chromatic aberration, lens 
diffraction and distortion aberration

8 Anamorphic correction (A 103) 
On the LCD screen/video output, desqueeze ratio 
(for most clips/for slow & fast motion clips), lens 
squeeze factor saved in the metadata

9 Image stabilization (A 78) 
Super16 digital IS, lens’s focal length and 
anamorphic correction

10 Lens model name (A 26)
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[  Assignable Buttons] status screens 

1

2

Current functions of the assignable buttons (A 105)
1 On the camera’s body
2 On the RC-V100 Remote Controller
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[¡ Audio Setup] status screens

1

2
4

5
3

4
2
3

CAMERA mode:

MEDIA mode:

1 Audio source input, audio level adjustment mode 
and audio level indicator for each audio channel 
(A 87) 

2 Audio channels output from the headphones/
speaker (A 133)

3 Headphone volume (A 122)

4 Audio configuration used for recording on the 
cards (A 87) and for output (HDMI OUT 
terminal, A 133)

5 Press SET to open the [¡ Audio Setup] menu
(only when the status screen was opened using 
the AUDIO STATUS button)
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[B System Setup] status screens

1 CAMERA mode only.
2 Only when the GP-E2 GPS Receiver is connected to the camera.

1
2

5
6

7
8
9

10

4
3

1 HDMI OUT terminal status (A 128): Signal type 
(HDMI/DVI), video output, frame rate, audio 
output

2 Onscreen displays output from the HDMI OUT 
terminal (A 129)

3 Time code output from the HDMI OUT terminal1 
(A 128)

4 User bit1 (A 84)

Information about the Canon battery pack (A 17)
5 Remaining recording time
6 Remaining charge level (visual bar)
7 Battery life indicator

8 Total operation time
9 Operation time since using [Reset Hour Meter] 

(A 172)
10 GPS information1,2

Latitude, longitude, elevation, coordinated 
universal time (UTC)
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[Æ Recording/Media Setup] status screens
Pages " to & are displayed only in CAMERA mode.

NOTES

• Depending on the card, the total space displayed on the screen may differ from the nominal capacity printed 
on the card itself.

1

2
12

3

5
4

13

14

6

9
10
11

8
7

1 Information about SD cards A and B
Visual bar, total capacity, used (recorded) space, 
approximate available recording time, speed class 
and number of remaining photos (SD card B only)

2 User memo (A 98)
User memo file name, title, creator, location and 
description

3 Clip name information (A 37)
Camera index, reel number, clip number, 
user-defined field

4 Scene and take information (A 99)
5 Unique material identifier (UMID) code (A 166): 

country, organization, user
6 Custom picture file embedded (A 112)
7 Sensor mode (A 53)

8 Recording mode (A 35)
9 Second card recording function (A 35) 
10 XF-AVC clip numbering (A 37)
11 MP4 clip/photo numbering (A 38)
12 Main recording video configuration (A 53)

Video format, color sampling, resolution and bit 
rate, frame rate and audio format (only MP4 clips) 
(A 88) 

13 Proxy clips (A 56)
Proxy clip recording activated/deactivated, video 
configuration, color conversion

14 Sub recording video configuration (A 54)
Video format, color sampling, resolution and bit 
rate, frame rate and audio format (only MP4 clips) 
(A 88) 
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[  Network Settings] status screens

Network connection used (A 140)

TCP/IP settings of the current network connection (A 147)

2 3

1

1 Network functions activated/deactivated 
2 Connection setting in use 

Connection setting (SET) number, name, 
communication settings (primary network and 
secondary network) and function settings

3 Communication settings of the primary/
secondary network
Network type, connection method, SSID (network 
name), Wi-Fi channel, authentication, encryption 
and key index

7

6

5
4
3
2
1

1 IP address assignment method
2 IP address
3 Subnet mask
4 Default gateway

5 DNS server
6 Camera’s MAC address
7 IPv6 settings (A 150)
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IP streaming settings (CAMERA mode only, A 143)

Settings for Browser Remote (CAMERA mode only, A 144)

FTP transfer settings (MEDIA mode only, A 141)

1

2

4
5

3

1 IP streaming activated/deactivated (A 154) 
2 Streaming protocol and receiver settings
3 Error correction settings

4 RTSP user name required to control streaming 
sessions

5 Streaming video configuration and audio 
channels

1
2 4
3

1 Port number (HTTP)
2 HTTPS connection (A 151) 

Port number, HTTPS activated/deactivated

3 Camera’s URL
4 Users

User names for single-user and two-user modes

1

1 Transfer mode, user name and FTP server (or 
host) name
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Troubleshooting
If you have a problem with your camera, refer to this section. Consult your dealer or a Canon Service Center if 
the problem persists.

Power source
The camera will not turn on or it turns off by itself.

- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Shortly after turning it on, the camera turns off on its own.
- You are using a battery pack that is not compatible for use with this camera. Use a recommended battery pack 

(A 197).

Cannot charge the battery pack.
- The temperature of the battery pack is outside the charging range. If the battery pack’s temperature is below 0 °C 

(32 °F), warm it before charging it; if it is above 40 °C (104 °F), let the battery pack cool down before charging it.
- Charge the battery pack in temperatures between 0 °C and 40 °C (32 °F and 104 °F).
- The battery pack is faulty. Replace the battery pack.

The battery pack is depleted extremely quickly even at normal temperatures.
- Check the [B System Setup] status screen (A 178) to check if the battery pack has reached the end of its battery 

life. If so, buy a new battery pack.

Recording
The camera’s controls are not responsive/disabled.

- When the Q switch is set to C, all buttons (or all buttons with the exception of some REC buttons) are locked 
and cannot be operated. Set the Q switch to CAMERA. You can change which controls are locked with the 

 > [B System Setup] > [Key Lock] setting.

Performing a recording operation (pressing a button/touching the onscreen button) will not start recording.
- The card is full or it already contains the maximum number of clips (999 clips). Delete some clips (A 126) or save your 

recordings and initialize the card (A 32) to free some space. Alternatively, replace the card.
- The REC button was pressed while all the camera's controls were locked (key lock, A 15). Unlock the controls or set 

 > [B System Setup] > [Key Lock] to [All Except REC Button].
- The REC button that was used may be disabled. Change the  > [B System Setup] > [REC Button], [Assign. 

Button 4 as REC] and [Onscreen REC/STBY Button] settings to enable the use of the desired button or onscreen 
button.

- Power supply to the camera has reached the level set for the power level warning (A 172). Check the power source.
- You may not be able to start or stop recording while controls on the RC-V100 Remote Controller are being operated. 

Stop using the remote controller and then press the REC button or touch the onscreen button.
- The camera cannot record while the [Color Correction] settings in the custom picture file (A 116) are being adjusted 

(except for the [Revision Level]/[Revision Phase] settings).

The point when the recording operation was performed does not match the beginning/end of the recording.
- There may be a slight interval between pressing the REC button (or touching the onscreen button) and the actual start/

end of recording. This is not a malfunction.

The camera will not focus.
- The camera may not be able to focus on certain subjects using autofocus. Focus manually (A 70).
- When the AF mode is set to AF-boosted MF, start focusing manually until the AF frame changes to white (automatic 

adjustment range).
- The lens is dirty. Clean the lens with a soft lens-cleaning cloth.

When a subject flits across in front of the lens, the image appears slightly bent.
- This is a phenomenon typical of CMOS image sensors. When a subject crosses very quickly in front of the camera, the 

image may seem slightly warped. This is not a malfunction.
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Bright red, green or blue dots appear on the screen.
- Try adjusting the black balance (A 40). The camera’s CMOS sensor is a delicate piece of precision engineering. Direct 

exposure of the sensor to ion rays or other types of cosmic radiation may affect it and this may rarely appear as bright colored 
dots on the screen. This is the nature of CMOS image sensors and does not represent a malfunction.

- The effects of the damage may be more noticeable when the camera is used in places subject to high temperatures, 
when a high ISO speed or gain level is used and when slow shutter speeds are used.

Abnormal images appear on the screen and the camera cannot record properly.
- While recording using an almost empty battery pack together with an AC adapter, the AC adapter was inadvertently 

disconnected or the power supply was suddenly interrupted. Reconnect the AC adapter and turn the camera off and 
then on again or replace the battery pack with a fully charged one.

Changing between recording (ÜREC) and record standby (STBY) takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings 

and initialize the card (A 32). Alternatively, replace the card.

Clips or photos cannot be recorded properly.
- This may occur as clips and photos are recorded/deleted over time. Save your recordings and initialize the card 

(A 32).

After using the camera for a long time, it becomes hot.
- The camera may become hot after using it continuously for long periods of time; this is not a malfunction. If the 

camera becomes unusually hot or it becomes hot after using it only for a short while, it may indicate a problem with 
the camera. Consult a Canon Service Center.

Playback
Cannot delete clips/photos

- XF-AVC clips with an $ mark cannot be deleted with the camera. Remove the $ mark (A 125).
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- Photos that were protected using other devices cannot be deleted with this camera.

Deleting clips takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings 

and initialize the card (A 32).

Indicators and Onscreen Displays
 appears in red on the screen.

- Battery pack is depleted. Replace or charge the battery pack.

í appears on the screen.
- The camera cannot communicate with the battery pack attached so the remaining battery time cannot be displayed.

The power indicator/tally lamp does not illuminate.
- Set  > [B System Setup] > [Tally Lamp] to [On].

The power indicator/tally lamp flashes quickly.  (4 flashes per second)
- The battery pack is depleted. Replace or charge the battery pack.
- There is not enough available space on the cards. Delete recordings (A 126) to free some space or replace the card.
- A system error has occurred. Turn the camera off and then on again. If this does not solve the problem, consult a 

Canon Service Center.

The power indicator/tally lamp flashes slowly.  (1 flash per second)
- The combined available space on the cards is low. Delete recordings (A 126) to free some space or replace the card.

 or  appears in red on the screen.
- An SD card error occurred. Remove and reinsert the SD card. If the display does not change back to normal, save your 

recordings and initialize the SD card (A 32).

 /  appears in red on the screen followed by [END].
- The indicated card is full. Delete recordings (A 126) to free some space or replace the card.



Troubleshooting

184

Even after stopping recording, the access indicator stays illuminated in red.
- The clip is being recorded on the card. This is not a malfunction.

b appears in yellow on the screen.
- The camera’s internal temperature has reached a predetermined level. You can continue using the camera.

b appears in red on the screen.
- The camera’s internal temperature has risen further while b appeared in yellow on the screen.
- If the icon appears in red in CAMERA mode while  > [B System Setup] > [Fan Mode] is set to [Always On] or in 

MEDIA mode while  > [B System Setup] > [Fan Speed] is set to [High], turn off the camera and wait until the 
temperature has decreased.

- In CAMERA mode, if the fan mode is set to [Automatic] and the fan was turned off while recording, the fan will turn on 
automatically (in that case, ` will appear on the screen).

` appears in red on the screen.
- The cooling fan may not be working properly. The camera will automatically turn off after a few minutes. Consult a 

Canon Service Center.

i appears on the screen.
- The camera and lens cannot communicate normally. Clean the lens’s contacts and reattach the lens.

The aperture value (T value) appears in gray on the screen.
- When using a compatible EF Cinema lens (A 203), the aperture value will appear in gray when the camera detects 

that the aperture may be close to fully closed. As you continue to close down the aperture further, the display will 
change to [closed].

The ND filter indicator appears in red or as [- -] on the screen, and the ND filter indicators on the RC-V100 Remote 
Controller are flashing.

- The ND filter mechanism may not be working properly. Consult a Canon Service Center.

Picture and Sound
There is no picture or sound from an external monitor/recorder connected to the HDMI OUT terminal

- Disconnect the HDMI cable and then restore the connection or turn the camera off and then on again.
- Check that the settings of the external monitor/recorder match the configuration of the output signal selected on the 

camera (A 127).
- Replace the HDMI cable.

An assistance display (peaking/zebra pattern/video scope/onscreen markers/false color/magnification/B&W image/
anamorphic desqueeze/LUT) does not appear or is not applied on the screen.

- These assistance displays have separate settings that allow you to turn the display on/off on individual monitoring 
devices/video outputs. Check the settings to see that the desired function is enabled on the desired monitor/video 
output.

- Onscreen displays output has not been enabled. Activate the output of the camera’s onscreen displays (A 129).

Screen displays turn on and off repeatedly.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Abnormal characters appear on the screen and the camera does not operate properly.
- Remove all the cards and disconnect the power source. After a moment, reconnect the power and reinsert the cards. 

If the problem still persists, use the  > [B System Setup] > [Reset] > [All Settings] function. This resets all the 
camera’s settings to default values, except for the hour meter.

Video noise appears on screen.
- Keep a distance between the camera and devices that emit strong electromagnetic fields such as near powerful 

magnets and motors, MRI machines or high-voltage power lines. 

Horizontal bands appear on the screen.
- This is a phenomenon typical of CMOS image sensors when recording under some types of lighting. This is not a 

malfunction. You may be able to reduce the symptoms by setting the shutter speed mode to [Speed] and the shutter 
speed to a value matching the frequency of the local electrical system: 1/50* or 1/100 for 50 Hz systems, 1/60 or 1/120 
for 60 Hz systems.
*May not be available depending on the frame rate.
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Audio is not recorded.
- The audio input source is not correctly selected (A 89) or a microphone is not connected to the selected terminal.
- When using the INPUT 1/INPUT 2 terminals, make sure you are using a mini XLR connector. When using the MIC 

terminal, make sure you are using a condenser microphone with a ∅ 3.5 mm stereo mini plug.
- The external microphone is not turned on or its battery is depleted.
- The external microphone connected to the INPUT 1/INPUT 2 terminal requires phantom power. Set the corresponding 

INPUT 1/INPUT 2 audio source selection switch to MIC+48V (A 89).
- The external microphone connected to the MIC terminal requires plug-in power but  > [¡ Audio Setup] > 

[MIC Input] is set to an option other than [MIC (with Power Supply)].
- To record audio for slow & fast motion clips, set the recording mode to [S&F Clip / Audio (WAV)] (A 35).

Sound is distorted or is recorded at lower levels.
- This may happen when the appropriate audio level is not set correctly. Adjust the audio recording level manually 

(A 91). You can also activate the microphone attenuator (A 92) to reduce the audio level.
- The audio source selected for the INPUT terminal or MIC terminal is incorrect. When using an external microphone, set 

the INPUT switch to MIC or set  > [¡ Audio Setup] > [MIC Input] to one of the [MIC] options. When using an 
analog audio device set the INPUT switch or the [MIC Input] setting to [LINE].

- The audio level is adjusted manually and the recording level is set too low. Check the audio level meter on the screen 
and adjust the audio level correctly (A 90).

Cards and Accessories
Cannot insert the card.

- The card you are trying to insert is not facing the correct direction. Turn it over and insert it.

Cannot record on the SD card.
- A compatible card must be used (A 31).
- Initialize the card (A 32) when you use it with the camera for the first time.
- The card is full or it already contains the maximum number of clips (999 clips). Delete recordings (A 126) to free some 

space or replace the card.
- The clip number has reached its maximum value. Save your recordings and initialize the card (A 32) or delete all the 

clips (A 126).
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- The folder and file numbers for MP4 clips and photos have reached their maximum value. Set  > 

[Æ Recording/Media Setup] > [MP4 Clip/Photo Numbering] to [Reset] and insert a new card.

Recording to and playing back from a card is slow.
- This may occur as recordings are made and deleted repeatedly over time. Save your recordings and initialize the card 

(A 32).

The RC-V100 Remote Controller or commercially available remote control does not work.
- Make sure that  > [B System Setup] > [REMOTE Term.] is set to [RC-V100 (REMOTE A)] when using the 

RC-V100 Remote Controller or to [Standard] when using a commercially available remote control (A 104).
- Turn off the camera, reconnect the remote controller and then turn the camera back on again.
- When the currently selected custom picture file is protected, detailed custom picture settings cannot be adjusted 

using the RC-V100. Unprotect the file (A 110).

Connections with External Devices
Video noise appears on a nearby TV screen.

- When using the camera in a room where a TV is located, keep a distance between the AC adapter and the power or 
antenna cables of the TV.
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Check This First

Cannot connect with an access point.
Cannot establish a Camera Access Point connection with a network device.

- Visit your local Canon website and check that the model of Wi-Fi adapter used (commercially available) was tested for 
use with this camera.

- If the network connection icon (A 152) does not turn white, turn off the camera, remove the Wi-Fi adapter and 
correctly attach it again.

- When connecting to an access point, check that the settings on the network device the camera is trying to connect 
with are correct.

- When you reset all the camera settings, all network settings are lost as well. Configure the network settings again 
(A 145).

- The wireless signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal. 
Refer to Precautions Regarding Wi-Fi Networks (A 187).

Cannot connect with a wired (Ethernet) network.
- Visit your local Canon website and check that the model of Ethernet adapter used (commercially available) was tested 

for use with this camera.
- Turn off the camera, remove the Ethernet adapter and correctly attach it again.
- Use a category 5e or better shielded twisted pair (STP) Ethernet cable.
- Try replacing the Ethernet cable.
- When you reset all the camera settings, all network settings are lost as well.
- Check that the network device to which the camera is connected is on and functioning properly. To use 1000BASE-T 

connection speeds, make sure to use network devices compatible with Gigabit Ethernet (1000BASE-T).

The Browser Remote application will not start on the Web browser.
- Make sure to use a connection setting with the [Browser Remote] function setting.
- The URL entered into the Web browser’s address bar is incorrect. Select  > [  Network Settings] > 

[Connection Setting] > Connection setting in use > [Check Settings] and check the camera’s IP address. Use this IP 
address as the URL (A 156).

The Browser Remote screen is not displayed correctly on the Web browser.
- The device, operating system or Web browser used may not be supported. For the latest information about supported 

systems, visit your local Canon website.
- Enable JavaScript and cookies in your Web browser’s settings. For details, refer to the help modules or online 

documentation of the Web browser used.

Cannot start IP streaming.
- Make sure IP streaming was activated on the camera (A 154).
- If the IP streaming protocol is set to an option other than [RTSP+RTP], make sure the [Destination Server] is set 

correctly (A 143).
- IP streaming cannot be used in the following cases. Check the settings.

• When slow & fast motion recording, pre-recording, relay recording or double slot recording is activated.
• When the system frequency is set to 24.00 Hz.
• When the main recording format is set to one of the [MP4(HEVC)] options.

• Are the camera, computer or other network devices all turned on?
• Is the network working and correctly configured?
• Are all network devices correctly connected to the same network as the camera?
• When using a Wi-Fi network, are there any obstructions between the camera and the access point or 

between the network device used and the access point?



187

Troubleshooting

Precautions Regarding Wi-Fi Networks
When using a Wi-Fi network, try the following corrective actions if the transmission rate drops, the connection is 
lost, or other problems occur.

Positioning a network device (access point, mobile device, etc.)
- When using a Wi-Fi network indoors, place the network device in the same room as the camera.
- Place the network device in an open, unobstructed location, where people or objects do not come between it and the 

camera.
- Place the network device as close as possible to the camera. Change the height or facing of the network device, as 

necessary.

Nearby electronic devices
- If the transmission rate over a Wi-Fi network drops because of interference from the following electronic devices, 

switching to the 5 GHz band or to a different channel may solve the problem.
- Wi-Fi networks using the IEEE 802.11b/g/n protocol operate in the 2.4 GHz band. For this reason, the transmission 

rate may drop if there are nearby microwave ovens, cordless telephones, wireless microphones and Bluetooth or 
similar devices operating on the same frequency band.

- If another access point operating on the same frequency band as the Wi-Fi adapter connected to the camera is used 
nearby, the transmission rate may drop.

Using multiple cameras/Wi-Fi adapters/access points 
- Check that there are no IP address conflicts among the devices connected to the same network.
- If multiple cameras are connected to a single access point, connection speeds may be reduced.
- To reduce radio wave interference when there are multiple access points using IEEE 802.11b/g or IEEE 802.11n (in the 

2.4 GHz band), leave a gap of four channels between each wireless access point. For example, use channels 1, 6, and 
11, channels 2, 7, and 12, or channels 3, 8, and 13. 
If you can use IEEE 802.11a/n/ac (in the 5 GHz band), switch to IEEE 802.11a/n/ac and specify a different channel, 
leaving an appropriate gap between channels according to the wireless standard and frequency band used. For 
example, when using IEEE 802.11ac (VHT80), leave a gap of 8 channels between access points.
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List of Messages
Refer to this section if a message appears on the screen. The messages in this section appear in alphabetical 
order. Note that for some messages, an indication of the card involved ([SD Card A], [SD Card B] or [SD Card]) 
may appear above the message itself.

60 minutes have elapsed.    Audio (WAV) recording will stop.
- Recording of the audio file will stop after 60 minutes but video recording will continue unaffected.

Accessing <...>   Do not remove
- You opened the card compartment cover while the camera was recording on the card. Be sure to stop the recording 

before removing the card.

Attached lens accessory not supported by the camera. It may not work properly.
- The attached lens accessory is not supported. Some functions may not work correctly.

Attached lens not supported by the camera. It may not work properly.
- The attached lens is not supported. Some functions may not work correctly.

Attached lens’s firmware must be updated for the lens to work properly with this camera.
- For details about available firmware updates for the lens used, visit your local Canon website.

Battery communication error.  Does this battery display the Canon logo?
- You attached a battery pack that is not recommended by Canon for use with this camera.
- If you are using a battery pack recommended by Canon for use with this camera, there may be a problem with the 

battery pack or camera. Consult a Canon Service Center.

Buffer overflow. Recording was stopped.
- Recording was stopped because the card's write speed was too slow. Use a recommended card (A 31).
- Save your recordings and initialize the card (A 32).

Camera b Lens communication error.   Clean the lens’s contacts and reattach the lens.
- The camera cannot correctly communicate with the lens due to dirty lens contacts. After the message disappears, the 
i icon appears on the screen. Clean the lens contacts with a soft cloth and reattach the lens.

Cannot play back
- The XF-AVC clip’s file control information is corrupted or there was a decoder error. Turn the camera off and then on 

again. If this does not solve the problem, consult a Canon Service Center.
* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information 

cannot be read by the software (Canon XF Utility or plugins for NLE applications).
- Playback was stopped because the card's read speed was too slow. Use a recommended card for recording/playback 

(A 31).

Cannot switch SD card slots
- The SLOT SELECT button was pressed while the camera is recording. Wait until recording is finished to change the 

selected card slot. 

Check the memory card
- Cannot access the card. If the card is correctly inserted, remove it. Check it has no defects or other problems and then 

reinsert it.
- A card error occurred and recording/playback is not possible. Try removing and reinserting the card or replace it.
- You inserted a MultiMedia Card (MMC) into the camera. Use a recommended SD card (A 31).
- If after the message disappears,  or  appears in red, perform the following: Turn off the camera and remove and 

reinsert the card. If  or  turns back to green you can resume recording/playback. If the problem persists, save 
your recordings and initialize the card (A 32).

Cover is open
- The card compartment cover was open when the camera was turned on or switched to CAMERA mode. Insert a card 

and close the card compartment cover.

Fan error
- The cooling fan may not be working properly. The camera will turn off automatically after a few minutes. Consult a 

Canon Service Center.

File name error
- XF-AVC clip numbers or MP4 clip/photo numbers have reached their maximum value. Save your recordings and 

initialize the card (A 32) or delete all the recordings (A 126).
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If you change this setting, you will not be able to use the current Look File.
- The Look File’s adjustments to the image quality cannot be applied because the [Gamma/Color Space], [HLG Color], 

[Over 100%] settings in the custom picture file are different from those registered with the Look File. Change these 
settings or register a different Look File.

Invalid operation
- The following are not valid operations and cannot be performed.

• In MEDIA mode, during playback, trying to add a shot mark to a frame that has one already.
• Trying to add an $ mark and a % mark to the same clip.
• Pressing the REC button when no cards are inserted in the camera.

Lens error   Turn the camera off, then on again.
- There was a communication error between the camera and the lens. Turn the camera off and then on again.

Lens firmware update   Firmware update failed. Try updating again.
- The lens’s firmware could not be correctly updated. Try updating the firmware again.

Low Power Warning   Check the power supply.
- The input power supplied to the camera (DC IN terminal) has reached the level set for the power level warning 

(A 172). Check the power source.
- The message appears every time you press the REC button when the power supply is too low (as described above).

Management file error
- Cannot record because the camera cannot write to the file control information. This may occur if the files on the card 

were accessed using another device. Save your recordings and initialize the card (A 32).

May not be possible to record clips on this media
- The card used does not meet the camera's requirements. Use a recommended card (A 31).

Media full
- The card is full. Replace the card or delete recordings (A 126) to free some space on the card.
- Recording will not start because the card is full. Switch to the card in the other card slot to record.

Media is almost full
- Available space on one or both cards is insufficient as described below. Replace the relevant card(s) or delete 

recordings (A 126) to free some space on the card.
• During normal recording, the space available on the card being used for recording is low.
• During relay recording, the combined space available on cards A and B is low.
• During sub recording or double slot recording, the space available on card A or B (the fullest one) is low.
• During proxy recording, the space available on card A (primary clips) is low. Otherwise, when recording only on card 

B (proxy clips), the space available on card B is low.
• During continuous recording, the space available on card B (continuous) is low.

Memory card is write-protected
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.

Mount Adapter firmware update     Firmware update failed. Try updating again.
- The mount adapter’s firmware could not be correctly updated. Try updating the firmware again.

No clips
- There are no clips of the selected video format on the selected card.

No photos
- There are no photos on the SD card.

Number of clips already at maximum
- The card selected for recording already contains the maximum number of clips (999 clips). Replace the card or use the 

card in the other card slot.
- Because both cards reached the maximum number of clips, double slot recording is not available.

Number of Shot Marks at maximum
- The shot mark could not be added because the clip already contains 100 shot marks.

Power Zoom Adapter   Check the power supply.
- The power zoom adapter’s remaining battery charge is low. Replace the power zoom adapter’s batteries.

Power Zoom Adapter   Temperature too high. Cannot perform task.
- The power zoom adapter cannot be operated because its temperature is too high. Stop using the power zoom adapter 

and let it cool down before using it again.
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Recommend checking the data and initializing
- The card cannot be used for any of the following reasons. Save your recordings and initialize the card (A 32).

• A problem has occurred with the card.
• The camera cannot read the data on the card.
• The card was initialized using a computer.
• The card is partitioned. 

Recorded at 24.00 Hz/50.00 Hz/59.94 Hz   Recommend checking the data and initializing
- The card contains clips that were recorded using a system frequency different from the one currently used by the 

camera. To record on this card, save your recordings and initialize the card with the camera (A 32). To play back the 
XF-AVC clips recorded on the card, change the camera's system frequency (A 53) to match the recordings on the 
card.

Recording was stopped.
- The file control information is corrupted or there was an encoder error. Turn the camera off and then on again. Then, 

remove the card being used and reinsert it. Alternatively, replace the card. If this does not solve the problem, consult a 
Canon Service Center.
* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information 

cannot be read by the software (Canon XF Utility or plugins for NLE applications).

SD Card A�SD Card B / SD Card B�SD Card A Switched
- This message appears when you use the SLOT SELECT button to switch the card slot in use or recording continued 

from one card to the other.

SD Card A�SD Card B / SD Card B�SD Card A Will switch in a moment
- The card is almost full so recording will continue on the other card in approximately 1 minute.

Set the lens to the shooting position.
- The collapsible lens attached to the camera is not set to the shooting position (with the barrel extended and locked). 

Set the lens to the shooting position.

Some audio files require data recovery.
- The power may have been suddenly turned off or the card may have been removed while the camera was recording. 

As a result, one or more audio files contain corrupted data. You can try to recover the files (A 34).

Some clips require data recovery
- The power may have been suddenly turned off or the card may have been removed while the camera was recording. 

As a result, one or more clips contain corrupted data. You can try to recover the clips (A 34).

The following settings were changed.
- The settings displayed on the screen were changed automatically due to a change in one of the [Æ Recording/Media 

Setup] settings. Check the settings before you continue recording.

The memory card is not compatible with the current recording settings.
- Slow & fast motion recording was activated and a shooting frame rate corresponding to slow motion was set while 

using a card with a speed class rating lower than V90. Replace the card with one rated V90.
- The main recording format was set to [XF-AVC YCC422 10 bit], or to [MP4(HEVC) YCC422 10 bit] with a 4K resolution 

(4096x2160 or 3840x2160), while using a card with a speed class rating lower than V60. Replace the card with one 
rated V60 or V90.

The number of ND filters used has changed.   Check the focus.
- When using ND filter settings in the extended range (8 stops or 10 stops), the number of ND filters used changes and 

this may result in a shift in focus. Check the focus before resuming shooting.

This photo cannot be displayed
- You may not be able to display photos taken with other devices or image files created or edited on a computer.

Unable to recover data
- Could not recover the selected recording (clip or audio file). Back up your recordings and delete the recordings that 

could not be recovered (A 126).
- The camera may not be able to recover files when there is not enough space on the card. Delete recordings (A 126) 

to free some space.

When [Slow & Fast Frame Rate] is set higher than 60 (fps), the Magnification function cannot be used.
- You attempted to use the magnification function with the sensor mode set to [Super 35mm] and slow & fast motion 

recording activated with a shooting frame rate higher than 60. Change the sensor mode or set a shooting frame rate of 
60 or lower.
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Along with this list, refer also to the instruction manuals of the access point or other external devices you are 
using.

With the current [Gamma/Color Space] settings, setting the main recording format to one of the 10 bit options is 
recommended.

- The main recording format is set to one of the options using 8 bit color but the color space component of the [Gamma/
Color Space] setting in the custom picture file is set to [C.Gamut] or [BT.2020]. Using a 10 bit color bit depth is 
recommended to fully realize the characteristics of the selected color space.

With the current combination of lens and mount adapter, some functions' performance may not be precise.
- With the current combination of lens and mount adapter used, the focal length and aperture value displayed by the 

camera may not be accurate and should be considered only as a reference. Additionally, some functions may not work 
as precisely.

A user with the same login name is already accessing the camera.
- This message appears on the screen of the connected device. Another device connected to the network is already 

operating the camera. To use this device, first end the connection on the device accessing the camera.

Another device has set the same IP address.
- Another device on the same network has the same IP address as the camera. Change the IP address of the conflicting 

device or the camera.

Another device with the same IP address already connected to the network.
- Another device on the same network has the same IP address as the camera. Change the IP address of the conflicting 

device or the camera.
- When using a network with a DHCP server, if the camera’s IP address assignment is set to [Manual Setting], change it 

to [Automatic Setting] (A 147).

Connection refused by FTP server.
- The FTP server is set to allow connections only with specific IP addresses. Check the camera’s IP address (A 148), 

and add it to the FTP server’s permission list settings.

Error code returned from the FTP server for the data session.
- The FTP server terminated the connection. Restart the FTP server.
- Change the file access permission settings on the FTP server to allow reading, writing and accessing logs.
- Allow access permissions to the selected destination folder on the FTP server.
- Check that the FTP server is turned on and working properly.
- Check that there is enough available space on the storage device (hard disk drive, etc.)

Ethernet adapter not connected.
- Check that the Ethernet adapter (commercially available) is correctly attached to the camera (A 139).
- Visit your local Canon website and check that the model of Ethernet adapter used (commercially available) was tested 

for use with this camera.

File transfer completion was not confirmed by FTP server.
- The camera did not receive a transfer completion notification from the FTP server for an unknown reason. Turn the 

camera and FTP server off and then on again and try the file transfer again.

Incorrect Wi-Fi password.
- Set the correct encryption key on the camera and the access point.

Multiple access points detected. Unable to connect.   Retry from the beginning.
- Other Wi-Fi devices are using the WPS function (push button method) to connect. Try the operation again or use other 

methods to configure the network (A 144).
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No address assigned by the DHCP server.
- The camera is set to automatic IP address assignment. If the selected network does not use a DHCP server, change 

the camera’s IP address assignment to [Manual Setting] and configure the IP address (A 147).
- Check the DNS server.

• Check that the DHCP server is turned on and working properly.
• Make sure the DHCP server has enough IP addresses to assign.

- Check the network.
• Check if a router with an active gateway function is not being used on the network you are trying to connect to.
• Set the correct gateway address on the camera and on all the devices connected to the same network.
• Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the 

camera’s network settings.

No response from access point.
- Check that the access point is working properly.
- Refer to Precautions Regarding Wi-Fi Networks (A 187) and check if there are applicable steps you can take.

No response from DNS server.
- The camera is set to automatic IP address assignment. If the selected network does not use a DNS server, change the 

camera’s DNS address to [Disable] and configure the IP address (A 147).
- Enter the same IP address of the DNS server used in the camera’s network settings.
- Check the DNS server.

• Check that the DNS server is turned on and working properly.
• On the DNS server, set the correct IP address and the name corresponding to the same address.

- Check the network.
• Check if a router with an active gateway function is not being used on the network you are trying to connect to.
• Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the 

camera’s network settings.
• Set the correct gateway address on the camera and on all the devices connected to the same network.

No Wi-Fi network found with the selected SSID.
- Check the access point’s SSID (network name) and make sure the same name is used in the camera’s settings.
- Check that the access point is working properly and try again.

Security of server connection cannot be verified.   To always trust this server and connect, set [Trust Destination 
Server] to [Enable].

- Check that the necessary certificate is correctly configured.
- To trust and use this server even without the proper certificate, set [Trust Destination Server] to [Enable].

Unable to connect to access point.
- The camera’s encryption method is different from that of the access point. Change the settings on the camera to 

match the access point.

Unable to connect to access point.   Retry from the beginning.
- To configure a new network connection using the WPS function (push button method), refer to the access point’s 

instruction manual and check how to activate the WPS function on the wireless router.
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Unable to connect to FTP server.
- Enter the correct address for the FTP server in the camera’s network settings.
- The authentication method is set to [Open System] but the encryption key is incorrect. Check uppercase/lowercase 

letters and other characters and make sure to enter the correct encryption key.
- The default port number is 21 (or 22 for SFTP transfers). Check the FTP server’s port number and enter the same port 

number in the camera’s network settings.
- Check that the server name of the selected FTP server is correctly configured on the DNS server and that the same 

name is used also in the camera’s network settings.
- Check the FTP server.

• Check that the FTP server is turned on and working properly.
• Check that the correct IP address assigned to the FTP server is the same as the FTP server’s IP address in the 

camera’s network settings.
• Access to the FTP server may be protected by a firewall due to security software or broadband routers. Change the 

firewall’s settings to allow connection to the FTP server.
• You may be able to access the FTP server by setting the camera’s passive mode to [Enable] (A 141).
• Contact the network’s administrator and obtain the correct IP address and port number for the FTP server. Enter the 

same information in the camera’s network settings.
- Check the network.

• Check if a router with an active gateway function is not being used on the network you are trying to connect to.
• Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the 

camera’s network settings.
• Set the correct gateway address on the camera and on all the devices connected to the same network.

Unable to connect to FTP server. Error code returned.
- The maximum number allowed of connections to the FTP server was reached. Reduce the number of network devices 

connected to the FTP server or increase the number of connections allowed.

Unable to disconnect from FTP server. Error code returned.
- The camera could not disconnect from the FTP server for an unknown reason. Turn the camera and FTP server off and 

then on again.

Unable to log in to FTP server. Error code returned.
- Check the FTP server’s [User Name] and [Password] in the camera’s network settings.
- Change the file access permission settings on the FTP server to allow reading, writing and accessing logs.
- Change the destination folder so the path includes only ASCII characters.

Wi-Fi adapter not connected.
- Check that the Wi-Fi adapter (commercially available) is correctly attached to the camera (A 138). 

Wi-Fi authentication unsuccessful
- The camera’s authentication mode and/or encryption key are different from those of the access point. Change the 

settings on the camera to match the access point.

Wi-Fi connection lost.
- The camera could not connect to the access point or network device.
- The wireless signal may be affected by nearby cordless telephones, microwave ovens, refrigerators or other devices. 

Operate the camera in a place more distant from such interference.

Wi-Fi error.    Incorrect encryption method.
- Make sure the camera and access point are using the same authentication/encryption method.
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Camera
Be sure to observe the following precautions to ensure maximum performance. 
• Do not use or store the camera in dusty or sandy places. The camera is not waterproof – avoid also water, 

mud or salt. If any of the above should get into the camera it may damage the camera and/or the lens. Consult 
a Canon Service Center as soon as possible.

• Be careful to avoid dust and dirt particles accumulating on the lens or entering the camera. When you finish 
using the camera, make sure to attach the body cap to the lens mount and the lens cap and dust cap to the 
lens.

• Do not use the camera near strong electromagnetic fields such as near powerful magnets and motors, MRI 
machines or high-voltage power lines. Using the camera in such places may cause anomalies in the video, or 
audio/video noise.

• Do not point the camera toward an intense light source, such as the sun on a sunny day or an intense artificial 
light source. Doing so may damage the image sensor or the camera’s internal components. Be especially 
careful when using a tripod or shoulder strap. When you are not using the camera, make sure to attach the 
lens cap to the lens.

• Do not touch the lens contacts on the lens mount. Dirty contacts may cause a poor 
contact between the camera and the lens resulting in incorrect operation of the 
camera. After removing the lens, make sure to attach the body cap to the lens mount 
and the lens cap and dust cap to the lens.

• Do not carry the camera by the LCD monitor or store the camera in a forced position, 
without returning the LCD monitor to its correct position. This may damage to the 
monitor’s joints.

• Do not apply excessive force when touching the screen. This may cause irregularities in the display quality or 
damage to the monitor’s joints.

• Do not apply protective film to the touch screen. The camera features a capacitive touch screen that may stop 
working correctly with a protective overlay.

Long-term storage 
If you do not intend to use the camera for a long time, store it in a place free of dust, in low humidity, and at 
temperatures not higher than 30 °C (86 °F).

Battery Pack

• Dirty terminals may cause a poor contact between the battery pack and the camera. Wipe the terminals with a 
soft dry cloth.

DANGER!

Treat the battery pack with care.
• Keep it away from fire (or it might explode).
• Do not expose the battery pack to temperature higher than 60 °C (140 °F). Do not leave it near a heater or 

inside a car in hot weather.
• Do not try to disassemble or modify it.
• Do not drop it or subject it to shocks.
• Do not get it wet.
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• Be sure to attach the terminal cover (Figure 1) to transport or store the battery 
pack. Do not allow any metal objects to touch the terminals (Figure 2), as this 
can cause a short circuit and damage the battery pack.

• Deplete the battery pack completely before charging it fully. The correct time 
may not be displayed if a fully charged battery pack is used continuously in 
high temperatures or is left unused for long periods of time. Also, the correct 
remaining time may not be displayed, depending on the battery life. Use the 
time shown on the screen as an approximation.

• The battery terminal cover has a [ð]-shaped hole. This is useful when you 
wish to differentiate between charged and uncharged battery packs.

• You can use the battery charger and AC adapter to charge battery packs in any country/region with power 
supply between 100 and 240 V AC, 50/60 Hz. Consult a Canon Service Center for information on plug 
adapters for overseas use.

Long-term storage 
• Store battery packs in a dry place at temperatures no higher than 30 °C (86 °F). 
• To extend the battery life of the battery pack, deplete it completely before storing it.
• Charge and deplete all your battery packs fully at least once a year.

Recording Media
• Periodically backing up recordings from the cards used to a computer is recommended. Data may be 

corrupted or lost due to defects or exposure to static electricity. Canon shall not be liable for lost or corrupted 
data.

• Do not touch or expose the terminals to dust or dirt.
• Do not use cards in places subject to strong magnetic fields.
• Do not leave cards in places subject to high humidity and high temperature.
• Do not attach any labels or stickers on the cards.
• Do not disassemble, bend, drop, or subject cards to shocks and do not expose them to water.

Disposal
When you delete data on a card, only the file allocation table is altered and stored data is not physically erased. 
Take the necessary precautions when you dispose of the card, for example by physically damaging it to prevent 
the leakage of private data.
If giving the card to another person, initialize it. Fill it up with unimportant recordings, and then initialize it again. 
This makes recovering the original recordings very difficult.

Built-in Backup Battery
The camera has a built-in rechargeable lithium battery to keep the date/time and other settings. The built-in 
backup battery is recharged while you use the camera; however, it will be depleted completely if you do not use 
the camera for about 3 months.
To recharge the built-in backup battery: Turn off the camera and attach a power source (sufficiently charged battery 
or DC IN terminal). The built-in backup battery will be fully charged in approx. 24 hours.

Figure 1 Figure 2
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Maintenance/Others
Condensation
Moving the camera rapidly between hot and cold temperatures may cause condensation (water droplets) to form 
on its internal surfaces. Stop using the camera if condensation is detected. Continued use may damage the 
camera. Condensation may form in the following cases:
• When the camera is moved quickly from cold to warm places
• When the camera is left in a humid room
• When a cold room is heated rapidly

When condensation is detected 
The precise time required for water droplets to evaporate will vary depending on the location and weather 
conditions. As a general rule, wait for 2 hours before resuming use of the camera.

To avoid condensation 
Remove the battery pack and any cards. Then, place the camera in an airtight plastic bag and let it adjust 
gradually to temperature changes before removing it from the bag.

Cleaning

Camera body
• Use a soft dry cloth to clean the camera’s body. Never use chemically treated cloths or volatile solvents such 

as paint thinner.

Lens
• Remove any dust or dirt particles using a non-aerosol type blower.
• Use a clean, soft lens-cleaning cloth to gently wipe the lens. Never use tissue paper.

LCD screen
• Clean the LCD screen using a clean, soft lens-cleaning cloth and commercially available cleaning fluid for 

eyeglasses.
• Condensation may form on the surface of the screen when the temperature changes suddenly. Wipe it with a 

soft dry cloth.
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Optional Accessories

Optional Accessories
The following optional accessories are compatible with this camera. The availability differs from area to area.
For details on using the optional accessories and on their specifications, refer also to the Cinema EOS System 
Expansion User Guide (PDF file), available from your local Canon website.

1 These battery packs are compatible with Intelligent System. The camera can communicate with the battery pack and display a 
more accurate approximate remaining usage time (in minutes).

2 An IFC-40AB III or IFC-150AB III Interface Cable (sold separately) is required to connect the receiver to this camera.

For our customers in the USA: Call or visit your local retailer/dealer for genuine Canon video accessories. You 
can also obtain genuine accessories for your Canon camera by calling: 1-800-828-4040, Canon U.S.A. 
Information Center.

IMPORTANT

• Use of genuine Canon accessories is recommended.
The message [Battery communication error] is displayed if you use a non-genuine Canon battery pack, and 
user response is required. Note that Canon shall not be liable for any damages resulting from accidents, such 
as malfunction or fire, that occur due to use of non-genuine Canon battery packs.

BP-A30, BP-A60
Battery Pack1

CA-CP200 L Compact Power Adapter CG-A10 Battery Charger CG-A20 Battery Charger and 
CA-CP200 B Compact 

Power Adapter

RC-V100 
Remote Controller

GP-E2 GPS Receiver2

This mark identifies genuine Canon video accessories. When you use Canon video equipment, we 
recommend Canon-brand accessories or products bearing the same mark.
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Specifications
C70
System

• Recording System
Clips:

XF-AVC
Video compression: MPEG-4 AVC / H.264
Audio format: Linear PCM, 24 bit, 48 kHz, 4 channels
File format: MXF

MP4
Video compression: H.265 / HEVC, MPEG-4 AVC / H.264
Audio format: Linear PCM, 16 bit, 48 kHz, 2 channels

MPEG-2 AAC-LC, 16 bit, 48 kHz, 2 channels
File format: MP4

WAV (audio files for slow & fast motion clips)
Audio format: Linear PCM, 24 bit, 48 kHz, 4 channels
File format: BWF

Photos: DCF (Design rule for Camera File system), compatible with Exif Ver. 2.31, JPEG compression

• Video Configuration (recording/playback)
Primary clips:

XF-AVC
Bit rate: 410 Mbps, 310 Mbps, 160 Mbps / Intra-frame,

260 Mbps, 160 Mbps, 50 Mbps, 24 Mbps / Long GOP
Resolution: 4096x2160, 3840x2160, 2048x1080, 1920x1080, 1280x720
Color sampling: YCbCr 4:2:2, 10 bit
Frame rate: 59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P

MP4
Bit rate: 225 Mbps, 170 Mbps, 150 Mbps, 135 Mbps, 100 Mbps, 50 Mbps, 35 Mbps,

12 Mbps, 9 Mbps, 8 Mbps / Long GOP
Resolution: 4096x2160, 3840x2160, 2048x1080, 1920x1080, 1280x720
Color sampling: YCbCr 4:2:2, 10 bit,  4:2:0, 10 bit,  4:2:0, 8 bit
Frame rate: 59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

Sub recording clips:
XF-AVC

Bit rate: 160 Mbps / Intra-frame,
160 Mbps, 50 Mbps, 24 Mbps / Long GOP

Resolution: 4096x2160, 3840x2160, 2048x1080, 1920x1080, 1280x720
Color sampling: YCbCr 4:2:2, 10 bit
Frame rate: 59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P

MP4
Bit rate: 150 Mbps, 100 Mbps, 50 Mbps, 35 Mbps, 12 Mbps, 9 Mbps, 

8 Mbps / Long GOP
Resolution: 4096x2160, 3840x2160, 2048x1080, 1920x1080, 1280x720
Color sampling: YCbCr 4:2:2, 10 bit,  4:2:0, 10 bit,  4:2:0, 8 bit
Frame rate: 59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

Proxy clips:
XF-AVC

Bit rate: 24 Mbps / Long GOP
Resolution: 2048x1080, 1920x1080, 1280x720
Color sampling: YCbCr 4:2:0, 8 bit
Frame rate: 59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P
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Specifications

• Recording Media (not included)
SD, SDHC (SD High Capacity) or SDXC (SD eXtended Capacity) cards

• Image Sensor
Super 35mm-equivalent CMOS sensor
Effective pixels (approximate, with [Super 35mm] sensor mode):

8,850,000 pixels (4096x2160) when the resolution is 4096x2160 or 2048x1080
8,290,000 pixels (3840x2160) when the resolution is 3840x2160 or 1920x1080

• LCD Touch Screen
8.8 cm (3.5 in.) color LCD, 16:9 aspect ratio, approx. 2,760,000 dots, 100% coverage, capacitive touch 
screen operation
- LUTs can be applied (BT.709, HDR Assist. 1600% or 400%) and assistance displays can be output 

(onscreen displays, peaking, zebra pattern, magnification, B&W image, video scope, false color, anamorphic 
desqueeze).

• Lens Mount
Canon RF lens mount compatible with Canon RF and EF1 lenses
1 One of the available Canon EF-EOS R Mount Adapters is required for using EF lenses (including EF-S and EF Cinema lenses).

• Approximate lens multiplication factor (for 35mm equivalent focal length)
[Super 35mm] sensor mode:

1.460  when the horizontal resolution is 4096 or 2048
1.534  when the horizontal resolution is 3840 or 1920

[Super 16mm (Cropped)] sensor mode:
2.920 when the horizontal resolution is 2048
3.069 when the horizontal resolution is 1920

• Lens Correction 
Peripheral illumination/chromatic aberration/diffraction correction is available for Canon RF, EF and EF Cinema 
lenses2

Distortion aberration correction is available only for Canon RF lenses2
2 Some lenses are not compatible with in-camera correction.

• Shutter Speed 
Speed (1/3-stop increments, 1/4-stop increments), angle, clear scan, slow, off

• Iris
Manual (1/2-stop increments, 1/3-stop increments, fine adjustment available), push auto iris, automatic 
aperture

• ISO Speed/Gain
Manual, automatic adjustment
ISO Speed: ISO 1003, ISO 160 to ISO 25600, ISO 512003, ISO 1024003

Gain: –6 dB3 to –3 dB3, –2 dB to 42 dB, 45 dB3 to 54 dB3
3 With extended ISO/Gain range and 1 stop increments (ISO speed) or [Normal] increments (gain).

• ND Filter
Built-in (Off, 2, 4, 6, 84 or 104 stops), motor operated
4 With extended ND range.

• Exposure
AE shift, light metering modes (standard, spotlight, backlight)

• White Balance
Custom white balance (two sets, A and B); two preset settings (daylight, 5,600 K5 and tungsten lamp, 
3,200 K5); color temperature setting (2,000 K to 15,000 K); automatic white balance (AWB)
Color temperature and color compensation (CC) adjustment available for all settings except custom white 
balance and AWB.
5 Color temperatures are approximate and given only as a reference.
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• Focus
Manual focus, autofocus (one-shot AF, AF-boosted MF, continuous AF, Face AF); face detection and subject 
tracking available
AF type: Dual Pixel CMOS AF, contrast-detection AF

• Sensor Sensitivity (ISO 800, 2000 lux, 89.9% reflection)
59.94 Hz: F10 (2048x1080 at 59.94P), F14 (1920x1080 at 29.97P)
50.00 Hz: F11 (2048x1080 at 50.00P), F16 (1920x1080 at 25.00P)

• Built-in Microphone
Stereo electret condenser microphone

• Size of Photos
4096x2160, 3840x2160, 2048x1080, 1920x1080

Terminals

• HDMI OUT Terminal
HDMI connector, output only
- Assistance displays can be output (onscreen displays, peaking, zebra pattern, magnification, B&W image, 

video scope, false color, anamorphic desqueeze).

• INPUT Terminals (INPUT 1 and INPUT 2)
Mini XLR 3-pin jack (pin1: shield, pin2: hot, pin3: cold), 2 sets, balanced
Sensitivity:

MIC setting: –60 dBu (volume center, full scale –18 dB) / 600 Ω, microphone attenuator: 20 dB
LINE setting: 4 dBu (volume center, full scale –18 dB) / 10 kΩ

• MIC Terminal
∅ 3.5 mm stereo mini-jack
Sensitivity:

[MIC], [MIC (with Power Supply)] setting:
–72 dBV (volume center, full scale –18 dB) / 1.5 kΩ, microphone attenuator: 20 dB
Plug-in power supply: 2.4 V DC (bias resistance 2.2 kΩ)

[LINE] setting: –12 dBV (volume center, full scale –18 dB) / 10 kΩ

• × (Headphone) Terminal
∅ 3.5 mm stereo mini-jack, –17 dBV (32 Ω load, Max volume) / 50 Ω or less

• TIME CODE Terminal
BNC jack, input/output
Input setting: 0.5 Vp-p to 18 Vp-p / 100 kΩ; Output setting: 1.3 Vp-p / 50 Ω or less

• USB Terminal
USB Type-C receptacle

• REMOTE A Terminal
∅ 2.5 mm stereo sub-mini jack
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Power/Others

• Power Supply (rated)
14.4 V DC (battery pack), 24.0 V DC (DC IN)

• Power Consumption and Approximate Continuous Recording Times
Values are listed in the following order: Power consumption / Continuous recording time with a BP-A30 
battery / Continuous recording time with a BP-A60 battery. The values were measured using normal recording 
(second card recording function turned off), with an RF35mm F1.8 MACRO IS STM lens and LCD luminance 
set to [Normal]. 
XF-AVC/MP4

Approx. 14.6 W  /  170 min.  /  350 min. ([Super 35mm] sensor, 4096x2160 at 59.94P)
Approx. 14.1 W  /  175 min.  /  360 min. ([Super 35mm] sensor, 4096x2160 at 50.00P)
Approx. 12.4 W  /  200 min.  /  410 min. ([Super 16mm (Cropped)] sensor, 2048x1080 at 59.94P)
Approx. 12.2 W  /  205 min.  /  415 min. ([Super 16mm (Cropped)] sensor, 2048x1080 at 50.00P)

• Operating Temperature
0 – 40 °C (32 – 104 °F)

• Dimensions (W x H x D)6

Camera body only: 160 x 130 x 116 mm (6.3 x 5.1 x 4.6 in.)
Camera with handle unit, microphone holder: 260 x 266 x 171 mm (10.2 x 10.5 x 6.7 in.)

• Weight6 (including tape measure hook and grip belt)
Camera body: 1,190 g (2.6 lb.) 
Camera with BP-A30 battery, 2 cards: 1,420 g (3.1 lb.) 
Camera with handle unit, microphone holder, BP-A30 battery, 2 cards: 1,620 g (3.6 lb.) 

Accessories
CG-A20 Battery Charger

• Rated Input: 24 V DC, 1.8 A

• Rated Output: 16.7 V DC, 1.5 A

• Operating Temperature: 0 – 40 °C (32 – 104 °F)

• Dimensions6 (W x H x D): 100 x 24 x 100 mm (3.9 x 0.9 x 3.9 in.)

• Weight6: 145 g (5.1 oz.)

CA-CP200 L Compact Power Adapter 

• Rated Input: 100 – 240 V AC, 50/60 Hz, 90 VA (100 V AC) – 120 VA (240 V AC)

• Rated Output: 24 V DC, 1.8 A

• Operating Temperature: 0 – 40 °C (32 – 104 °F)

• Dimensions6 (W x H x D): 67.5 x 37 x 134 mm (2.7 x 1.5 x 5.3 in.)

• Weight6: 290 g (10.2 oz.)
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BP-A30 Battery Pack

• Battery Type: Rechargeable lithium ion battery, compatible with Intelligent System

• Rated Voltage: 14.4 V DC

• Rated Battery Capacity: 3,100 mAh / 45 Wh

• Operating Temperature: 0 – 40 °C (32 – 104 °F)

• Dimensions6 (W x H x D): 41.5 x 45.1 x 69.7 mm (1.6 x 1.8 x 2.7 in.)

• Weight6: 225 g (7.9 oz)
6 All dimensions and weights are approximate.

Errors and omissions excepted.
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Compatible Lenses and Functions

Compatible Lenses and Functions
Following is a list of lenses compatible with this camera and the various functions that can be used depending 
on the lens. Depending on the lens’s purchase date, you may need to update the lens’s firmware to use these 
functions. For details, visit your local Canon website or consult a Canon Service Center.

1 Except for the RF600mm F11 IS STM, RF800mm F11 IS STM.
2 One of the available Canon EF-EOS R Mount Adapters is required for using EF lenses (including EF-S and EF Cinema lenses).
3 Only lenses with the PZ-E1 Power Zoom Adapter attached.
4 The AE response setting (A 163) is not supported (not applicable).

• EF lenses compatible with auto iris:

Lens
Iris control from the camera Zoom control 

from the cameraManual Push auto iris Automatic

RF lenses Ü Ü Ü1 –

EF lenses2 Ü Ü – –

EF lenses compatible with auto iris Ü Ü Ü Ü3

EF Cinema lenses2

CN7x17 KAS S/E14

CN10x25 IAS S/E14

CN20x50 IAS H/E14
Ü Ü Ü Ü

CN-E18-80mm T4.4 L IS KAS S,
CN-E70-200mm T4.4 L IS KAS S

Ü Ü Ü Ü

Manual focus lenses compatible with focus guide

– – – –
CN-E15.5-47mm T2.8 L S
CN-E15.5-47mm T2.8 L SP
CN-E30-105mm T2.8 L S
CN-E30-105mm T2.8 L SP

EF24-105mm f/3.5-5.6 IS STM EF-S10-18mm f/4.5-5.6 IS STM
EF70-200mm f/4L IS II USM EF-S18-55mm f/3.5-5.6 IS STM
EF70-300mm f/4-5.6 IS II USM EF-S18-55mm f/4-5.6 IS STM
EF85mm f/1.4L IS USM EF-S18-135mm f/3.5-5.6 IS STM
EF400mm f/2.8L IS III USM EF-S18-135mm f/3.5-5.6 IS USM
EF600mm f/4L IS III USM EF-S35mm f/2.8 MACRO IS STM

EF-S55-250mm f/4-5.6 IS STM
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1 One of the available Canon EF-EOS R Mount Adapters is required for using EF lenses (including EF-S and EF Cinema lenses).

• Manual focus lenses compatible with focus guide:

• EF lenses not compatible with autofocus while slow & fast motion recording is activated:

 
• Lenses compatible with automatic retraction when the camera is turned off (A 172).

Lens

Focus control from the camera

Focus guide
Manual One-shot AF

Continuous 
AF

Face AF Tracking

RF lenses / EF lenses1 Ü Ü Ü Ü Ü Ü

EF lenses not compatible with autofocus 
while slow & fast motion recording is 
activated

Ü – – – – Ü

EF Cinema lenses1

CN7x17 KAS S/E1
CN10x25 IAS S/E1

Ü Ü Ü Ü Ü Ü

CN20x50 IAS H/E1 Ü – – – – –

CN-E18-80mm T4.4 L IS KAS S,
CN-E70-200mm T4.4 L IS KAS S

Ü Ü Ü Ü Ü Ü

Manual focus lenses compatible with 
focus guide

– – – – – Ü

CN-E14mm T3.1 L F CN-E50mm T1.3 L F
CN-E20mm T1.5 L F CN-E85mm T1.3 L F
CN-E24mm T1.5 L F CN-E135mm T2.2 L F
CN-E35mm T1.5 L F

EF24-105mm f/3.5-5.6 IS STM EF-S18-135mm f/3.5-5.6 IS STM
EF70-300mm f/4-5.6 IS II USM EF-S18-135mm f/3.5-5.6 IS USM
EF-S10-18mm f/4.5-5.6 IS STM EF-S35mm f/2.8 MACRO IS STM 
EF-S18-55mm f/3.5-5.6 IS STM EF-S55-250mm f/4-5.6 IS STM 
EF-S18-55mm f/4-5.6 IS STM

RF35mm F1.8 MACRO IS STM EF50mm f/1.8 STM
EF40mm f/2.8 STM EF-S24mm f/2.8 STM
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Reference Tables

Reference Tables
Approximate Recording Time on a Card

Charging Times
Charging times are approximate and vary according to charging conditions, ambient temperature and initial 
charge of the battery pack.

Main recording format and bit rate 32 GB 128 GB 512 GB

XF-AVC

410 Mbps 9 min. 39 min. 156 min.

310 Mbps 12 min. 51 min. 207 min.

260 Mbps 15 min. 61 min. 246 min.

160 Mbps 25 min. 100 min. 401 min.

50 Mbps 80 min. 321 min. 1,284 min.

MP4 (HEVC)

225 Mbps 16 min. 71 min. 285 min.

170 Mbps 23 min. 94 min. 377 min.

135 Mbps 29 min. 118 min. 475 min.

100 Mbps 40 min. 160 min. 642 min.

MP4 (H.264)
150 Mbps 25 min. 107 min. 428 min.

35 Mbps 114 min. 458 min. 1,834 min.

Battery pack BP-A30 BP-A60

Charging time using the supplied 
CG-A20 Battery Charger

170 min. 300 min.
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Appendix: Camera Dimensions
Unless indicated with the " (inch) mark, all units are in mm.  represents the depth of a hole or socket.
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Appendix: Camera Dimensions

Camera with handle unit and microphone holder
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× (headphones) terminal . . . . . . . . . . . . . .93, 122

A
ABB (automatic black balance)  . . . . . . . . . . . . .40
Abroad, using the camera  . . . . . . . . . . . . . . . .195
Access point  . . . . . . . . . . . . . . . . . . . . . .137, 138
Accessories . . . . . . . . . . . . . . . . . . . . . . . .10, 197
AE shift  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .65
Air vents  . . . . . . . . . . . . . . . . . . . . . . . .12, 13, 39
Anamorphic lenses and desqueeze . . . . . . . . .103
Aperture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .62

Automatic aperture (auto iris)  . . . . . . . . .64
Push auto iris . . . . . . . . . . . . . . . . . . . . .64

Assignable buttons  . . . . . . . . . . . . . . . . . . . . .105
Audio

Audio level  . . . . . . . . . . . . . . . . . . . . . . .90
Bit depth  . . . . . . . . . . . . . . . . . . . . . . . .87
Format . . . . . . . . . . . . . . . . . . . . . . . . . .88
Output channels . . . . . . . . . . . . . . . . . .133
Peak limiter  . . . . . . . . . . . . . . . . . . . . . .91
Recording  . . . . . . . . . . . . . . . . . . . . . . .87

Audio files (for slow & fast motion clips)  . . . . . .100
Audio reference signal . . . . . . . . . . . . . . . . . . . .94
Authentication . . . . . . . . . . . . . . . . . . . . . . . . .146
AWB (auto white balance)  . . . . . . . . . . . . . . . . .68
AWB lock  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .68

B
Bit rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .53
Browser Remote . . . . . . . . . . . . . . . . . . . . . . .156
Built-in backup battery . . . . . . . . . . . . . . . . . . .195
Button connection mode (WPS) . . . . . . . .138, 141

C
Camera Access Point  . . . . . . . . . . . . . . . . . . .145
Camera dimensions . . . . . . . . . . . . . . . . . . . . .206
CAMERA mode . . . . . . . . . . . . . . . . . . . . . . . . .15
Camera nickname . . . . . . . . . . . . . . . . . . . . . .148
Canon Log 2, Canon Log 3 

(gamma curves) . . . . . . . . . . . . . . . . . . . . .113
Canon XF Utility (download) . . . . . . . . . . . . . . .134
Card volume label  . . . . . . . . . . . . . . . . . . . . . . .33
Check marks (%)  . . . . . . . . . . . . . . . . . . .97, 125
Cinema EOS System Expansion 

User Guide . . . . . . . . . . . . . . . . . . . . . . . . .197

Clips
Adding $ marks/% marks  . . . . . .97, 125
Adding shot marks . . . . . . . . . . . . .97, 125
Clip information  . . . . . . . . . . . . . . . . . .124
Clip name format  . . . . . . . . . . . . . . . . . .37
Clip numbering . . . . . . . . . . . . . . . . .37, 38
Deleting  . . . . . . . . . . . . . . . . . . . . . . . .126
Playback  . . . . . . . . . . . . . . . . . . . . . . .120
Proxy clips  . . . . . . . . . . . . . . . . . . . . . . .56
Recording  . . . . . . . . . . . . . . . . . . . . . . .41
Recovering . . . . . . . . . . . . . . . . . . . . . . .34

Color bars  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .94
Color bit depth . . . . . . . . . . . . . . . . . . . . . . . . . .53
Color compensation (CC) value  . . . . . . . . . . . . .66
Color sampling  . . . . . . . . . . . . . . . . . . . . . . . . .53
Color space . . . . . . . . . . . . . . . . . . . . . . .113, 131
Computer  . . . . . . . . . . . . . . . . . . . . . . . . . . . .134
Condensation  . . . . . . . . . . . . . . . . . . . . . . . . .196
Connection to external devices  . . . . . . . . . . . .128
Continuous recording  . . . . . . . . . . . . . . . . . . .102
Control dials  . . . . . . . . . . . . . . . . . . . . . . . .59, 62
Control ring (RF lens) . . . . . . . . . . . . . . . . . . . .171
Custom displays  . . . . . . . . . . . . . . . . . . . .43, 167
Custom picture  . . . . . . . . . . . . . . . . . . . . . . . .109

Detailed custom picture settings . . . . . .113
Look File . . . . . . . . . . . . . . . . . . . . . . . .111
Preset settings . . . . . . . . . . . . . . . . . . .109

D
Data entry / keyboard screen . . . . . . . . . . . . . . .25
Date and time  . . . . . . . . . . . . . . . . . . . . . . . . . .22
DC IN terminal . . . . . . . . . . . . . . . . . . . . . .19, 201
Deleting recordings  . . . . . . . . . . . . . . . . . . . . .126
Desqueeze  . . . . . . . . . . . . . . . . . . . . . . . . . . .103
Detection of access points . . . . . . . . . . . . . . . .146
Digital IS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78
Direct setting mode . . . . . . . . . . . . . . . . . . . . . .50
Direct touch control . . . . . . . . . . . . . . . . . . . . . .49
Double slot recording . . . . . . . . . . . . . . . . . . . . .35
Drop frame (time code)  . . . . . . . . . . . . . . . . . . .84

E
EF Cinema lenses  . . . . . . . . . . . . . . . . . . .26, 203
Encryption . . . . . . . . . . . . . . . . . . . . . . . .145, 146
Exposure bar . . . . . . . . . . . . . . . . . . . . . . . . . . .65
Exposure compensation  . . . . . . . . . . . . . . . . . .65

Index
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F
Face detection . . . . . . . . . . . . . . . . . . . . . . . . . .75
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Light metering mode  . . . . . . . . . . . . . . . . . . . . 65
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Microphone
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MP4 Join Tool (download) . . . . . . . . . . . . . . . .134
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Network functions  . . . . . . . . . . . . . . . .137

Network connection
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Phantom power (microphone)  . . . . . . . . . . . . . .89
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Recording  . . . . . . . . . . . . . . . . . . . . . . .42
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Power supply . . . . . . . . . . . . . . . . . . . . . . . . . . .17

AC adapter (DC IN) . . . . . . . . . . . . .19, 201
Canon battery packs  . . . . . . . . . . . . . . .17
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POWER switch  . . . . . . . . . . . . . . . . . . . . . . . . .15
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Trademark Acknowledgements
• SD, SDHC and SDXC Logos are trademarks of SD-3C, LLC.
• Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United 

States and/or other countries.
• Apple, macOS are trademarks of Apple Inc., registered in the U.S. and other countries.
• Avid and Media Composer are trademarks or registered trademarks of Avid Technology, Inc. or its 

subsidiaries in the United States and/or other countries.
• Wi-Fi is a registered trademark of the Wi-Fi Alliance.
• Wi-Fi Certified, WPA, WPA2, and the Wi-Fi Certified logo are trademarks of the Wi-Fi Alliance.
• WPS as used on the camera’s settings, onscreen displays and in this manual signifies Wi-Fi Protected Setup.
• JavaScript is a trademark or registered trademark of Oracle Corporation, its affiliates or subsidiaries in the 

United States and other countries.
• HDMI, the HDMI logo and High-Definition Multimedia Interface are trademarks or registered trademarks of 

HDMI Licensing Administrator, Inc. in the United States and other countries.
• DaVinci Resolve™ is the trademark of Blackmagic Design Pty Ltd.
• Other names and products not mentioned above may be trademarks or registered trademarks of their 

respective companies.

Licensing Information
• This device incorporates exFAT technology licensed from Microsoft.
• This product is licensed under AT&T patents for the MPEG-4 standard and may be used for encoding 

MPEG-4 compliant video and/or decoding MPEG-4 compliant video that was encoded only (1) for a personal 
and noncommercial purpose or (2) by a video provider licensed under the AT&T patents to provide MPEG-4 
compliant video. No license is granted or implied for any other use for MPEG-4 standard.

• THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE 
OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE 
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT 
WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM 
A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE 
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM
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CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN THE UNITED STATES
The limited warranty set forth below is given by Canon U.S.A., Inc. (‘Canon USA’) with respect to (a) the Canon Cinema EOS Product, and (b) the accessories 
for the Canon Cinema EOS Product (if any), packaged with this limited warranty (collectively the “Products”)* and purchased in the United States. This limited 
warranty is only effective upon presentation of your Bill of Sale or other proof of purchase. The Products are warranted to the original end-user purchaser, 
when delivered in new condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At Canon USA’s 
option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from the date of original purchase.  Labor: For a 
period of ONE YEAR from the date of original purchase, labor will be provided free of charge by Canon USA’s factory service centers or designated service 
facilities located in the United States. When returning Products under this warranty, you must pre-pay the shipping charges, and you must enclose a copy of 
the Bill of Sale or other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period, repairs will be made and the 
Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be given an estimate of the cost of repair and an 
opportunity to approve or disapprove of the repair expense before it is incurred. If you approve, repairs will be made and the Products will be returned to you 
at your risk and expense. If you disapprove, we will return-ship the Products to you at no charge to you to an address within the United States.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as 
to which items Canon USA will have no responsibility. Canon USA shall have no responsibility under this limited warranty for use of the 
Products in conjunction with incompatible peripheral equipment and/or incompatible software. Non-Canon brand peripheral equipment and 
software which may be distributed with, or factory loaded on, the Products, are sold ‘AS IS’ without warranty of any kind by Canon USA, 
including any implied warranty regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such non-
Canon brand items is given by the manufacturer or producer thereof.

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the Products or contact the CANON 
INFORMATION CENTER AT 855-CINE-EOS (855-246-3367) or on the internet at pro.usa.canon.com/support. You will be directed to the nearest service 
facility for your Products.

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon accessories or failure to follow 
operating, maintenance or environmental instructions prescribed in Canon USA’s user’s manual;

B. If the Products are defective as a result of leaking batteries, sand, dirt or water damage;
C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon USA) that cause damage to the Products or that 

cause abnormally frequent service calls or service problems;
D. If defects or damages are caused by  service other than  Canon USA’s factory service centers or authorized service facilities;
E. Any internal modification to product hardware or firmware;
F. Any applicable fee for Maintenance of the Products;
G. If the Product has had its serial number or dating altered or removed.

This Limited Warranty does not apply to Products purchased outside the United States. This Limited Warranty does not apply to accessories or 
consumables not originally packaged with the Product. Please retain this warranty card and your Bill of Sale as a permanent record of your purchase. This 
card ensures that you are contacted promptly should there be a safety inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE PRODUCTS AFTER THE 
APPLICABLE PERIOD OF EXPRESS WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON, FIRM OR CORPORATION 
WITH RESPECT TO THE PRODUCTS SHALL BIND CANON USA (SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED 
WARRANTY LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU). CANON USA SHALL NOT BE LIABLE FOR LOSS OF 
REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE PRODUCTS OR SERVICE, STORAGE CHARGES, LOSS OR CORRUPTION OF DATA, INCLUDING 
WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’ HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON 
WHICH THE CLAIM IS BASED, AND EVEN IF CANON USA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY 
OF ANY KIND AGAINST CANON USA BE GREATER THAN THE PURCHASE PRICE OF THE PRODUCTS SOLD BY CANON USA AND CAUSING THE 
ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND 
YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE, MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED 
DIRECTLY BY THE NEGLIGENCE OF CANON USA (SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE 
OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

CANON U.S.A., INC

USA

http://pro.usa.canon.com/support
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CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN CANADA
The limited warranty set forth below is given by Canon Canada Inc. (‘Canon Canada’) with respect to (a)  the Canon Cinema EOS product, and (b)  the 
accessories for the  Canon Cinema EOS Product (if any),  packaged with this limited warranty (collectively the “Products”)* and purchased in Canada. This 
limited warranty is only effective upon presentation of your Bill of Sale or other proof of purchase. The Products  are warranted to the original end-user 
purchaser, when delivered in new condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At 
Canon Canada’s option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from the date of original 
purchase.  Labor: For a period of ONE YEAR from the date of original purchase, labor will be provided free of charge by Canon Canada’s factory service 
center or designated service facilities located in Canada. When returning Products under this warranty, you must pre-pay the shipping charges, and you 
must enclose a copy of the Bill of Sale or other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period, 
repairs will be made and the Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be given an 
estimate of the cost of repair and an opportunity to approve or disapprove of the repair expense before it is incurred. If you approve, repairs will be made 
and the Products will be returned to you at your risk and expense. If you disapprove, we will return-ship the Products to you at no charge to you to an 
address within Canada.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as to 
which items Canon Canada will have no responsibility. Canon Canada shall have no responsibility under this limited warranty for use of the 
Products in conjunction with incompatible peripheral equipment and/or incompatible software. Non-Canon brand peripheral equipment and 
software which may be distributed with, or factory loaded on, the  Products, are sold ‘AS IS’ without warranty of any kind by Canon Canada, 
including any implied warranty or condition regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such 
non-Canon brand items is given by the manufacturer or producer thereof. 

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the  Products or contact the CANON 
PROFESSIONAL SERVICE CENTRE 1-800-667-2666 or on the internet at www.canon.ca/pro.  You will be directed to the nearest service facility for your 
Products. 

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon accessories or failure to follow 
operating, maintenance or environmental instructions prescribed in Canon Canada’s user’s manual;

B. If the Products  are defective as a result of leaking batteries, sand, dirt or water damage;
C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon Canada) that cause damage to the Products or 

that cause abnormally frequent service calls or service problems;
D. If defects or damages are caused by  service other than  Canon Canada’s factory service centers or authorized service facilities;
E. Any internal modification to product hardware or firmware;
F. Any applicable fee for Maintenance of the Products;
G. If the Product has had its serial number or dating altered or removed.

This Limited Warranty does not apply to Products purchased outside Canada. This Limited Warranty does not apply to accessories or consumables not 
originally packaged with the Product. Please retain this warranty card and your Bill of Sale as a permanent record of your purchase. This card ensures 
that you are contacted promptly should there be a safety inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY OR CONDITION, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE 
PRODUCTS AFTER THE APPLICABLE PERIOD OF EXPRESS WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON, 
FIRM OR CORPORATION WITH RESPECT TO THE PRODUCTS SHALL BIND CANON CANADA (SOME PROVINCES DO NOT ALLOW LIMITATIONS ON 
HOW LONG AN IMPLIED WARRANTY OR CONDITION LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU). CANON 
CANADA SHALL NOT BE LIABLE FOR LOSS OF REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE  PRODUCTS OR SERVICE, STORAGE 
CHARGES, LOSS OR CORRUPTION OF DATA, INCLUDING WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’ 
HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE  
PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON CANADA HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON CANADA BE GREATER THAN THE PURCHASE PRICE OF 
THE PRODUCTS SOLD BY CANON CANADA AND CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK 
AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE, 
MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF CANON CANADA (SOME PROVINCES DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU). 
THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR 
WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from province to province. 

CANON CANADA INC.

CANADA

http://www.canon.ca/pro
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